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Course Overview

About the Course Ubuntu is a community developed Linux-based operating system freely available and suitable for laptops,
desktops and servers. This course is based on Ubuntu 8.04 LTS and aims to train new users of Ubuntu how to use key applications
including mainstream office applications, Internet connectivity and browsing, graphics arts tools, multi-media and music.

OBIJECTIVES

* The concepts of open source and how they tie in with Ubuntu

* The benefits of using Ubuntu

* How to customise the look and feel of the Ubuntu desktop

* How to navigate through the file system and search for files

* How to connect to and use the Internet

* How to perform basic word-processing and spreadsheet functions using OpenOffice.org
* How to Install and play games

* How to add, remove and update applications

* How to view, draw, manipulate and scan images

* How to play, edit and organize music and video files

* Where to seek help on Ubuntu from free and commercial sources

* How to create partitions and dual-boot options

Target Audience and Pre-requisites

This course provides both home and office users with hands on training on Ubuntu. No prior knowledge of Ubuntu is required,
although computer literacy is assumed and is a pre-requisite. Ubuntu 8.04 LTS must be installed on the computer hard disk
before starting this course.

The Ubuntu desktop course is designed to be modular. If studied in a classroom in its entirety, it should be completed within two
full days. However, topics and lessons can be selected as required and a day’s content designed to suit the key learning objectives.

Sample material for various exercises is available through the ubuntu-desktop-course-resources package. The most current pack-
age is available through the canonical-training PPA (Personal Package Archive) in Launchpad: https://launchpad.net/~canonical-
training/+archive.
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Student Responsibilities

* Students should arrive on time and stay until the session is dismissed. The instructor should be notified if you expect to arrive

late.

* Participation in class discussions is strongly encouraged. Even when some topics are already familiar to some, sharing relevant

experiences can be very helpful to other people.

¢ Cell phones and pagers should be placed on silent mode during class.

» Feedback is vital to the improvement of our course development and delivery. All students must complete the course evaluation
form at the end of the last day in order to receive a certificate of completion.

* Please provide any and all feedback regarding this course to: training@canonical.com.

Ubuntu Session Plan

Session

Duration (in
minutes)

DAY 1

Welcome and Course Overview

20

Introducing Ubuntu

60

About Open Source

Free Software Movement, Open Source and Linux

About Ubuntu

Software Repositories and Categories

Key Differences between Ubuntu and Microsoft Windows

Lesson Summary

Review Exercise

Exploring the Ubuntu Desktop

75

Ubuntu Desktop Components

Changing the Default Language

Creating a User Account and Fast User Switching

Adding/Removing Applications

Desktop Effects - Compiz Fusion

Lesson Summary

Lab Exercise

Using the Internet

100

Connecting to and Using the Internet

Browsing the Web

Accessing RSS Feeds

Sending and Receiving E-mail Messages

Instant Messaging

Making Phone Calls using Softphones

Review Exercise

Lab Exercise

Using OpenOffice Applications

180

Introducing the OpenOffice.org Suite

Using OpenOffice.org Writer
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Using OpenOffice.org Calc

Using OpenOffice.org Impress

Using OpenOffice.org Draw

Using OpenOffice.org Math

Additional Applications

Lesson Summary

Review Exercise

Lab Exercise

Ubuntu and Games

40

Installing Ubuntu Games

Playing Ubuntu Games

Playing Other Popular Games

Lesson Summary

Lab Exercise

Session

Duration (in
minutes)
excl.
exercises

DAY 2

Customising the Desktop and Applications

80

Introduction

Customising the Desktop

The 3D Effects

Working with Files Using Nautilus

Adding and removing applications using Add/Remove and Synaptic Package
Manager

Installing a Single Package File

Software Repositories

Adding New Language Settings

Lesson Summary

Review Exercise

Lab Exercise

Making the Most of Images and Photos

60

Introducing Graphics Applications

The GIMP

Managing Photos with F-Spot

Drawing with Inkscape

Using a Scanner

Lesson Summary

Review Exercise

Lab Exercise

Playing Music and Videos

60

Legal Restrictions

Playing Music Files

Playing and Extracting Audio CDs

Burning Audio CDs

Playing Proprietary Multimedia Formats

Using an iPod
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Playing Music and Videos 60
Creating and Editing Audio Files
Using DVDs

Playing Online Media

Editing Videos

Lesson Summary

Review Exercise

Lab Exercise

Ubuntu: Help and Support 60
Introduction

Free support resources
System documentation
Online Documentation
Community Support
Launchpad

The Fridge

Paid for Commercial Services
Lesson Summary

Review Exercise

Partitioning and Booting - optional 60
What is Partitioning
Creating a Partition
Boot-up Options
Lesson Summary
Review Exercise
Lab Exercise
Course Summary
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Chapter 1

Introducing Ubuntu

OBIJECTIVES

* The fundamental concepts of open source.

The link between the Free Software Movement, open source and Linux
e How Ubuntu ties in with open source
* How Ubuntu is developed

¢ About Ubuntu versions

The key differences between Ubuntu and Microsoft Windows

1.1 About Open Source

Ubuntu is a Linux-based open source operating system. The term ’open source’ can be defined as a set of principles and practices
that promotes access to the design and production of goods and knowledge. Open source is generally applied to the source code
of software and is available to users with relaxed or no intellectual property restrictions. This enables users to distribute, create
and modify software content, either individually to meet their specific requirement or collaboratively to improve the software.
Both open source and Linux have transitioned through various phases to reach their present form.

The idea behind openly distributed source code is to encourage the voluntary, collaborative development of software. Users
continuously enhance the software, fix bugs, develop new features and share it with others.

As a result of collaborative software development which involves a large number of programmers, users receive software that
is often better in quality and performance than proprietary alternatives. Users are encouraged to customise the software to their
own personal requirements, which in itself is a huge step away from the *one size fits all’ philosophy.

Open source projects call on the talents of many people with skills other than programming. Many projects involve artists,
musicians, user-interface designers and documentation authors to create a complete product.

1.2 Free Software Movement, Open Source and Linux

There is often confusion between open source, free software and Linux. While all three are inter-linked, there are distinct
differences which are made clearer when looking at their evolution.
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1.2.1 The Free Software Movement

In the 1960s, it was typical for software to be distributed freely by companies such as IBM and shared amongst users. Software
was then considered an enabler for the hardware, around which the business model of these corporations was built. Software
was provided with source code that could be improved and modified; this was therefore the very early seeds of open source
software. However, as hardware became cheaper and profit margins eroded in the 1970s, manufacturers looked to software to
provide additional revenue streams.

In September 1983, Richard Matthew Stallman, former programmer at the MIT Artificial Intelligence Lab launched the GNU
project to create a free UNIX-like operating system (OS). He was concerned with growth in proprietary software and users’
inability to access and modify programmes on their computers. Developer constraint, as opposed to freedom was prevalent. With
the launch of the GNU project, Stallman started the Free Software Movement and in October 1985, set up the Free Software
Foundation.

Stallman pioneered the definition and characteristics of open source software and the concept of copyleft. He is the main author
of several copyleft licenses, including the GNU General Public License (GPL), which is the most widely used free software
license.

Nice to Know:
For more information on Richard Stallman and the GNU project, refer to the following URL: http://en.wikipedia.org/wiki/-
Richard_stallman.

By 1991, a number of GNU tools, including the powerful GNU compiler collection (GCC), had been created. However, a free
kernel was not yet available to build a free OS that would use these tools.

1.2.2 The Open Source Movement and Linux
The difference between free software and open source can be defined as the difference between a social movement (free software)
and a development methodology (open source). Linux refers to the kernel, or the backbones of the open source architecture.

In August 1991, Linus Benedict Torvalds, a Finnish second-year student of computer science at the University of Helsinki, started
working on Minix.



http://en.wikipedia.org/wiki/Richard_stallman
http://en.wikipedia.org/wiki/Richard_stallman
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Figure 1.1: Linus Benedict Torvalds

Nice to Know:
Minix is a UNIX-like OS built with open source code that Prof. Andrew S. Tanenbaum created with the intention to teach his
students the internal processes of an OS.

Linux was initially designed to be a Minix-like operating system that Linus Torvalds could use on his home computer. By mid-
September, Torvalds released the first Linux kernel version 0.01. In 1994, Linux kernel version 1.0 was released under the GNU
GPL. The free kernel and GNU tools provided a fertile environment for enthusiasts. By staying close to its UNIX roots, Linux
provided a Command Line Interface (CLI) first; the adaptation of the X Window System made a graphical user interface (GUI)
available at a later stage.

Nice to Know:
Linux is not owned by any individual or company, not even Linus Torvalds who started Linux. However, Torvalds is heavily
involved in the main kernel development process and owns the trademark, Linux.

Linux open source code:

* Is available and accessible to everyone

* Can be customised according to an individual’s requirements and the platforms used

* Can be freely redistributed in its current or a modified form

Initially, Linux was a very technical, hard core open source programming tool. Thousands of developers contributed to its

evolution as it became more user friendly. This has resulted in the launch of hundreds of commercial and non-commercial
distribution versions, designed for everyday application use which are now available.

In 1998, Jon "maddog" Hall, Larry Augustin, Eric S. Raymond, Bruce Perens et al formally launched the Open Source Movement.
They promoted open source software exclusively on the basis of technical excellence.
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Figure 1.2: Founders of the Open Source Movement

The open source movement and the dot.com boom of the late 1990s coincided, resulting in the popularity of Linux and the
evolution of many open source friendly companies such as Corel (Corel Linux), Sun Microsystems (OpenOffice.org) and IBM
(OpenAFS). In the early 21st century when the dot.com crash was at its peak, open source was in a prime position as a viable
alternative to expensive proprietary software. Its momentum has strengthened since with the availability of many easy to use
applications.

As such, what started off as an idea became a passion to revolutionise a patent and license intense industry. With a significantly
cheaper return on investment and enhanced usability features, Linux is now rooted as a viable option for enterprises and home
users.

1.3 About Ubuntu

Ubuntu is a community developed, Linux-based operating system that is perfect for laptops, desktops and servers. It contains all
the applications you need - including a Web browser, presentation, document and spreadsheet software, instant messaging and
much more.

Nice to Know:
Ubuntu is an African word meaning 'Humanity to others’, or ’| am what | am because of who we all are’.

The history of Ubuntu dates back to April 2004 when Mark Shuttleworth formed a group of open source developers to create a
new Linux OS.
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Figure 1.3: Mark Shuttleworth

Based on the principles of time-based releases, a strong Debian foundation, the GNOME desktop, and a commitment to freedom,
this group operated initially under the auspices of http://no-name-yet.com.

In a little over four years, Ubuntu has grown to a community of thousands of members and an estimated user base of over 8
million (as at June 2007). Canonical is the commercial sponsor of Ubuntu.

1.3.1 The Ubuntu Promise

Ubuntu will always be free of charge, including enterprise releases and security updates.
» Ubuntu comes with full commercial support from Canonical and hundreds of companies around the world.

» Ubuntu includes the best translations and accessibility infrastructure that the free software community has to offer.

Ubuntu CDs contain only free software applications; Ubuntu encourages you to use free and open source software, improve it
and pass it on.

1.3.2 Ubuntu Versions

In October 2004, Ubuntu released its first version. A new version of Ubuntu is released every six months and upgrades to new
releases are free of charge. Users are encouraged to upgrade with each new release in order to enjoy the latest features and
applications. Its versions are named using the Y.MM (name) scheme, where Y indicates the year and MM refers to the month of
release. The name in brackets is a code name given to the version pre-release.

Each release is supported for 18 months; Long Term Support releases (LTS) are supported for 3 years on the desktop and 5 years
on the server.
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Figure 1.4: Ubuntu Versions

A brief history of releases:

* Ubuntu 4.10 (Warty Warthog) Ubuntu 4.10 was the first release of Ubuntu in October 2004; supported until April 2006.

Nice to Know:
The early testing community of version 4.10 was called the Sounder, named after the collective noun for warthogs. The
Sounder mailing list continues today as an open discussion forum for the community.

* Ubuntu 5.04 (Hoary Hedgehog) Released in April 2005; supported until October 2006.
* Ubuntu 5.10 (Breezy Badger) Released in October 2005; supported until April 2007.

* Ubuntu 6.06 LTS (Dapper Drake) The first release with Long Term Support (LTS); it was released in June 2006. Long-term
support version refers to guaranteed three years of support on the desktop and five years on the server. All other releases are
provided with 18 month support for desktops and servers. The extended support period provides reassurance and makes it
easier and more practical for large deployments of Ubuntu. Desktops supported until June 2009; servers supported until June
2011.
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e Ubuntu 6.10 (Edgy Eft) Released in October 2006. This version guarantees a robust boot process; supported until April 2007.

* Ubuntu 7.04 (Feisty Fawn) Released in April 2007. This version introduced significant improvements to network roaming;
supported until October 2008.

* Ubuntu 7.10 (Gutsy Gibbon) Released in October 2007. Key features include spectacular visual effects by default, fast user
switching, printer auto-detection and easier desktop file searching and tracking; supported until April 2009.

* Ubuntu 8.04 LTS (Hardy Heron) Released in April 2008. Ubuntu 8.04 LTS forms the second Long Term Support release of
Ubuntu. Desktops will be supported until April 2011; servers supported until April 2013.

* Ubuntu 8.10 (Intrepid Ibex) Released in October 2008. Ubuntu 8.10 includes hundreds of improvements and full 3G support.
This release will be supported until April 2010.

* Ubuntu 9.04 (Jaunty Jackalope) Releasadin April 2009. Ubuntu 9.04 is the latest cutting edge Ubuntu release, bringing the
Eucalyptus Cloud to the Ubuntu community. This release will be supported until October 2010.

e Ubuntu 9.10 (Karmic Koala) Scheduled for release in October 2009, Ubuntu 9.10 will be the next Ubuntu release. This
release will be supported until April 2011.

1.3.3 Ubuntu Derivatives

Ubuntu is also available in several editions such as Ubuntu, Edubuntu, Kubuntu and Xubuntu. Edubuntu is Ubuntu customised
for the school environment. Kubuntu is an official derivative of Ubuntu based on the work of the K Desktop project (KDE). KDE
is a powerful graphical desktop environment, combining ease of use and contemporary functionality. Xubuntu is intended for
users with less-powerful computers or those who seek a highly efficient desktop environment on faster systems.

1.3.4 Ubuntu Development and the Community

Ubuntu is a joint collaboration project comprised of Ubuntu community members all around the world. Since its inception
in 2004, thousands of contributors have joined the Ubuntu community. These users contribute towards Ubuntu development
through writing code, advocacy, artwork, translations, testing and documentation (to name just a few). The development process
of Ubuntu is open and transparent to all, whether you are a novice Ubuntu user or an experienced Ubuntu developer - everyone
is welcome to get involved with and improve Ubuntu. Canonical also employs developers to contribute to Ubuntu.

How you can get involved The Ubuntu community is made of many individuals and teams who work on different aspects of
Ubuntu. If you are a developer, you can participate in the core development, write new applications, package additional software
and fix bugs. If you are an artist, you can add value to the look and feel and functionality of Ubuntu. You can also provide online
support, write documentation, assist with training material, join Web forums and the mailing lists of Ubuntu. There are lots of
ways to get involved!

Developer Zone The developer zone is comprised of developers who create and package software, fix bugs and maintain Ubuntu.
They are responsible for ensuring that Ubuntu has a wide catalogue of software and it operates reliably and smoothly. A great
way to get started as a packager is to join MOTU - see https://wiki.ubuntu.com/MOTU/GettingStarted.

Idea Pool If you have ideas for projects, proposals and enhancements but do not necessarily want to implement them, you can
add the ideas into the idea pool available at https://wiki.ubuntu.com/IdeaPool.

Technical Users If you have the requisite technical skills, you can contribute to the Ubuntu community in the following ways:

* Test the pre-release versions of Ubuntu to help find bugs before the final release.

* Report bugs and help the development team analyse them.

* Triage (edit and categorise) bugs to read, assess and sort them before they can be fixed.
* Join an e-mail support list or discussion list on the Ubuntu mailing lists.

* Join Web forums and respond to requests.

* Join the Ubuntu support and discussion Internet Relay Chat (IRC) channel, which is a form of real-time Internet chat.
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Non-Technical Users Even if you do not have technical knowledge of Ubuntu, you can help Ubuntu users through the following
projects:

* Artwork and design
* Translation and localisation
* Writing and updating documentation and training materials

e Advocacy

Ubuntu Desktop Course Development Part of Canonical’s mission is to enable the widest deployment of Ubuntu on as many
computers and servers, in as many corners of the world as possible. Training is seen as a core enabler for the adoption of Ubuntu
and as such courses are designed to certify Ubuntu professionals, assist partners to deploy Ubuntu and show desktop users (such
as yourselves) how to use and get the most out of it. For more information on Ubuntu course availability and certifications, please
refer to http://www.ubuntu.com/training.

As with software development, the community contributes towards the development and enhancement of this desktop course. As
Ubuntu experts, the community defines the scope and structure of the training by identifying requirements from the users’ per-
spective; they also assist the Canonical and third-party content writers in developing content and reviewing it. More information
on the Ubuntu Training community effort can be found at http://wiki.ubuntu.com/Training.

The entire content development process is in the true spirit of Ubuntu’s philosophy and the open source tradition.

1.4 Ubuntu and Microsoft Windows: Key Differences

Open source differs from the proprietary software model in that it:

* Encourages customisation and variation as opposed to a one size fits many approach.
* Relies on a ’services attached’ business model rather than per license and seat basis.

* Believes that the benefits of collaboration and multi-developer contribution outweigh those of controlled project work of
smaller, paid developer teams.

Looking at each element outlined in the table in greater detail:

Associated Costs: The Microsoft Windows OS is proprietary and the overall price increases with added functionality and
applications. The associated price is sometimes a factor of using third party applications and not just a Microsoft decision. With
Ubuntu new release versions and applications are free.

New version releases: There is only one released version of Ubuntu and therefore features available to home and professional
users are the same. The Home and Professional editions of Microsoft Windows are not the same. For example, Microsoft
Windows Professional editions have more security features than Home editions.

Ubuntu’s 6 monthly release cycle also makes it very easy for users to have access to all the latest applications. An upgrade from
one release to the next is free and fully supported. Microsoft scheduled releases are less frequent and less visible to the public.

Security aspects: Ubuntu is rarely targeted by malware and viruses. The administrative user root is locked by default in Ubuntu
and only certain tasks are run with administrative privileges. Microsoft Windows provides an environment where people can
access administrative user directly.
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Attribute

Ubuntu

Microsoft Windows

Costs

* Free of licensing charges

* Charges per user license and/or for a
fixed term

Versions Released

¢ Same version and features for home and
professional users

 Six-monthly fully supported free release

¢ Separate Professional and Home
editions

* Less frequent and less visible release
schedule

¢ Locked administrative user root

* Enables easy access to administrative
user

» Easy to migrate and replicate user data
and configuration to another computer

Security
» Rarely targeted by malware and viruses | * Regularly targeted by malware and
viruses
 Easy to design and personalise » Standard OS with limited options to
o . . personalise
Customisation + Can run different flavours of Ubuntu in
parallel  Paid for additional applications
» Easy to upgrade and downgrade
» User data saved in multiple locations
 User data stored in home directory
Data Storage « Difficult to backup and migrate to

computer

Table 1.1: Key Attributes
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Figure 1.5: Ubuntu Security

Customisation: As you will discover throughout this course, Ubuntu is yours to design and personalise. You can have different
flavours of Ubuntu running parallel; for example, you can install the Kubuntu (KDE) desktop together with Ubuntu (GNOME)
and then select the desktop environment you want to use. More than 17,000 packages are available and easily accessible through
the Internet. As a result, you are not stuck with using one version because it was the first you installed.

Microsoft Windows is a standard OS with some options for customization. While many applications are available, most are
proprietary software which incur a license fee.

Figure 1.6: Desktop Customisation

Data Storage: User data is often located in multiple locations in Microsoft Windows, which can make backing up and migrating
from one computer to another tricky. Ubuntu saves your user information in one place - the home directory. This makes the
migration of data from an old computer to a new one easy, as well as keeping user specific backup data separate.

1.4.1 |Installation

* OS Installation: Both Microsoft Windows and Ubuntu come as pre-installed OSs on computers. However, to install post-
purchase, Ubuntu can be freely downloaded from the Internet or a free CD can be requested. Any Microsoft Windows version
will need to be purchased.

Ubuntu comes in live-CD mode which means you can use the OS directly from the CD without installing it on a host computer.
If you like what you see, install it. If you don’t, pass it on to a friend. The live-CD option is also useful for system recovery.

The installation of Microsoft Windows and Ubuntu is easy and conducted by running the installation CD and booting the
computer. Both installations vary in length according to how powerful your computer is, with an average install taking 20 - 30
minutes.
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Installation Ubuntu Microsoft Windows
¢ Freely downloadable from the Internet * Purchase required
. or using a free CD
OS Installation g * OS must be installed on computer hard
* Can be used directly from the live-CD drive

. L . * Limited selection of software available
* Huge variety of applications available

by default
Software by default o ) i -
Installation « All freely downloadable from the SCIS Cafl purchase and cown’oac some
Internet software online, others can only be

manually installed

Table 1.2: Installation Differences

* Software Installation: You can add software on Ubuntu by using the Add/Remove Applications and Synaptic Package Man-
ager. The Add/Remove Applications allows you to search the entire directory of free applications recommended for Ubuntu
and install the ones you want. In Microsoft Windows, each programme supplies its own installation method. Microsoft Vista
has a Digital Locker feature enables users to purchase software online and download it in a protected manner.
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Figure 1.7: Installing Software Applications

1.4.2 Applications

The table below displays a comparison between Ubuntu and Microsoft Windows applications:
Looking at each element outlined in the table in greater detail:

Networking, Web browsing and E-mail Network setup on both Ubuntu and Microsoft Windows is easy. Web browsing features
are more or less the same on both OSs.

Mozilla Firefox is loaded as the default browser on Ubuntu, and Internet Explorer is the default browser on Vista. You can also
install Firefox on Microsoft Windows.

Evolution is the default e-mail client on Ubuntu. It connects to POP accounts, conventional UNIX mailboxes and Exchange
servers via Outlook Web Access. Evolution also has a built-in Personal Information Manager (PIM) and a calendaring and
appointment system. The Microsoft Windows Mail application in Vista is a rewritten version of Outlook Express, with a stripped
down calendar or appointment application, Microsoft Windows Calendar. An upgrade to Outlook is suggested if you use the
calendar often or if you have a full PIM. Ubuntu users enjoy the out-of-the-box mail client setup facility.
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Applications Ubuntu Microsoft Windows
. * Internet Explorer Web browser by
Web browsing and Firefox Web browser by default default
E-mail . i ~mail cli
Evolution e-mail client by default « Outlook e-mail client by default
Word Processing * OpenOffice.org suite * WordPad by default
¢ Includes Audio CD Extractor, Brasero, ¢ Includes Microsoft Windows Media
Multimedia Rhythmbox, Movie Player and Sound Player 11 (WMP) and Microsoft
Recorder Windows Media Center (WMC)
Image Editing and * F-Spot photo manager * Picture Gallery application
Picture ) ] o )
Management * Gimp for image editing * Paint

Table 1.3: Application Based Differences

File Edit Wiew Folder Message Search Help

a_| @ @ &0 I T L, * s
New Send / Receive Reply Replyto Al Forward Print Delete Junk Mot Junk Cancel
O Inbox 1total Show: | All Messages 3 Seargh: | & Subject or Sender contz  |in | current Folder %
< On This Computer (=18 l;i Fom | Subj.e(r | Data )
inb The Evolution Team <evolution@no... Welcome to Evolution! 14 Mar 5:30 PM |
nbox
3 Deleted tems
L Drafts
7 Junk
B outbox
[l sent From: The Evolution Team <evolution@novell.com>
< Search Folders To: Ewvolution Users <ewolution@novell.com>

Subject: Welcome to Evolution!

&4 Unmatched Dale: 14 Meiili 2007 12:00.00 +0000 (17.30 /5T)

» The Evolution Team is proud to welcome you to Evolution, a complete system (@

for managing your communications and personal information.

Mail ‘
— Getting Started
‘ a Contacts ‘ ©On the left of the Evolution window is the side bar, with shorteuts to all your mail folders. Below that, you will find il
e R — buttons for your calendars, contacts, tasks, mail and memos,
‘ Ej Calendars ‘ For a complete guide to using Evolution, select Table of Contents in the Help menu, or press the F1 kay.
‘ [4 memos ‘ New Features
(e 1 Evolution 2.10 brings you
‘ E Tasks ‘ O Integration with gtk-print
— O Customizable fetching of IMAP headers -
==

Figure 1.8: Evolution E-mail Client

Word Processing: The OpenOffice.org suite is installed on Ubuntu by default and provides many features of Microsoft Office.
Vista comes with WordPad by default; the full version of Microsoft Word (or Office) for Microsoft Windows, is available at an
additional cost.
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Figure 1.9: OpenOffice.org Writer

Multimedia: Several multimedia programmes are configured by default on Ubuntu, such as Audio CD Extractor, Brasero Disc
Burning, Rhythmbox Music Player, Movie Player and Sound Recorder. Rhythmbox is the default application for playing audio
CDs and organising music and playlists. Rhythmbox is similiar to Microsoft Windows Media Player. You can use Brasero to
author audio CDs.

To play the mp3 format on Ubuntu, you need to install a codec pack. This is because Ubuntu is not distributed with mp3 codecs
due to licensing restrictions. Playback of mp3 files is enabled by default on some versions of Microsoft Windows.

Vista has two multimedia programmes, Windows Media Player 11 (WMP for short) and Windows Media Center (WMC for
short). WMP is best for playing music, and WMC is useful if you are using the computer as your core entertainment system.
WMP can contain a large music library. With the index search system of WMP, you can search music numbers by a particular
artist or search for specific numbers.

Image Editing and Picture Management: With the Picture Gallery application of Microsoft Vista, you can upload thousands
of images and add tags. You can also organise the images quickly and work on them easily because you can tag them with one
click. F-Spot photo manager organises your personal photos on Ubuntu. It integrates seamlessly with popular Web based image
databases, such as Flickr and Picasa Web.

Ubuntu provides GIMP for image editing which is a powerful Photoshop-like application. Microsoft Windows Vista provides
’Paint’ for basic image editing.
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1.5 Lesson Summary

In this lesson, you learned:

* The fundamental concepts of open source

* How Ubuntu ties in with open source
* How Ubuntu is developed

e The Ubuntu version naming conventions

1.6 Review Exercise

Question: What is meant by the term free software?

Answer:
Question: What is the Ubuntu promise?

Answer:

Figure 1.10: GIMP

The link between the Free Software Movement, open source and Linux

The key differences between Ubuntu and Microsoft Windows

Question: Match the Ubuntu versions with the years in which they were released.

1) 7.04 a) June 2006
2)4.10 b) October 2007
3) 6.06 ¢) April 2007
4)7.10 d) October 2004

Answer:

Question: List 3 ways in which non-technical users can contribute towards the development of Ubuntu.

Answer:
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Question: The default web browser on Ubuntu is
Answer:

Question: The default e-mail client on Ubuntu is

Answer:
Question: What are the advantages of Ubuntu 6 monthly releases?

Answer:
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Chapter 2

Exploring the Ubuntu Desktop

OBIJECTIVES

The highlights of Ubuntu desktop

* How to change the default language

* How to create a new user account and take advantage of user switching
* To add and remove applications

* How to enable 3D Desktop effects

This section serves as a quick tour of the Ubuntu desktop. The course will go into more detail in later lessons, but this will give
you a taste of what’s ahead.

2.1 Ubuntu Desktop Components

Note: Note:

GNOME is the default desktop environment for Ubuntu. GNOME (GNU Network Object Model Environment) is an interna-
tional effort to build a complete desktop environment—the graphical user interface, which sits on top of a computer operating
system—entirely from free software. This goal includes creating software development frameworks, selecting application soft-
ware for the desktop and working on the programmes which manage application launching, file handling and window and task
management. Community members worldwide contribute to the translation and accessibility of the desktop in multiple lan-
guages. (Reference: http://en.wikipedia.org/wiki/GNOME)

Key Desktop Components on Ubuntu When you start your computer, the first screen displayed on Ubuntu is the logon screen,
where you type your user name and password. The next screen displayed is the Ubuntu desktop. Ubuntu comes with a completely
clean desktop background, free of icons by default.
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Figure 2.1: Default Ubuntu Desktop

You can arrange icons and files on the desktop to access them quickly. If a CD, hard disk or any other external device is connected
to your computer, Ubuntu automatically displays its icon on the desktop to allow easy access to the device.

-Q Applications  Places System e@o

Figure 2.2: Desktop Icons

At the top and bottom of the desktop are two bars, called panels.
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Figure 2.3: Desktop Panels

There are three main menus in the left pane of the top panel: Applications, Places and System.

* Applications: This menu contains all the applications installed on your computer such as games, music players, Web browsers
and e-mail clients.

Applications Places System e@e
% Accessories L

|lﬂ Games 3
_é Graphics >

@ Internet ]
@ office D

4/’ Programming 3

B sound & video  »

@ Add/Remove...

Figure 2.4: The Application Menu

* Places: This menu provides access to your home directory, external devices and network on your computer.
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| Pictures

|5 Videos

g Computer
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i
= Network
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g Search for Files...
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@) Recent Documents

Figure 2.5: The Places Menu

Note: The Home directory is created by default for every user and automatically takes the username. It contains all user-specific
files. In a multi-user system, every user stores personal data in a sub-directory of this directory.

» System: This menu enables you to change the computer settings. You can also access the Ubuntu help system and turn off
your computer here.

-i_‘, Applications Places System e Q| a
9 preferences 3

(o) Administration ¥
e

& Help and Support
& About GNOME

-Ij; About Ubuntu

[ aui..

Figure 2.6: The System Menu

By default, there are three shortcut icons next to the menus on the top panel: Mozilla Firefox, Evolution and Help. You can create
additional shortcuts to any applications and place them here for quick access.

433 Applications Places System @ wed Dec 17, 7:23 PM El] ] william Windsor

Figure 2.7: The Shortcut Icons

1. Right-click the blank area of the top panel and click Add to Panel. The Add to Panel dialogue box appears.

o3 Applications Places System eg\e i wed Dec 17, 7:27pM [§] ] William Windsor
— 4k Add to Panel

& Properties
@ Delete This Panel

' New Panel

@ Help

@ About Panels

Figure 2.8: Adding a Shortcut Icon
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2. The Add to Panel dialogue box displays a list of applications available on your computer. Select an application and click
Add to add it to the blank area of the desktop. If you want to launch the programmes available on the Applications menu,
click Application Launcher. NOTE:

Alternatively, you can drag an application icon from the Add to Panel dialogue box and drop the icon on the panel to create
a short cut to the application.

Find an item to add to the panel:

Custom Application Launcher
Create a new launcher

Application Launcher...
Copy a launcher from the applications menu

Address Book Search
Search for a person in your address book

Battery Charge Monitor
Monitor a laptop's remaining power

@ 0 o«

Brightness Applet
Adjusts Laptop panel brightness

Character Palette
Insert characters

Clipboard Text Encryption
Encrypt, decrypt or sign the clipboard (uses PGP type encryption).

Clock
Get the current time and date

OB E

Connect to Server.. Pt

]
Bach : _-;ii-i Egose

Figure 2.9: Adding Application Launchers

3. The applications grouped in a category similar to the Applications menu appears. Select an application from the available
list, and click Add.

Find an itemn to add to the panel: l

b B ;‘ Accessories
L.

Desktop accessories

b rola Games
Games and amusements

b A Graphics -
« . Graphics applications

Office

b — Internet
Q".:;) Programs for Internet access such as web and email
M Office Applications

’

b # Programming
Tools for software development

b u Sound & Video
Multimedia menu

== Add/Remove... =
Install and remove applications

@

b 1 Preferelnces

(1]

eﬂelp ‘ ‘ = Back H o= Add H Eglose‘

Figure 2.10: Selecting Applications
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The icon of the selected application will be displayed on the blank area of the top panel.

Find an itern to add to the panel: [ |

b 1 }o Accessories e

Desktop accessories

S5 l:-LJ Games
L)
(= Games and amusements

AisleRiot Solitaire
Flay many different solitaire gares

Atomix
Molecule puzzle game

| 8 |[s]

=
.\.

Blackjack
Play the casino card game Blackjack

Chess
FPlay the classic two-player beardgame of chess

N

Five or More
Rermove colored balls from the board by forming lines

D

Four-in-a-Row
Malke lines of the sarme color to win

e,

| FreecCell Solitaire

nl thim mmemiilme Ceaarall rel e

= Back H =k Add H Eglose ‘

3

-

Figure 2.11: Adding Application Launchers

You can change the location of the newly created shortcut icon by right-clicking it and selecting Move. Move the icon anywhere
on the top panel and left-click the icon to freeze its location.

0
Launch
| Properties

== Remove From Panel

Mowve

Lock To Panel

Figure 2.12: Moving Shortcut Icons

Next to the blank area on the top panel (where you can create short cuts of the application) is the fast user switch icon. This icon
shows the current user of your computer. You can click the icon to view other users on the computer and switch to another user.

You will learn more about fast user switching in the Fast User Switching topic of this lesson.
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Figure 2.13: The Fast User Switch Icon

The System tray contains the network and sound icons for quick access to network and sound settings. You can check the network
configuration of the computer and adjust the volume of your computer’s speaker.

The current date and time is displayed next to the System tray. If you click the date and time, a calendar is displayed.

The last icon on the top panel shuts down, restarts, hibernates, locks your computer and places it on standby.

i wed Dec 17, 7:35 PM gl William Windsor

Click to view your appeintments and tasks

Figure 2.14: Top Panel Icons

The first icon on the bottom panel provides quick access to the desktop. If multiple windows are open on your desktop and you
would like to minimise all of them together, click this icon. Clicking again will display your windows in their original state,
before you minimised them.

[&] G

Figure 2.15: Show the Desktop

Next to the icon used to minimise the windows is a blank area in which the list of open application windows appears, similar to
the taskbar in Windows. When you open an application, it’s listed on this area for easy access, as shown in the bottom panel of
the following screen:

@ [Documents - File Br... || =1 [Chess] - E’

Figure 2.16: Open Applications

The next icon, workspace, enables you to split the windows that are open on your desktop into multiple workspaces. You can
then navigate among the workspaces by pressing and holding down the CTRL+ALT keys, and then pressing either the left or the
right arrow key. This reduces the clutter on your desktop and eases navigation between windows.

For example, you might have the Firefox window, an OpenOffice application, a search window and a calculator window open on
the desktop.
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Figure 2.17: The Workspace Icon

You can move the Firefox window to a separate workspace by pressing and holding down the CTRL+ALT+SHIFT keys and
then pressing the left or the right arrow key. Two workspaces will be displayed in the bottom-right corner of the desktop - one
workspace with the Firefox window and the original workspace with the other windows.
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Getting Help with Ubuntu:
There are many ways to get help with Ubuntu.

Access Ubuntu's guides and documentation by selecting "Help” from your
System menu, You can also find help from the official Ubuntu documentation
website and the community contributed documentation.

(2
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Figure 2.18: Switching Workspaces

Now, you have two separate workspaces. Notice that the Firefox window has shifted to the original workspace. So, depending
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on the task you perform, you can split the windows into different workspaces.
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Figure 2.19: Splitting Windows into Workspaces

By default, Ubuntu provides two workspaces. If you want to split the windows into more workspaces, you have to add the

workspace to the desktop by right-clicking the workspace icon and then clicking Preferences. The Workspace Switcher Pref-
erences dialogue box appears.

[ & preferences
| @ Help

(%) Get Help Online...
3 Translate This Application...
| it Report a Problem

&) sbout

=1 Remowve From Panel

v Lock To Panel

]

Figure 2.20: Creating New Workspaces

In the Workspace Switcher Preferences dialogue box, type or select the number of workspaces from the Number of workspaces
list and click Close.
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Figure 2.21: Workspace Switcher Preferences

The specified number of workspaces will be displayed in the bottom-right corner of the desktop.

The last icon in the bottom panel is the Waste basket. It contains the files you deleted from your computer. Right-click the icon
and click Open to open the Trash window.

] Open
Empty Trash

@ Help
) About

= Remowve From Panel

« Lock To Panel

s

Figure 2.22: The Waste Basket Icon and Menu

You can delete an item permanently from the computer by pressing the DELETE key.
Alternatively, you can right-click the item and click Delete from Trash to permanently delete it from the computer.

If you want to restore the deleted item to the desktop, drag that item to the desktop from the Trash window.
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Figure 2.23: Deleting Items from Trash

2.2 Changing the Default Language

Nice to Know:
Ubuntu supports more than 100 languages. You can set the default language of your computer either during the installation of

Ubuntu or at a later stage.
To change the default language during the installation, select the required language when prompted.

1. On the System menu, point to Administration and click Language Support. The system prompts you to install language
support if updates are available for your selected language.
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Figure 2.24: Configuring Language Support

2. Click Install to continue. On completing the updates, the Language Support dialogue box opens.

Supported Languages

Language Support =

Achinese
Afar

Afrikaans
Albanian

Armharic

o i e T[]

(a7

Arshir

Default Language
Default language for new user accounts and the login screen:

ar

English (United States)

Input method

[} Enable support to enter complex characters

Ll |[0Qance| [ &QK I

Figure 2.25: Installing Language Support Updates

3. In the Language Support dialogue box, from the Supported Languages section, select the check box for the language
you want to use for support functions in Ubuntu.
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Figure 2.26: Installing Default Language Support

4. Click Apply and then click OK. Ubuntu downloads and installs the necessary packages on your computer. The language
you selected will now appear in the Default Language box.

5. Select the language that you want set as default, and click OK.

6. For the changes to take effect, log off and then log on again.

You can change the language as many times as you would like and this can depend on your location. For example, changing the
language to Russian may be a nice touch when presenting in Russia during a business trip.

2.3 Creating a User Account and Fast User Switching

You may have multiple users who want to access your system. In this case, there is a risk of data being manipulated or corrupted
by other users. To prevent this from happening, you can create user accounts for each individual who wants to use your computer,
giving each user an individual account with personalised user settings. For example, it is useful to give children their own accounts
on the computer to prevent then from changing your settings or accessing unsuitable files and applications..

1. On the System menu, point to Administration and click Users and Groups. The User settings dialogue box appears.
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Figure 2.27: Adding/Removing Users

2. In the User settings dialogue box, click Add User to add a new user account on your computer. The New user account

dialogue box opens.

MName Login name Home di l ok Add User J
= roat root Jroot |
(2} charleswindsor charleswindsor thomejc |_

Figure 2.28: Adding a User

3. Specify the user accounts’ basic settings, contact information and password information in the New user account dialogue

box.

(a) Type the name with which you want to log on to your computer in the Username box.

(b) Type your full name in the Real name box.

(c) Select your user type from the Profile box.

(d) Type your office location in the Office location box.

(e) Type your work phone number in the Work phone box.

(f) Type your home phone number in the Home phone box.

(g) Type the password for your user account in the User password box.

NOTE:

This information is for record keeping only, and other users cannot view it.

Click Close to save the settings.
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Figure 2.29: Configuring New User Account

4. A new user account will be displayed in the User settings dialogue box. This dialogue box displays the new user’s full
name and login name. It also tells you the location of the new user account created.
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Figure 2.30: The New User Account

Now, if you click the fast user switch icon, there will be two users displayed and the current user logged on to the computer will
be marked.

{3 Applications  Places. System @L—\Q
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= Eel|n| User Switcher

=) Charles Windsor
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Figure 2.31: Switching Users

This feature prevents you from logging off and logging on all the time to switch users. It allows multiple users to switch quickly
while staying logged on. By simply clicking the fast user switching icon, a list of the user names appears. Select the user name
and you will be directed to the logon screen. Type the user name and password, and you will be on a desktop of the new user.
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When you switch to another user, the previous user screen is locked by default, so the other person cannot make any profile
changes.

2.4 Adding/Removing Applications

USE THE ADD/REMOVE APPLICATIONS WHEN YOU NEED TO:

» Use software not provided as a default application on Ubuntu.

» Try an alternative application to the one already installed

Ubuntu contains pre-loaded software that you can easily install on your computer when required. You can install this software by
using the Add/Remove application or the Synaptic Package Manager utility of Ubuntu. To access the Add/Remove application,
on the Applications menu, click Add/Remove.

QApplications Places System @'l;‘ e Wl Wed Dec 17, 7:54 PM dff] William Windsor
[y Accessories

[¥} Games »

"E Graphics
| €& Internet »
| lig office .
_.,’ Pregramming

| B3 sound & video  »

: @ Add/Remove...

install and remove applications

Figure 2.32: Launching Add/Remove Applications

To access Synaptic Package Manager, on the System menu, point to Administration and click Synaptic Package Manager.
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Figure 2.33: Launching Synaptic Package Manager

Synaptic offers an advanced way of installing packages. If you do not find a software programme in the Add/Remove tool, you
can search for it in Synaptic. It searches all software in the available repositories on Ubuntu.

2.5 Desktop Effects - Compiz Fusion

Compiz Fusion is a 3D window manager that makes use of 3D accelerated graphics cards found today on many desktops and
laptops. It provides a number of visual effects that makes the Linux desktop more powerful and intuitive, as well as easier and
more fun to use. For example, you can place workspaces on a cube, which enables you to move from one workspace to another
easily.

Compiz Fusion is enabled by default on Ubuntu 8.04 LTS with appropriate graphics cards. It enables the 3D desktop visual effects
that improve the usability and visual appeal of the system. You really have to see and play with this application to appreciate the
benefits.

1. On the System menu, point to Preferences and click Appearance. The Appearance Preferences dialogue box appears.
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Figure 2.34: Opening the Appearance Preferences Dialogue Box

2. In the Appearance Preferences dialogue box, there are three pre-configured levels of special effects settings: No effects,
Normal effects and Extra effects. You can select any one of them:

Thermea I Background I Fonts I Interface | Visual Effects

None: Provides a simple
@ @ desktop environment without

any effects,

Normal: Provides improved usability and
® \ good balance between attractiveness and
moderate performance requirements,

. Extra: Provides more aesthetically pleasing set
O A
of effects. Requires faster graphics card.

Figure 2.35: Configuring Visual Effects

If you want a simple desktop without any special effects, select None. If you want a desktop with a balance of attractiveness
and average performance, select Normal. If you want various desktop effects, such as wobbly windows, desktop cube and many
more, select Extra. For example, while you are waiting for an update to complete or an e-mail client to import e-mail messages,
you can turn on the Wobbly effect. The windows will start dancing and displaying the 3D effects. Play with it a little, it’s fun!




Ubuntu Desktop Training
48 /348

2.6 Lesson Summary

In this lesson, you learned that:

* Ubuntu utilises the GNOME desktop by default

* You can set the default language of your computer either during the installation of Ubuntu or at a later stage

* Fast user switching enables you to share your computer with other users without sharing your files

* You can install software by using the Add/Remove application or the Synaptic Package Manager utility of Ubuntu

* Compiz Fusion is enabled by default on Ubuntu 8.04 LTS and provides fun, 3D desktop visual effects

2.7 Review Exercise

Question: At the top and bottom of the desktop, you have two bars, called

Answer:

Question: Which are the three shortcut icons already present on the top panel?
Answer:

Question: What is fast user switching?

Answer:

2.8 Lab Exercise

Exercise: You have bank-related information on your computer and want to block others’ access to it. Your friend wants to use
your computer for some time. To handle this situation, create a new user account for your friend and use the fast user switch
feature.

1. On the System menu, point to Administration and click Users and Groups. The User settings dialogue box opens.
2. In the User settings dialogue box, click Add User. The New user account dialogue box appears.

3. In the dialogue box, specify the following information:

(a) Type charles in the Username box.
(b) Select Desktop user from the Profile box.
i. Type charles windsor in the Real name box.
ii. Type England in the Office location box.
iii. Type 111111 in the Work phone box.
iv. Type 99999 in the Home phone box.
v. Type password@1 in the User password box.
vi. Click Close to save the settings.

4. Click the fast user switch icon on the top panel. Click charles. The logon screen appears.
5. Type charles in the Username box and password@1 in the Password box.
6. Your friend can now work on this desktop.

Your friend cannot access your user account because the computer will ask for your password to log on to the account. So, your
personal data is safe.
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Chapter 3

Using the Internet

OBIJECTIVES

* Connect to the Internet

* Browse the Web

* Use an RSS newsreader

* Send and receive e-mail messages

* Use various tools for instant messaging

* Make phone calls using Softphones

3.1 Connecting to and Using the Internet

The Internet is used by millions of people daily for work and entertainment. Searching for information all over the world,
corresponding with friends and relatives, participating in discussion forums, reading the news, playing games, has never been
easier... or more accessible.

The means of connecting to the Internet is not always a choice and depends greatly on where you live and/or work and the
surrounding infrastructure. The pre-requisites to connect to the Internet are an Internet Service Provider (ISP) subscription and a
functional Internet connection in your area. Configuring the Internet connection requires minimal involvement from you. Ubuntu
supports most connection types. This lesson will cover: Broadband (cable or ASDL), dial-up and direct access through Local
Area Network (LAN).

Broadband connections are fast and reliable connections that users subscribe to for a monthly fee. Broadband companies offer
packages with different speed specifications and bandwidth limits. If you travel and need Internet access, you can purchase a
wireless Internet connection. If your computer does not have one pre-installed, you will need to install a wireless card. This
connection is similar to a satellite connection, where data is transmitted through the airwaves.

Dial-up access uses the same lines as your phone connection, except that the parties at the two ends are computers. This is a slow
and cheap connection that uses a phone line to connect to a local server. Your computer dials a phone number that is provided by
your ISP and connects to the server. Consequently, you cannot make phone calls while you are connected to the Internet. This is
the oldest and slowest means of connecting; carrying out many functions using this mode can be very tedious and frustrating.

3.1.1 Network Manager

The Network Manager on Ubuntu is a simple to use and powerful utility to stay connected with wired and wireless adapters. It is
located on the top menubar at the outer right corner. A left-click will reveal if your computer is already connected to a wired or
wireless network. In case of a wireless network that is protected by a password, a dialogue will appear and ask for the password.
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The password can then be stored in your keyring, where it will automatically be used when needed. However, you may be asked
for your keyring password if you have to log out.
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Figure 3.1: Network Manager
You can also right-click on Network Manager to enable and disable wireless and wired connections. The connection information
allows access to the network parameters currently used.
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Figure 3.2: Network Manager Connection

If Network Manager does not automatically configure your network connections, you can fall back to manually configuring them.

3.1.2 Using a Cable Connection

1. On the System menu, point to Administration and click Network. The Network Settings dialogue box will be displayed.
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Figure 3.3: Accessing Network Settings

2. Click on the Unlock button and enter your Administrator’s password.

3. On the Connections page, select the connection to use. Click Properties. The eth0 Properties dialogue box will be
displayed.

Location: | B 3 |

Connections | General l DNS l Hosts |

eﬂelp I "‘-J_—-Lgnlockw I Bglose

Figure 3.4: Network Settings

4. Clear the Enable roaming mode check box to enable the connection. NOTE:

Most broadband providers will use Dynamic Host Control Protocol (DHCP) to provide you with an IP address. If a Static
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IP address is required, it will be provided by your network administrator. The following steps are for setting up a static IP
address.
(a) In the Configuration box, select the Static IP address option.
(b) Type the IP address of your computer in the IP address box.
(c) Type the subnetwork (subnet) mask of your computer’s IP address in the Subnet mask box. NOTE:
A subnet mask divides a network of IP addresses into groups, which facilitates routing of data.
(d) Type the IP address of your ISP in the Gateway address box. NOTE:

A gateway is a device that connects a user to the Internet. It is provided by the ISP.

Network Settings [;J[E]E
Location: = l @ . i
4= EED T OPETTIES S

logancel l I QﬂgK ]

w .- '__s:.-‘i_‘| Eglose

Figure 3.5: ethO Properties

5. Click OK to complete the configuration for the cable connection.

Location:
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B Wireless connection
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Figure 3.6: Network Settings

Now, you can connect to the Internet by using the cable.
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If your internet provider uses DHCP (Dynamic Host Connection Protocol) you simply need to select Automatic Configuration
(DHCP) from the Configuration drop down menu.

3.1.3 Using a Wireless Card
Ubuntu automatically detects support for various wireless cards.

1. On the System menu, point to Administration and then click Network. The Network Settings dialogue box will be
displayed.

2. If the wireless card on your computer is listed, you can use the same procedure as listed in the Using Cable Connection
section to connect to the Internet.

B EEE]
Location: = |:J‘ | ﬁ |
Connections | General | DNS | Hosts ‘
= Wireless connection | | Broperties ‘
Roaming mode enabled
Wired connection
=
Roaming mode enabled
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I 0 Help ‘ | | Qlcsa |

Figure 3.7: Choosing a Wireless Connection

Alternatively, left-click on Network Manager and discover any detected wireless networks in range.

Nice to Know:
To view the complete list of wireless cards that work with Ubuntu, refer to: https:/help.ubuntu.com/community/WifiDocs/-

WirelessCardsSupported.

Some wireless cards are not listed on the Ubuntu Web site because open source drivers for these are not available. Therefore,
these cards do not work automatically with Ubuntu. If your wireless network card does not have an open source driver, you can
make it work by using ndiswrapper.

Using Ndiswrapper with a Wireless Card Ndiswrapper is a Linux module that allows Ubuntu to use Microsoft Windows
drivers for wireless cards. The utility to configure ndiswrapper can be installed comfortably via Add/Remove Applications. The
Windows Wireless Drivers setup programme can be found in System Administration.

3.1.4 Using a Dial-up Connection
A dial-up connection uses a modem to connect to the Internet. You can use the ScanModem tool to identify the type of modem.

This tool recognises the type of modem-whether it is a Peripheral Component Interconnect (PCI) or a Universal Serial Bus (USB)
modem.

Nice to Know:
To download the ScanModem tool, refer to: https://help.ubuntu.com/community/DialupModemHowto/ScanModem.
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1. Download, configure and install your modem’s driver. If an open source driver is not available, contact your vendor for
other options. NOTE:

To download the open source driver, refer to www.modemdriver.com.

2. CONFIGURE THE DIAL-UP CONNECTION TO YOUR ISP:

(a) On the System menu, point to Administration and click Network. The Network Settings dialogue box will be
displayed.

(b) In the Network Settings dialogue box, select Modem connection and click Properties. The ppp0 Properties
dialogue box will be displayed.

JE" Tie ”'ﬂ"l:&ﬂ lil ) _::E'
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Figure 3.8: Network Settings

(c) In the ppp0 Properties dialogue box, select the Enable this connection check box to activate the connection.

(d) Specify your ISP’s information and your account information, which you can obtain form your ISP.
Type the phone number in the Phone number and the dial prefix in the Dial prefix box, which the modem uses to
connect to the server. Type your dial-up account name in the Username box and the password in the Password box.
The user name is the one that is registered with your ISP.

(e) Specify the modem setting on the Modem tabbed page. Click the Modem tab. Type or select the modem port in the
Modem port box. Select the dial type from the Dial type box. You can select the types of phone dial used in the Dial
type box. Dial type depends on your phone company and may be Tones or Pulses. If you do not know which dial
type to choose, contact your phone company. Irrespective of the dial type, the modem will make some noise while
connecting to the ISP server. You can set the volume of this noise by selecting the appropriate volume options from
the Volume box-it is recommended that you select Off or Low.

(f) Specify the connection settings. Click the Options tab and select the Set modem as default route to Internet check
box to specify the dial-up modem as the default Internet connection. If you use a laptop on a local area network
(LAN), clear the Set modem as default route to Internet check box. Select this option only if you use a dial-up
connection.

As part of modem connection settings, you need to assign a host name to an IP node to identify it as a TCP/IP
host. You can select your ISP server for this name resolution of hosts, which maps a host name to an IP address
successfully. For this, select the Use the Internet service provider nameservers check box.

If the Internet connection breaks, your modem will automatically try reconnecting to the Internet if the Retry if the
connection breaks or fails to start check box is selected.

(g) Click OK to complete the dial-up configuration.
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Figure 3.9: pppo Properties

Now, you can connect to the Internet using a dial-up connection.

3.2 Browsing the Web

Note:

Mozilla Firefox is the default web browser on Ubuntu. It is open sourced, developed by the Mozilla Corporation and many
external contributors and is fully compatible with Ubuntu. To open a Firefox Web browser, on the Applications menu, point to
Internet and click Firefox Web Browser.
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é.i_, Terminal Server Client
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Figure 3.10: Launching Firefox Web Browser

Firefox includes two powerful features that make your online experience more productive - an integrated search system and
bookmarking.
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Integrated Search This feature enables you to search for and find any information. The Search bar comes pre-loaded with search
engines for Google, Yahoo!, Amazon, eBay, Answers.com and Creative Commons. You can enter a search term in the Search
bar and receive immediate answers from the search engine you choose. You can select a new search engine from the Search bar
menu at any time and add search engines from favourite Web sites.
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Figure 3.11: Available Search Engines

Search Suggestions To further ease your search-related tasks, some search engines such as Google, Yahoo and Answers.com in
Firefox, suggest search terms. Begin typing into the Search bar and a list of suggestions will appear.

For example, if you type king in the Search bar, a list of suggestions to complete your search keyword is displayed. So instead
of typing the complete term, you can select the required term from the list. This makes the search easy and quick.

The following graphic shows a list of suggestions, when you start typing in the Search bar:

ocalesfindex: | = | o | [Glfking
kings of...
kingfizh...
kingston
kingfizsher
kingdo...
kingdo...
king.com
kings isl... |
king of ...
kings d...

3

Figure 3.12: List of Suggestions

Bookmarks If you come across an interesting Web site over the Internet and would like to keep it for future reference, without
trying to remember the URL, create a bookmark. The next time you are online, simply click the link to go to that Web page. You
can view Web feeds such as news and blog headlines in the bookmarks toolbar or menu. A Web feed or feed is an XML Web
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page that contains a list of links to other Web pages. You can quickly review the latest headlines from your favourite sites and
click to go directly to chapters of interest.

A Bookmark in Firefox, similar to favourites in Internet Explorer, is a useful browser feature.
1. Open the Firefox Web browser. On the Bookmarks menu, click on Bookmark this page.
2. The Bookmarks dialog box will appear. Select a location to save the new bookmark and add any tags (keywords).

3. Click Done to save your bookmark.

To sort your bookmarks and create new folders, or categories, select Organize Bookmarks from the Bookmarks menu.

3.3 Using an RSS feed reader

News feeds allow you to see when a Web site has added new content. You can get the latest headlines as soon as it is published
without having to visit the website. These news feeds are known as RSS or Really Simple Syndication.

3.3.1 Liferea Newsreader

Note: Note:
Liferea is an online RSS feed reader. It is a fast, easy-to-use and easy-to-install news accumulator for GTK/GNOME.

You can install Liferea on Ubuntu using the Synaptic Package Manager by following the procedure described in Using Alterna-
tive E-Mail Client section.

The Web sites that offer RSS feeds display an RSS feed symbol next to its URL.

Thernage) INEwe T Human B eInge o2l a1 reroX:

File Edit Wiew History Bookmarks Tools Help

& - €

[EiMost Visited > b Getting Started [E|Latest Headlines =

o) i http:/fridge.ubuntu.com/ B | = l I' |king '@g]

P Prducis »  Suppor »  Communily * Fadmes B Hews

3 vbuntu oo [

the fridge

The Fridge

News for human beings

Navigation 4000 Attendees at French Team Release Party

» about Thu, 2008-12-11 20013 — nali

Upcoming eVentS Every & months, the French Team holds release parties. For Ubuntu 8.10, a release party was held in Paris

with 12 install parties throughout France
Server Team Mesling | 1ds-1

. Th release party, organized by ubuntu-party and the French loco team, ubuntu-fr, took place at the "Cite des
Subscribe parly. o Y arly P

scignces et de l'industrie” in Paris, 29-30 November 2008,

MNews: ﬁ Subscribe in a reader

4000 people attended the event, which broke the record from last year, almost 3000 visitors!

-
Events: % cal, ) Ass

Figure 3.13: Identifying RSS Feed Providing Web Sites

Accessing Liferea

You have to search the Web site that offers RSS feeds to access Liferea. Look through the complete list of newsgroups on your
server to search for the group that interests you.
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1. Open the Web page that offers RSS feeds.

File Edit Wiew History Bookmarks Tools Help

[ v c | & | httpijffesds feadburner.comjubuntu-fridge o ‘ - ] |" s500qle @

Most Visited = P Getting Started [f]Latest Headlines =

Ubuntu Weekly Newsletter #120 u
12/07/2008 09:38 PM

The Ubuntu Weekly Newsletter, Issue #120 for the week of November 30th- December 6th,
2008 is now available.

In This Issue:

* Ubuntu Free Culture Showcase ||

* Archive of Interviews

* New MOTU: Onkar Shinde

* Ubuntu Stats

* Ubuntu Tamil Team

* Ubuntu Tunisia Team

* Ubuntu-MNL release party

* Launchpad 2.1.11 and Open ID support
* RSS feeds for Ubuntu forums

*In the Press & Blogosphere

* Ubuntu Podcast #13 =
* Full Circle Magazine #19

* Community Interview of Nicolas Scerpella

* Hardening the Linux Desktop

* Cormning Soon: Ubuntu Pocket Guide & Reference

* 50 amazing Ubuntu time-saving tips

* 50 of the best looking Gnome/Ubuntu desktop themes
* Tearn Meeting summaries

* Upcoming Meetings & Events

* Updates & Security

The Ubuntu Weekly Newsletter is brought to vou by: L=)
Done

Figure 3.14: Opening RSS Feed Web Page

2. On this Web page, search for the link that offers RSS feed. Click the link and save the URL of that link. This URL will be
the feed.

Hle Edit Wiew History Bookmarks Tools Help

= - 6 ﬁa‘ | & | httpyffeeds feedburner.cornjubuntu-fridge ‘ - I I'f '@gl

[ Most Visited ~ W Getting Started [|Latest Headlines ~

Subscribe to this feed using Live Bookmarks e

[ Always use Live Bookmarks to subscribe to feeds.

The Fridge - News for Human Beings

Ubuntu Global Bug Jam 20-22 February 2009
12/17/2008 08:54 PM

Jorge Castro is happy to announce the second Ubuntu Global Bug Jam which will take place from
20 to 22 February 2009.

So, what is the Ubuntu Global Bug Jam? Jono Bacon explains it as “a world-wide online and
F ot

LanE: tocat thor fo Facllb ot b toto cat L

Figure 3.15: Searching the Link

3. Open Liferea. On the Applications menu, point to Internet and click Liferea Feed Reader.
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I g}’ Accessories ’

;:LI Games 3

‘é Graphics ,?ew History Bookmarks Tools Help
| '{bé; Internet ',@' Ekiga Softphone -jeedburner.ccm;ubunt
[ office v| (=] Evolution Mail Headlines =

.._,_-’ Prograrmming r & Firefox Web Browser

w Sound & Video  » | D Liferes Feed Reader

E) Al | a Mozilla Thunderbird Mail| Download and view feedsli
s move,..

Tarks to subscribe

1 ~ @ Pidgin Internet Messenger

B

L_!ﬁ Remote Desktop Viewer Su
| f‘g Terminal Server Client E

1 @ Transmission BitTorrent Client

Figure 3.16: Launching Liferea Feed Reader

4. To subscribe to the feed, right-click anywhere on the left-pane of the Liferea window, point to New and click New Sub-
scription. The New Subscription dialogue box will be displayed.
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-13_ Applications Places System &@0

The Fridge - News for Human Beings - Mozilla Firefox

Feed [tem View Tools Search Help

e =3 & [ [ -

Mew Subscription... MNext Unread ltem Mark As Read Update All Search All Feeds...

= (i3 International... |- | Date ~ | Headline | !
[ Open Sou... I_"n"esterlda'y' 01:00 PM_-The annoyances of proprietar... |
“J Planet ... Yesterday 08:00 AM Open source programming la... ||
J The Ub... Thu 01:00 PM openSUSE 11.1 makes Christ...
€ art.gno... Thu 08:00 AM Three ways to create Web-acc...
€ Gnome... Wed 01:00 PM Barracuda offers a new -- and ... |
€ GNOME... ! Wed 08:00 AM Where has my disk space gon...
@ Grokla.. | || [FlTue 03:16 PM  Ubuntu-snonsored FOSScamn ... |~
| ‘ﬁ‘g‘;:i;?;m” . _"l"E’:eed: Linux.com - -
Ve I_urt:e: http:fwww linux.comjindex rss
Mew P: Mew Subscription... %en Source
| & Delete MNew Folder..,
[ Properties.., MNew Sgarch Folder...
. ﬂTll—)thE--- =Tl MNew Source..,
i@ Unread (254) ‘EL MNew News Bin...
:aj]: . . 254 unread

Figure 3.17: Subscribing to RSS Feeds

5. In the New Subscription dialogue box, paste the URL, which is the feed, and click OK. You will see a new feed in the
Liferea window.

Feed Source

Enter a website location to use feed autodiscovery
or in case you know it the exact feed location.

|http:}ffeeds.feedburner.comfubuntu—fridge |

[ ogancel HAdvanced... ‘ [ Qﬂgl( ]

Figure 3.18: Entering Feed Source

The following graphic shows the new feed in Liferea.
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Subscriptions Feed |tem View Tools Search Help
iy = & & ey -
Mew Subseription... Mext Unread ltem Mark As Read Update All Search All Feeds...
< @ International... || | Date || He=ding =]
v [ Open Sou... Wed 08:54 PM Ubuntu Global Bug Jam 20-22 ...
J Planet ... Wed 08:43 PM Ubuntu on Amazon EC2 Beta ...
“J The Ub... Sun 04:05 PM Ubuntu Weekly Newsletter #1...
€ art.gno... Dec 11 02:13 PM 4000 Attendees at French Tea... || |
€ Gnome... Dec 07 09:38 PM Ubuntu Weekly Newsletter #1...
& GNOME... | Nov 30 04:31 PM Ubuntu Weekly Newsletter #1... | |
@ Grokia.. | || [FlNov2504:43PM_ libuntu Free Culture Showcas... |7
€ Linux. c... Feed: The Fridge - Mews for Human Beings
I & The Fri... ‘ Source: httpiifeeds feedburner.comfubuntu-fridge
= mozilla...
L€ Newsfo...
€ Planet ...
& Slashd...
A TuxMob... =
. Eﬁmage - News for Human Beings" updated... 264 unread (10 new)

Figure 3.19: Viewing New Feeds

1. Liferea Feed Reader has multiple RSS subscriptions by default.

\S]

. If you do not want a chapter to be deleted after some time, you can flag it and tag it as an important item.
3. You can use the search function to search through the downloaded items to quickly access the information needed.

4. You can also use an online search engine to search for additional news.

3.4 Sending and Receiving E-Mail Messages
Evolution is the default e-mail client for Ubuntu. It combines mail, calendar and tasks in one powerful application.
3.4.1 Using Evolution Mail

Note:

1. On the Applications menu, point to Internet and click Evolution Mail.
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System

!_ ! Applications Places
[ Accessories v
\iﬂ Games 3
‘.é Graphics »
@ Internet v I @ Ekiga Softphone
office ’ L;j Evolution Mail

,_;-, Programming » i Firefox Web Browser

Read and write emails

m Sound & Videe  +| [T] Liferea Feed Readsr

Q Mozilla Thunderbird Mailinews

Add/Remove,,.

ﬁ Pidgin Internet Messenger
lﬁ Remote Desktop Viewer
% Terminal Server Client

@ Transmission BitTorrent Client

Figure 3.20: Launching Evolution Mail

Nice to Know:
The .evolution directory is created in the home directory when you run Evolution for the first time. It saves its local data

in this directory. Then, it opens a first-run assistant to help you set up the e-mail accounts. User specific settings for
evolution are also stored in .gconf/apps/evolution.

The Evolution Setup Assistant is displayed and guides you through various steps to enable Evolution to connect to your
e-mail accounts and import files from other applications. Click Forward.

Welcome to Evelution. The next few sereens will allow
Ewvolution to connect to your e-mail accounts, and to import
files from other applications,

Please click the "Forward” button to continue.

{ ogance\ ] | Back | l W Forward I

Figure 3.21: Configuring New E-mail Account

2. Evolution offers an integrated backup system. If you migrate your Evolution data from one system to another, use this
dialogue. On the Restore from backup page, you can restore the backup files such as, e-mails, memos, address book,
personal files and many more from your older version of Evolution.
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SeCUp ASSIStant

You can restore Evolution fram your backup. It can restore all the Mails, Calendars, Tasks, Memos, Contacts,
It also restores all your personal settings. mail filters etc,

] Restore Evolution from the backup file

please select an Evolutian Archive to restors [(Nerel

Restore from backup

{ ogance\ ] [ & Back J Eﬂiﬂmardg

Figure 3.22: Restoring Evolution

3. On the Identity page, type your full name in the Full Name box and your e-mail address in the E-mail Address box. This
is the e-mail address that your ISP provides. Your Evolution account is configured with this information. Click Forward.

NOTE:

Please enter your name and email address below. The
"optional" fields below do not need to be filled in,
unless you wish to include this information in email
you send.

Required Information

Full Name: [leliam Windsor ]

Email Address: Iwmdsorll@gmail.com ]

Optional Information

[ Make this my default account

Reply-To: [

Organization; [

[ogance\ ] [ @ Back ] [ﬂﬁomera]

Figure 3.23: Setting up Account Identity
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You can skip the information in the Optional Information section. You are required to type the information in the Reply-
To and Organisation boxes, only if you want to include this in the e-mail messages you send. In Reply-To box, you can
type your name, favourite quotes or any other information and, in the Organisation box, type any name such as that of
your organisation, school or college.

4. On the Receiving E-mail page, in the Server Type box select the type of server your ISP provides. Evolution is compatible
with numerous server types, but POP is commonly used to receive e-mail messages.

Receiving E-mail

Please select among the following options

Server Type: [None H ]

Description:

‘ ogancel ‘ ‘ & Back I I w Eorward l

Figure 3.24: Selecting Server Type for Receiving E-Mail

NOTE:

If you do not know the server information, you should contact your system administrator or ISP.

(a) Select POP from the Server Type box to connect to and download mail from POP servers. The Receiving E-mail
page will further prompt you for the configuration information. NOTE:

For more information about server types, refer to: https://help.ubuntu.com/community/EmailClients.

(b) Type the receiving e-mail server name in the Server box and your account user name in the Username box. This is
not your login name to your PC but your login name to your ISP’s e-mail account.

(¢) Inthe Security section, you can select Encryption or No encryption in the Use Secure Connection box. Encryption
makes the message unreadable by anyone other than the intended recipient.

(d) Select Password in the Authentication Type box or click Check for Supported Types to have Evolution check for
supported authentication types. The crossed out authentication types are not supported. Generally, the password is
the way you authenticate with the server. NOTE:

Contact your system administrator or ISP to know about the authentication type supported.
(e) Click Forward.
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Please select among the following options

Server Type: [POP b ‘

Description:  For connecting to and downloading mail from POP servers.,

Configuration

Server: [ l

Username: [\n\rwindsorll ]

Security

Use Secure Connection: | Mo encryption 5

Authentication Type

Password = l [ Check for Supported Types ]

1 Remember password

[ ogancel J [ @ Back J | Earward

Figure 3.25: Providing POP Server Information

5. On the Receiving Options page , select the following options, if required:
(a) To automatically check e-mail messages after a particular interval of time, select Automatically check for new mail
every check box. Specify the duration of the interval in the minutes list.

(b) In the Message storage section, select Leave message on server check box , if you want to leave a message on the
server.

(c) Select Disable support for all POP3 extensions check box, if you want to disable POP3.
(d) Click Forward.
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EVDIOIoN SeLUp ASSISLANT

Receiving Options

Checking for New Mail

1 Automatically check far new mail every $ minutes
Message storage
[] Leave messages on server

[ Delete after |7 . day(s)

[] Disable support for all POP3 extensions

{ ogance\ ] [ &a Back J | ﬁiumardg

3

Figure 3.26: Specifying Mail Checking and Storage Options

6. On the Sending E-mail page, specify the information according to the way you want to send e-mail messages. Select the
outbound mail server in the Server Type box.

(a) There are two methods you can use to send e-mail messages, SMTP and Programmes Send Mails. SMTP is the
common method that is used to send e-mail messages. Select SMTP as your outbound mail server type in the Server

Type box.
(b) Specify the outbound server configuration:
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Please enter information about the way you
will send mail. if vou are not sure, ask your
systern administrator or Internet Service

Provider.

Server Type: | SMTP =

Description;  For delivering mail by connecting te a
remote mailhub using SMTP.

Server Configuration

Server: I

[ Server requires authentication

Security

Use Secure Connection: |MNo encryption ¥

Authentication

Type: [PLAIN B

[Chgck for Supported Types

Username: [wwindsorll

[} Remember passward

| @cencel | | gapack | |

Figure 3.27: Providing SMTP Server Information

i. Type the host address in the Server box. This is the address of the outbound server that your ISP provides.

ii. Specify how you want the server to authenticate. Select Server requires authentication check box, if your
server requires authentication. You will be asked to select your authentication type in the Type box. You can

also click Check for Supported Types to have evolution check for supported types.

iii. Type the evolution account user name in the Username box.

iv. Select Remember Password check box, if you want evolution to remember your password. Then, click For-

ward. The Account Management page is displayed.

7. It is possible for Evolution to access multiple e-mail providers. To differentiate between them, you can give each e-mail
provider a name. Type a name for this configuration or your account in the Name box. You can type any name you prefer

as this is only for your reference. Then, click Forward.
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Account Management

Please enter a descriptive name for this account in the

space below.
This name will be used for display purposes only.

Account Information
Type the name by which you would like to refer to this account,
For example: "Work" or "Personal

Mame: {W‘ork

[ ogancel J [ i Back } Eﬂinmard]

Figure 3.28: Providing Account Information

8. On the Timezone page, select the time zone you are in, either on the map or from the Selection list. Click Forward.

[ion Setup Assistant.

O Use the left mouse button to zoom in on an area of the map and select a time zone,
9 Use the right mouse butten te zeemn out.

Time Zones

[+

[

Selection

EuropejLondon

I ogancel } [ éﬁeck J Eﬂﬁcrward:il

Figure 3.29: Specifying Timezone

9. Configuration is done. Click Apply to save your settings. The Evolution window will be displayed.
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Toolbar: Quickly access the most
used features in each component

Message List: List of e-mail

Menu bar: Access many messages recelved Search Tool: Search your e-mail
evolution features messages, contacts, calendars and
tasks easily
- ABoX (1 total) - Evolution
file Edft View Folder Message Search Help
( B4 [54] [ ] A i ‘
D . = & ] 2 =2 & ta Q ‘ =
New Send | Receive Reply Reply to All  Forward Print ete Junk Mot junk cancel
= Inbox 1 total Shuw:‘ All Messages : | / 'Sear;h:“ B subject or Sender contz 1];: ‘ Current Folder 3 |
= i [ol@&! From [e=ds Subject | Date [t
= | The Evolution Team <evolution@no... Welcome to Evolution! 14 Mar 5:30 PM |
2 Inbox |
@ Deleted tems
Folder list: List of available & Drafis
folders for each account
€ Junk
B outbox
[ sent From: The Evolution Team <evolution@novell.com>
o SearchiFaldars To: Evolution Users <evolution@novell.com>

Subject: Welcome to Evolution!

55 Unmatched Date: 14 March 2007 12:00:00 +0000 (17:30 IST)

Status bar: View the
progress of a task

The Evolution Team is proud to welcome you to Evolution, a complete system (17;'

v/ for managing your communications and personal information. W
Mail ‘ =
= | Getting Started
ﬁ Contacts ‘ On the left of the Evolution window is the side bar, with shortcuts to all your mail folders. Below that, you will find 1l
buttons for your calerdars, contacts, tasks, mail and memos,
[5] calendars For a complete guide to using Evolution, select Table of Contents in the Help menu, or press the F1 key.
‘ [ memos ‘ New Features

Evolution 2,10 brings you
‘ © Integration with gtk-print
© Customizable fetching of IMAP headers ~

5 = Task
Preview pane: View the content of ‘ B hiics
e-mail messages that are selected

in the e-mail messages list

Figure 3.30: Evolution

For more information on how to use the Evolution e-mail client, refer to: https://help.ubuntu.com/8.04/internet/C/email.html.

3.4.2 Using an Alternative E-Mail Client

In addition to Evolution, you can use many other e-mail clients, such as Mozilla Thunderbird, Balsa and Pine. If you have been
using the Mozilla Suite, you may prefer to use Thunderbird which is very similar. Try them both and see which you prefer.
Mozilla Thunderbird is an e-mail application developed by Mozilla Foundation. It is a free, cross-platform e-mail and news
application.

Nice to Know:

Mozilla Suite is a cohesive collection of integrated Internet applications, including a Web browser, e-mail and newsgroup client,
Internet Relay Chat (IRC) chat client, address book organizer and Web page creation utility.

The Thunderbird e-mail application is available in the Universe repository and can be installed on your computer from the
Synaptic Package Manager.

1. On the System menu, point to Administration and select Synaptic Package Manager. The Synaptic Package Manager
window will be displayed.
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{2 Applications  Places System & 0 )| Sat Dec 20, 4:48 PM
g Preferences ’

‘o4 Administration  »| %% Authorizations
o i}

[ Hardware Drivers
0 Help and Support

-{ 3
« 3 Hardware Testing
& About GNOME el

m Language Support
@ Login Window
% Network

! ‘-| MNetwork Tools

-13 About Ubuntu

[ auit...

& Ppartition Editor

HJ Printing

Services

J fe

@

Software Sources

@:ﬂ

Synaptic Package Manager

Systerm Log Install, remove and upgrade software packages

System Monitor

kel

& |

- Time and Date

GZﬂ’jr

7 Update Manager

Figure 3.31: Launching Synaptic Package Manager

2. In the Synaptic Package Manager dialogue box, you can select the package you need. The left pane lists the categories,
and the right pane lists the packages. You can search for the package by clicking Search and specifying its name. If you
do not know the name of the package, select the category in the left pane to filter the list of packages. You can then select
the check box next to the required package in the right pane.

Nice to Know:
If you want to view the installed and uninstalled packages, click Status. To know the source repository of the package,
click Origin. Click Custom Filters if you want to know whether a package is broken or can be upgraded.

3. Click Search. The Find dialogue box opens. Type the name of the package, Thunderbird, in the Search field and click
Search. The Mozilla Thunderbird package displays in the right pane of the Synaptic Package Manager window.
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& Synaptic Package Manager [=)l=][x]
File Edit Package Settings Help
Reload  Mark All Upgrades al Fropertie Search
All — |8 Package Installed Version | Latest Version Size Description -
Amateur Radio (univel I|:| 2veard 0.5-1ubuntu3 A little perl seript to convert an addre|
Base System L0  3270-commeon 3.3.4p6-33 Common files for IBM 3270 emulators
Base System irestrict|| ||[[]  3dchess 0.8 3D chess for X11

Base System (univers | | [J 4adigits A guess-the-number game, aka Bulls

Communicaticn 0 ags packet Capture and Interception for S

e Search: |Thunderb rd | ']
Communicaticn (mult | | I[]  6tunnel TCP proxy for non-IPvé applications

Look in: I Description and Name .]

Communicatien (univ 0  91Sresolution

resolution modification toal for Intel gf| |

I Dcancel | l [, search l I

Cross Platform D

Cross Platform {multiy

| lNo package is selecied.
Cross Platform (univer| | |

Development
Development [multive| ||
Development [restrict

Development {univers

-

Pim s s b

Sections
[ Origin

| Custom Filters | :

Search Results I |

(=] [ Synaptic Package Ma... | ﬁ_ @l

Figure 3.32: Searching Thunderbird

NOTE:

To return to the list of categories after searching the packages using Search, click Sections.

4. Select the Mark for Installation check box to install the package.
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File Edit Ppackage Settings Help
R |
Reload Marle All Upgrades Properties Secarch
Al S Package Installed Versicn | Latest \iersion Description =
Thunderbird " )
2 [1 lightning-extession-locale-pl 0.5-0ubuntuz Polish language package for lightning|[—|
[l mail-notification 4.1.dfsg.1-2ubuntu: mail notification in systern tray =
[0 mozilla-imagezoom 0.3-lubuntul Mozilla context menu option to zoom
[ mnzilla-thunda hird | 2.0 ‘_G.5+nnbi'nun_\y.-t- Transition package for mozilla-thunde
WIS e 0.7 .3-2ubuntu2 BiDirectional support for lcadove
&) Mark lor nstallation . o
[ e — 2.0.0.6+nobinonly-t Transition package for mozilla-thunde
; 2:0,95.0-0ubuntud Transitional package for enigmail =
I D]
| B mark for ce MO underbird rename %
= zilla-thundarbird
| Properties
1 Mare 5icaaErad reralfaton rice the thunderbird
package has been installed,
CIIEEE D)
Status
| Qrigin
Custom Flters
Search Results
161 packages listed, 1158 installed, 0 broken. 0 te installfupgrade, 0 to remove

Figure 3.33: Marking Thunderbird for Installation

5. The package that you choose to install may depend on other packages. In this case, you are notified about the dependencies.
To continue making the changes required to resolve the dependencies, click Mark.

6. To confirm that you want to make the marked changes, click Apply.

Apply the following changes?

This is your last opportunity to look through the list
of marked changes before they are applied,

P To be installed =
=

Summary Show Details
2 new packages will be installed
32.9 MB of extra space will be used
11.0 MB have to be downloaded

[] Download package files only

[ ogancel

[ & Apply l

Figure 3.34: Confirming Changes

7. The Summary dialogue box opens, prompting you for a final check before making the marked changes. Click Apply to
continue with the changes.
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This completes the procedure of installing Thunderbird by using Synaptic Package Manager. To access Thunderbird, on
the Applications menu, point to Internet and click Mozilla Thunderbird Mail/News.

This displays the Thunderbird window.

Q Applications Places System & 9
I & Accessories *
|Lﬂ Games r
‘fi Graphics ’
| @ Internet iJ @ Ekiga Softphone
. @ Office ’ Q Evolution Mail

_._’,-.' Programming » i Firefox Web Browser

B0 sound & video v [T] Liferea Feed Reader

|
' @ Mozilla Thunderbird MailfNews -
y iy

Read/Write MailfNews with Mozilla Thunderbird

‘ @. Add/Remove...

ﬁ Pidgin Internet Messenger
@ Remote Desktop Viewer
(_g Terminal Server Client

@ Transmission BitTorrent Client

Figure 3.35: Launching Mozilla Thunderbird Mail/News
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& ., & &1 | & h =. @
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All Folders T I.* | Q] Subject ‘6&\' Sender | [0 l Date '.[.Eﬁ]!
# 4 Local Folders
=57 Gmail - wwindsorll
= Inbox
“ 1 Trash
Welcome to Thunderbird!#£
Mozilla’'s Thunderbird email 5
application is more powerful than
ever. it’s now even easier to
organize, secure and customize your
mail. =
5= e Experience the difference, Thunderbird is
— |D—| developed and supported by Mozilla, a
Mail Calendar : ; =
global community warking together to E
| '.','I Unread: 0 | Total: 0 |

Figure 3.36: Thunderbird Window

Features of Thunderbird Thunderbird features many enhancements to help you better manage your inbox,

organise your correspondence.

Some of its key features are:

send emails and

 Stop Junk Mail If you are tired of spam and annoying advertising in your Inbox, Mozilla Thunderbird provides effective tools
for detecting junk mail. These tools analyse your e-mail message and identify those that are most likely to be junk. Your junk
mail can be automatically deleted or placed in a specific folder.
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Figure 3.37: Stopping Junk Mail

1. On the Tools menu, click Junk Mail Controls. The Junk Mail Controls window will be displayed.
2. Click the Adaptive Filter tab. Select the Enable adaptive junk mail detection check box and click OK

* Customise your mail You have three column views to access you e-mail messages: Classic, Wide and Vertical view.
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%
Get Mail
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View Go Message Tools Help

Toclbars b ) = | &
- I, - R _._I'\].
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Headers »

Message Body As
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Figure 3.38: Customising the E-mail View

¢ Built-in Spell Checker To check for correct spelling, click Spell on the toolbar.




Ubuntu Desktop Training
76 /348

Fle Edit WView Insert Format Options Tools Help
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IT To: | L= charleswindsor@hotmail.com
Subject: [H\!
(Body Text | 2 [Variable width Jh s &8 1 u|EEEE
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| e =

Figure 3.39: Spell Checker
 Security Thunderbird provides enhanced security features, which is equivalent to enterprise and government-grade security. It
offers built-in support for Secure/Multipurpose Internet Mail Extensions (S/MIME) secure e-mail message.

» Extensions Extensions are powerful tools to help you build a mail client that meets your specific needs. Mozilla Thunderbird
has several features, such as quick search, a smart address book, advanced message filtering and more.

* News Reader Mozilla Thunderbird makes it easier to subscribe to your favourite newsgroups, downloading headers and
messages and offline support.

(S AccountWizard (=l |43

New Account Setup

In order to receive messages, you first need to set up a Mail or
MNewsgroup account,

This Wizard will collect the information necessary to set up a Mail or
Newsgroup account. If you do not know the information requested,
please contact your System Administrator or Internet Service
Provider,

Select the type of account you would like to set up:

() Email account

) Unix Mailspoal (Mavemail)
() RSS News & Blogs

) Gmail

@ Newsgroup account

Cancel l [ MNext

Figure 3.40: Thunderbird as a Newsgroup
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* Themes As with most elements on Ubuntu, you can personalise the themes to change the look and feel of Mozilla Thunderbird.
A theme can change the toolbar icons or the complete appearance of an application.

* Cross-Platform Support Thunderbird is used on various platforms, such as Ubuntu, Microsoft Windows, Mac OS X and
Unix-based operating systems.

3.5 Instant Messaging

E-mail message is not expected to be real-time, which means you can respond to it when time allows. But when 'Immediacy’ is
required, instant messaging (IM) is the way to go. Using IM over the Internet can bring down costs of long distance phone calls
when you want to stay in contact with friends. While in office, if you want an answer to a simple question, IM facilitates quick
and easy communication and reduces the amount of e-mail messages sent and received in a day. IM also enables you to view a
person using Web-cams or talk over the Internet for free.

The default instant messenger client on Ubuntu is Pidgin, a cross-platform instant messenger that supports various popular
IM network protocols. Using Pidgin, you can communicate with people who use America Online (AOL) Instant Messenger
(AIM/ICQ), Gadu-Gadu, GroupWise, IRC, Jabber, MSN, Napster and Yahoo. It allows you to list all your friends in one window.
Pidgin users can log on to multiple accounts on multiple IM networks simultaneously. This means that you can chat with friends
on AIM, talk to a friend on Yahoo Messenger, and sit in an IRC channel, all at the same time. Pidgin supports many features
of the various networks, such as file transfer, away messages, typing notification, and MSN window closing notification. A few
popular features are Buddy Pounces, which give the ability to notify you, send a message, play a sound or run a programme when
a specific buddy goes away, signs online or returns from idle.

1. On the Applications menu, point to Internet and click Pidgin Internet Messenger. The Accounts dialogue box with a
welcome message will be displayed.

-QAppI\cations Flaces Systeme 9

‘ib Accessories 3

,iﬁ\ Games v
"__5 Graphics b
\i._', Internet J @ Ekiga Seftphone
| Lw Office 3 Q Evolution Mail

_'-’ Programming 3 Q Firefox Web Browser
m Sound & Video  » D Liferea Feed Reader

E) AddfRe B Mozilla Thunderbird MailNews
" move, ..

ﬁ Pidgin Internet Messenger

@ Remote Desktop Viewer Send instant messages over multiple protocols

f‘% Terminal Server Client

Transmission BitTorrent Client

Figure 3.41: Launching Pidgin Internet Messenger

2. Click Add to configure your any existing e-mail account on Pidgin. The Add Account dialogue box will be displayed.
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Welcome to Pidgin!

You have no IM accounts configured. To start connecting with
Pidgin press the Add button below and configure your first
account. If you want Pidgin to connect to multiple IM
accounts, press Add again to configure them all.

You can come back to this window to add, edit, or remove
accounts from Accounts=Add/Edit in the Buddy List window

I =k Add I| |__ H Eglose

Figure 3.42: Adding a New IM Account

3. In the Add Account dialogue box, select the protocol, which is your e-mail account server name from the Protocol box.
The protocol is the name of the server you want to use for chat. Type your selected protocol’s e-mail ID in the Screen
name box and the corresponding password. Type your nick name that you would like to be known by while chatting in the
Local alias box. Click Save to create the account. The Accounts window will be displayed.

Basic | Advanced |

Login Options

Protocol; [ [ IRC = ]
Screen name: |wwindsor |
Server: lirc.ubuntu.com ]
password; [ |
Localalias: | |

[1 Remember password

logancel I gave

Figure 3.43: Providing Basic Account Information

4. You can see the newly created account with a check mark indicating that it is active in the Accounts window. Click Close.
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Enabled Screen Mame Protocol

4] wwindsor@irc.ubuntu.com @ IRC

‘ =k Add | | & Modify: | | il Delete

l Eglose

Figure 3.44: Viewing Added Accounts

NOTE:

If you want to add another e-mail account, click Add in the Accounts window and perform steps 1-4.

5. Now, click the Pidgin icon on the top panel of the desktop to view the Buddy List window for your current account.
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Buddies Accounts Tools Help

() Available - A

Figure 3.45: Viewing Buddy List

6. To start using Pidgin, on the Buddies menu, click New Instant Message. The New Instant Message window will be
displayed.
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Figure 3.46: New Instant Message

7. To interact with other users, type the screen name or alias of the person you would like to chat with in the Name box and
click OK. An IM window will be displayed.

New Instant Message

Please enter the screen name or alias of
the person you would like to (M,

Mame: |char|e52

J
(@] [z

Figure 3.47: Specifying Buddy Name

8. You can use the box at the bottom of the window to type your messages and press Enter to send them. This is how you can
start your conversation.
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@lFont | 2k nsert | () smile!

Figure 3.48: IM Window

Nice to Know:

You can change the appearance of Pidgin by adding additional features, such as changing its graphical interface and
theme to it. The packages required to do this are Pidgin-guifications, Pidgin-libnotify and Pidgin-themes. You can install
these packages from Synaptic Package Manager by following the procedure listed in the Using Alternative E-Mail Client
section.

3.6 Making Phone Calls Using Softphones

A softphone is a software programme that is used to make telephone calls over the Internet using a computer instead of using
a regular phone. Your service provider may offer computer-to-computer calls for free, but PC-to-phone and phone-to-PC calls
usually are charged. You need to have the same communication protocol and use a common audio codec to communicate with
another person. The audio codec defines how voice is translated into digital signals. Examples of SIP softphones are Ekiga, SIP
Express Router and many more.

You use a softphone with a headset connected to the computer or with a USB phone. The features of softphone include all standard
telephony features, such as mute, flash, hold and transfer. It also includes new features, such as presence, video, wideband audio
and many more. The softphone requirements to make voice calls over the Internet are a computer with a microphone and speaker,
a headset or USB phone, Internet connectivity and an account with an Internet telephony service provider.

Nice to Know:
Skype, Google Talk and Vonage are Internet telephony service providers whose software you would need to install on your
computer. But these three providers are not interoperable, and you cannot place a direct call between them.

The configuration of Ekiga is described below.

3.6.1 Using Ekiga

Note:

Ekiga is an open source softphone application for Ubuntu. It is a free Voice over IP (VoIP) and video conferencing application.
VoIP routes voice conversations over the Internet or through any other IP-based network. You can use Ekiga to call, send instant
messages and be contacted by other Ekiga users.
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The First Time Configuration Assistant helps you configure Ekiga. It appears automatically when you open Ekiga for the first
time.

1. On the Applications menu, point to Internet and click Ekiga. The Configuration Assistant page will be displayed. Click
Forward.

QAppIications Places System

gx Accessories 3
\iﬂ Games r
.‘fi Graphics »
| @ Internet J @ Ekiga Softphone
@ Office 3 Q Evolution Mail

_:;’ Programming » & Firefox Web Browser

m Sound & Video v D Liferea Feed Reader

Talk to people over the Internet

| @ A @ Mozilla Thunderbird MailNews
%) move...

ﬁ Pidgin Internet Messenger

@ Remote Desktop Viewer
(__g Terminal Server Client

i Transmission BitTorrent Client

Figure 3.49: Launching Ekiga Softphone

2. On the Personal Information page, type your full name in the Please enter your first name and your surname box. The
name that you specify is used for display purposes when you connect to other audio or video applications. Click Forward.

Please enter your first name and your surname:

lwilliam Windsor l

Your first name and surname will be used when connecting
to other VoIP and videoconferencing software.

l ogancel l I & Back l | =) Forward

Figure 3.50: Specifying Display Name

3. On the ekiga.net Account page, type your Ekiga’s account user name and password that you use to log in to your existing
Ekiga account. You will get this detail from the ekiga.net free SIP service. Click Forward.
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Please enter your username:

[wwindsor I

Please enter your password:

[ecessces |

The username and password are used to login to your existing
account at the ekiga.net free SIP service. If you do not have
an ekiga.net SIP address yet, you may first create an account
below. This will provide a SIP address that allows people to call
you.

You may skip this step if you use an alternative SIP service, or
if you would prefer to specify the login details later.

Get an ek\ga.net SIP account

[ | do not want to sign up for the ekiga.net free service

[ cancel ‘ [ ¢ Back ‘ [ﬁﬁomard]

Figure 3.51: Specifying ekiga.net Account Username and Password

NOTE:

If you do not have an SIP account, you can click the link Get an ekiga.net SIP account on the page to create an SIP
account on ekiga.net.

4. On the Connection Type page, select the type of Internet connection you are using on your computer from the Please
choose your connection type box. This connection type determines the best quality settings that Ekiga will use during
calls. If you do not know the connection type, contact your system administrator. Click Forward. You can change these
settings later.

Connection Typ ge 4/1

Please choose your connection type:

ar

[ TI/LAN

The connection type determines the best quality settings
that Ekiga will use during calls. You can later change the
settings individually in the preferences window.

l ogancel

[ @eeck | [peowerd]

Figure 3.52: Selecting Connection Type

5. On the NAT Type page, click Detect NAT Type. It informs you which Network Address Translation (NAT) type was
detected and automatically configures Ekiga to transparently cross your router. So, NAT avoids all the problems associated
with reserving IP addresses. Click Forward.
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NOTE:

To learn more about NAT, refer to: http://en.wikipedia.org/wiki/Network_address_translation.

Q| EiTstime GConhguration AssIstant: '[’;j:[ﬁ_‘lf@_"

NAT Type - page 5/10

Click here to detect your NAT Type:

i Detect NAT Type |

The NAT type detection will help you te
configure your NAT router to be able to call with
Ekiga.

l Dcancel l [ &3 Back l [ﬂEomardl

Figure 3.53: Selecting NAT Type

6. On the Audio Manager page, select the audio manager, which is the plug-in, according to the sound card of your computer.
The audio manager is a plug-in that manages your audio device and is dependant on the operating system on your computer.
Though it is recommended to use ALSA, you should check with your your system administrator to identify the appropriate
audio manager for the audio device that you want to use. Then, click Forward.

Q. Fir

Audio Manager - page 6/10

Please choose your audio manager:

[ ALSA

ar

The audio manager is the plugin that will manage your
audic devices, ALSA is probably the best choice It it's
available.

l ogancel

[ ‘:iEBCk l EﬂEomardﬂ

Figure 3.54: Selecting Audio Manager

7. Ekiga requires audio output and input devices to play and record sound files. The audio output device is used to play audio
and audio input device to record your voice. So, on the Audio Devices page, select the audio output and input devices. For
example, headset or speakers are the output device and your microphone the audio input device. Now, click Test Settings
to check the functionality of audio devices and the click Forward.
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Audio Devices - page 7/10

Please choose the audio output device;

[HDA Intel

ar

The audio output device is the device managed by
the audic manager that will be used to play audio.

Please choose the audio input device:

[Default - ]

The audio input device is the device managed by
the audioc manager that will be used to recerd your
voice.

Test Settings

[ ogancel l [ &3 Back l i ﬂEomardﬂ

Figure 3.55: Selecting Audio Devices

8. On the Video Manager page, select the video manager, which is the plug-in used to manage your video devices. You can
select Video4Linux to manage Webcams or AVC / DC for Firewire cameras. Click Forward.

Video Manager - page 8/10

Please choose your video manager;

[\ML

ar

The videa manager is the plugin that will
manage your videe devices, VideedLinux is the
most common choice if you own a webcam.

[ ogancel

[ @EBCk l EﬂEﬂmardﬂ

Figure 3.56: Selecting Video Manager

9. On the Video Devices page, select the video input device from the Please choose the video input device box. The video
input device is the device managed by the video manager that will be used to capture video. If you do not want to do video
conferencing or if you do not have a video device, you may skip this page.

Click Test Settings to ensure that your video device works with Ekiga. Click Forward.
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TSt TimE CONHgUTAIonA:

Video Devices - page 9/10

Please choose the video input device:

ar

[N device found

The video input device is the device managed by
the videe manager that will be used to capture
video.

[ ogancel J [ @ Back J i ﬂEorwardi

Figure 3.57: Selecting Video Devices

10. The configuration of Ekiga is now complete. This window displays a configuration summary of the settings you have
selected. You can verify your settings here. If you want to make any modification, navigate to the required page by using
Back and Next and make appropriate changes. Click Apply to save the configuration.

vou have now finished the Ekiga configuration. all of the
settings can be changed in the Ekiga preferences. Enjoy!

Configuration summary:

Username: charles windsor
Connection type: TLjLAN

Audio manager: ALSA

Audio player: HDA Intel

Audio recorder: Default

Video manager: V4L

Video input: No device found
SIP URL: sipicharlesw@ekiga.net

[ anncel [ @Apply-]

[ ¢ Back

Figure 3.58: Account Configuration Summary

The Configuration Assistant will close. NOTE:

After installing Ekiga, if you want to modify any configuration, you can run the configuration assistant again by Prefer-
ences on the Edit menu in the Ekiga window.

Nice to Know:
For more information on Ekiga, refer to http://www.ekiga.org.
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The Ekiga window will be displayed. It is the default softphone application available on Ubuntu.

L)

call Edit wiew Tools Help

sip: ‘ - |‘%|

Standby

Registered accounts: 0

BeEm
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[ Tonnre ||| 4Bt l QWM]
= Je Je

—.‘ Dialpad | Audio _|Video 3

Registration failed: Forbidden

Figure 3.59: Ekiga Window

MAKING CALLS USING EKIGA

From Computer to Computer Using Ekiga, you can call anyone who is registered to the public SIP provider and uses SIP
software or hardware. You can use the online address book of Ekiga to find the SIP addresses of other Ekiga users. It is of
course possible to call non-Ekiga users, registered to any public SIP provider. To make calls, type the URL address of the
user you wish to call in the sip: : input box and click the connect icon on the right of the text box. With the default setup,
you can simply type sip:foo to call user foo@ekiga.net.

From Computer to Regular Phones You can use Ekiga with multiple ISPs. There is a charge for this service so you will need
to create an account with the provider first. After the account is created, you will receive a login and a password by e-mail.
Simply enter them in the Ekiga dialogue box, select Use PC-To-Phone service and you are ready to call regular phones
using Ekiga. With the default setup, you can simply use sip:00911129535955 to call the real phone number 003210444555,
00 is the international dialling code, 91 is the country code and 1129535955 is the number to call.

From Real Phones to Computer You can also use Ekiga to receive incoming calls from regular phones. For this, you have
to login to PC-To-Phone account and purchase a phone number. Ekiga then rings, when people call you at that phone
number.

To learn more about making phone calls by using Ekiga, refer to http://www.ekiga.org/index.php?rub=3.

3.6.2 Skype

Skype is another softphone that can be used on Ubuntu to make calls over the Internet. The source code of Skype is proprietary,
but the software is free to use. Your calls go through distributed servers and not through a central server. To accomplish this,
Skype uses a decentralized peer-to-peer technologies and its own proprietary communication protocol. Skype uses encrypted
communication, which means all communications are encrypted from end-to-end so that others cannot listen in. We will not go
into detail over Skype communication here.

3.7 Lesson Summary

In this lesson, you learned that:
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* You can connect a computer to the Internet using cable, wireless and dial-up connections.

* Mozilla Firefox is an open source, powerful and secure Web browser. It is available for free and is the default browser on
Ubuntu.

* Firefox includes two powerful features that make your online experience better and more productive -integrated search system
and bookmarking.

* Liferea is an RSS feed reader, which offers useful features to manage your newsgroup subscription.
* Evolution is the default e-mail client for Ubuntu.

* Mozilla Thunderbird is the e-mail application developed by Mozilla Foundation. It is a free, cross-platform e-mail and news
client.

* The default instant messenger client on Ubuntu is Pidgin. It is a cross-platform instant messenger that supports multiple popular
IM network protocols.

* Ekiga is the default open source softphone application for Ubuntu.

3.8 Review Exercise

Question: What are the three main ways to connect to the Internet?
Answer:

Question: Which tool is used to identify a modem on Ubuntu?
Answer:

Question: Why do you require a bookmark in Firefox?

Answer:

Question: What is a feed?

Answer:

Question: Match the following:

1) Evolution a) Web browser

2) Firefox b) Mail client

3) Ekiga ¢) Instant messenger

4) Pidgin d) Phone calls
Answer:

Question: You can get an SIP address from

Answer:

Question: The source code of Skype software is , but the software is to use.

Answer:

Question: Which of the following is an RSS feed reader?
A. Ekiga

B. Liferea

C. Pan

D. Skype

Answer:
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Question: Which of the following is proprietary software?
A. Skype

B. Ekiga

C. Liferea

D. Firefox

Answer:

3.9 Lab Exercise

Exercise 1 You use Liferea as a newsreader on your computer. Recently, you met a friend who informed you about a Web site
that offers RSS feeds, http://www.lifehacker.com. Now, you want to configure Liferea for the latest updates from this Web site.
1. Open the following Web site http://www.lifehacker.com. This site offers RSS feeds.

2. In the left pane, under syndication, click Full content (with ads). Save the URL in the Address bar of Mozilla Firefox.
This URL, http://feeds.gawker.com/lifehacker/full, is the feed.

3. Open Liferea.
4. Right-click in the left pane, point to New and click New Subscription. The New Subscription dialogue box is displayed.

5. In the New Subscription dialogue box, type the saved URL http://feeds.gawker.com/lifehacker/full and click OK.
Exercise 2 You want to chat with your friend, who uses Google talk (gtalk). Configure Pidgin to chat using gtalk.

1. On the Applications menu, point to Internet and click Pidgin Internet Messenger.
2. On the Accounts menu, click Add/Edit. The Accounts window is displayed.
3. In the Accounts window, click Add. The Add Account window is displayed.

4. In the Add Account window, select xmpp from the Protocol box, type your gtalk e-mail id in the Screen name box, your
account password in the Password box and your nickname in the Local alias box. Click Save.

5. You are now connected to the gtalk server.
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Chapter 4

Using OpenOffice Applications

OBIJECTIVES

* Perform basic word-processing functions using OpenOffice.org Writer.
 Perform basic spreadsheet functions using OpenOffice.org Calc.

* Create and view multimedia presentations using OpenOffice.org Impress.
* Perform basic drawing operations using OpenOffice.org Draw.

* Create and edit formulae using OpenOffice.org Math.

4.1 Introducing the OpenOffice.org Suite

OpenOffice.org is the default office application suite provided with Ubuntu. This is a free, open source office software suite that
comprises all the features normally expected in an office suite. It is not just a collection of separate software programmes; it has
been designed as a complete office package, in which all applications have a similar look and feel and common tools.

The OpenOffice.org suite is available in more than 30 languages and can run on many operating systems, including Linux,
Microsoft Windows, Solaris and Mac OS X. It is also compatible with all other major office suites, including Microsoft Office,
which makes it easy for you to create, open, save and exchange documents with friends and colleagues in Microsoft Office
formats.

Another key feature of the OpenOffice.org suite is that all the applications save in the OpenDocument format, which is the new
international standard for office documents. This Extensible Markup Language (XML) based format enables you to access your
data from any OpenDocument-compliant software.

Nice to Know:
For more information on the history and development of OpenOffice.org, please visit http://en.wikipedia.org/wiki/Openoffice.org.

The OpenOffice.org software suite includes the following applications to help you handle your work effectively:

* OpenOffice.org Writer
* OpenOffice.org Calc

* OpenOffice.org Impress
* OpenOffice.org Base



http://en.wikipedia.org/wiki/Openoffice.org

Ubuntu Desktop Training
92/348

* OpenOffice.org Draw
* OpenOffice.org Math

To ACCESS THE OPENOFFICE.ORG SUITE:

* On the Applications menu, point to Office and then click the OpenOffice.org application you want.

ﬁ Applications Places System e @ 9

’Zc,b Accessories C

;i&i Games g
‘J__i Graphics *
r{., Internet k
| @ Office v Q Evolution Mail and Calendar
__f-’ Programming 3 P_EJ OpenOffice.org Presentation
m Sound & Video  » m Openoffice.org Spreadshest

M OpenOffice.org Word Processor

@. Add/Rermowve. ..

Figure 4.1: Accessing OpenOffice.org

4.1.1 OpenOffice.org Writer
Writer is the word processor of the OpenOffice.org suite. It provides powerful functions and tools to do anything from writing a

small letter to creating an entire book that contains charts, graphics, images, tables and an index. Complex desktop publishing
tasks, such as creating multicolumn newsletters and brochures are also on hand.

4.1.2 OpenOffice.org Calc
Calc is a powerful spreadsheet that contains all the tools necessary to calculate, analyse, summarise and present data in the form

of reports or charts. It has a wide range of advanced functions such as entering complex formulae, pulling in external data and
performing statistical analyses.

4.1.3 OpenOffice.org Impress

Impress is a presentation programme designed to create effective multimedia presentations. It provides a range of tools to create
presentations with 2D and 3D graphics, clip art, graphics, special effects and animations.
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4.1.4 OpenOffice.org Base

Base is a database programme used to store contact and account information, create and modify tables, forms, queries and reports.
Accessing data stored in a wide variety of database file formats is also available. Base will not be covered in detail in this course.
For more information on base, please refer to www.openoffice.org/product/base.html

4.1.5 OpenOffice.org Draw

Draw is a vector graphics editor that provides tools to create anything from simple graphics to dynamic 3D illustrations and
special effects.

4.1.6 OpenOffice.org Math

Note:

You can use Math for creating and editing mathematical equations by using a graphic user interface or by directly typing the
formula into the equation editor. The formula created in this manner can then be inserted into other OpenOffice.org programmes,
such as Writer, Calc and Impress.

Using a new OS and especially a new office application suite is not as daunting to pick up as you may think. With OpenOffice,
most of the operations are very intuitive. Think of a new suite as moving to a new house; all your old cutlery, plates and dishes
are in your kitchen cupboards, you just need to get used to the new kitchen arrangement!

4.2 Using OpenOffice.org Writer

4.2.1 Key Features of OpenOffice.org Writer

You may already be familiar with many of the features of this application so only a few of them are included here.

Writing OpenOffice.org Writer offers a variety of useful features to help you create basic text documents as well as long and
complex or multi-part documents that may include components such as bibliographies, reference tables and indexes. Some of
these features are:

* Spellchecker: The spellchecker feature facilitates error-free writing by enabling you to check your entire document, including
the header, footer, index entries and footnotes, for spelling errors. It even allows you to identify a misspelled word from a
specific selection of the document, lists suggested words for replacing the misspelled word and provides you the option to add
a new word to the existing user dictionary.

* Thesaurus: The thesaurus helps you enhance the quality of your writing and make it more effective by allowing you to find a
more appropriate synonym for a selected word.

* Autocorrect: Autocorrect is a software function that enables you to reduce your typing effort by automatically correcting
common spelling and typing errors. This feature also allows you to automatically apply correct formatting to the text or insert
special characters by recognizing particular character usage.

* Hyphenation: You can use the hyphenation feature to insert hyphens in words that are too long to fit at the end of a line. It
searches the entire document and suggests hyphenation that you can either accept or reject.

* Mail merge: The Mail merge feature allows you to create multiple personalised form letters, labels, envelopes, faxes and
e-mail messages by using a form letter template and an address database.

Designing and Structuring OpenOffice.org enables you to design and structure your text document by using an assortment of
features, including:

* Style and Formatting window: The Style and Formatting window is one of the common features available in the OpenOffice.
org package that can be used consistently in all the applications included in the package. You can use this window to create,
assign and modify styles for paragraphs, lists, individual characters, frames and pages.
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» Navigator: Provides you with an outline view of the entire document and allows you to quickly navigate inside the document.
You can also use Navigator to track the objects and elements that are already inserted and to insert new elements into the
document.

* Indexes and Tables: Enable you to insert an index, a table of contents or a bibliography reference in your text document. You
can also customise the inserted tables and indexes by defining their structure and appearance.

Desktop Publishing The following features can help you create professionally styled documents, such as brochures, invitations
and newsletters:

» Text Frames: Acts as a container for text and graphics and can be placed anywhere in a document. You can also use these
frames to apply a multi-column layout to your document and render a professional look and style to it.

* Graphics: Allows you to insert a graphic object into your text document from a gallery, a file or any other OpenOffice.org
application.

* Tables: OpenOffice.org Writer also enables you to create or insert a table into a text document.

Drawing The drawing functions make it easy for you to create many types of drawings and graphics directly in your text
document. You can use the Drawing bar to add various shapes, lines, text and callouts to a current document.

Drag and Drop This unique feature allows you to drag objects from one location to another in the same document, from one
OpenOffice document to another and from the Gallery to your OpenOffice document.

The Help Function This is a complete reference for your Writer.

4.2.2 Performing Basic Word-Processing Tasks

You can perform a number of word-processing tasks, such as writing, editing, formatting, reviewing and printing documents,
using OpenOffice.org Writer. The word processor also allows you to use various templates, apply different styles to your docu-
ment, control your page layout and insert, edit and create graphics inside your text document. Instructions to perform some of
the basic word-processing tasks in Writer are described in the following sections.

Entering and Formatting Text OpenOffice.org Writer is primarily used for writing and formatting text. You can enter text using
your keyboard and then apply a variety of formats to the text, as per the document’s requirements.

1. On the Applications menu, point to Office and then click Openoffice.org Word Processor. A blank text document opens.
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Figure 4.2: Launching Writer

2. Depending on what you want to do, you can either create a letter, memo, note or an entire novel from scratch, or you may
start with a predefined template or sample that is suitable for your requirements.

To access the templates and samples, on the File menu, point to New and then click Templates and Documents. Alterna-
tively, you can press SHIFT+CTRL+N. The Templates and Documents dialogue box opens.
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Figure 4.3: Accessing Templates and Documents

3. You can view the various categories of available templates in the middle column of the Templates and Documents dialogue
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box. If you want to use a template to create your document, you can double-click a category. This will display the various
templates associated with that category. Select a template of your choice and then start working on it.

However, you may also decide to work with the default blank document. To continue working with the blank document,
exit the Templates and Documents dialogue box by clicking Close in the top-right corner of the dialogue box.

T My Templates
U Presentation Backgrounds
New [ Presentations

Decument

My
Documents

=)

[—
Samples

organise... Ope i Cancel I I Help

Figure 4.4: Accessing Templates

4. After you have created the document, you can use the various formatting features provided in Writer to change the text
display or emphasise specific areas in your document. You can use the following options available on the Formatting
toolbar to perform some of the most common formatting tasks.
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Figure 4.5: The Formatting Toolbar

5. You can use the Style and Formatting window to perform a complete document makeover.
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To open the Style and Formatting window, on the Format menu, click Style and Formatting. The Style and Formatting
window appears.
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Figure 4.6: Accessing Style and Formatting Window

6. You can use this window to select and modify the existing style or create a new style. Clicking one of the icons below
the title bar of the Style and Formatting window will display a list of styles in a particular category, such as a list or a
paragraph.
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Figure 4.7: The Style and Formatting Icons

7. By default, when you open the Style and Formatting window, the Paragraph Style icon is selected. All the styles listed
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in this category are displayed in the Style and Formatting window. You can start restyling individual parts of the current
document by selecting specific parts of the document and applying an existing style by double-clicking that style.
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Figure 4.8: Applying a Style

8. However, if you want to modify an existing style, you can simply right-click that style and select Modify. This displays a
new pop-up window. You can redefine almost all aspects of the selected style using the various options available under the
different tabs.

Modify the specifications of the selected style, and click OK to apply the changes.
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Figure 4.9: Modifying a Style

9. Double-click the modified style to reflect the changes in the selected text.
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Figure 4.10: Applying the Modified Style

10. You can customize all other parts of the document in the same way.

To insert a table in a text document, position the cursor where you want the table to appear and then follow the procedure
described below:

1. On the Table menu, point to Insert and then click Table. The Insert Table dialogue box opens.
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Figure 4.11: Inserting a Table

2. You can use the various options present in the dialogue box to specify some of the table properties.
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Figure 4.12: Specifying Table Properties

Nice to Know:
To directly insert a table with the default properties, click the Table icon on the Standard toolbar and select the table size
in the graphic that appears. To create the table, click the cell that you want to be on the last row of the last column.

3. Specify the table properties and click OK. The table is inserted at the specified location in your text document. By default,
Writer creates a table as wide as the page margins, with all the rows having the same height and all the columns having the
same width. To adjust the column and rows and customise the table further, right-click the table and select Table from the
short-cut menu. The Table Format dialogue box opens.

Now you can use this dialogue box to define finer specifications for the table such as alignment, column width, text flow,
borders and background.

Define the table specifications as per your requirements and preferences, and click OK to apply the changes.
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Figure 4.13: Customising the Table Format

4. The defined specifications are applied to the table. To arrange the data within one of the table cells into another table, you
can create nested tables. Writer permits you to create as many layers of nested tables as you want.
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To create a nested table, click the cell in which you want the nested table to appear, then follow the procedure for inserting
a new table. A nested table appears in the specified cell within the larger table.
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Figure 4.14: Creating a Nested Table

5. You can now define the finer specifications of the nested table using the Table Format dialogue box and then populate the
table with data.

Ubuntu Desktop Course

Session Plan for Day 1

Figure 4.15: The Nested Table

Inserting Images OpenOffice.org allows you to import images of various file formats, including the most common file types
such as JPEG, PNG, BMP and GIF. Images can be inserted from a file, the OpenOffice.org Gallery, a scanner, the Internet, or a
graphics programme.

1. Position the cursor at the location in the document where you want the picture to be inserted. On the Insert menu, point to
Picture and then click From File. The Insert Picture dialogue box opens.
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2. To insert the file, navigate to the desired file and select it. You can select the Preview check box at the bottom of the Insert

Picture dialogue box to preview the selected image in a pane and verify whether you have selected the correct image.
Click Open to insert the image in your document.
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Figure 4.16: Inserting Image

3. The image is inserted at the specified location in your document. If the image does not fit perfectly into your document,
you should resize it.

To resize the image while maintaining its proportions, select the image and then press and hold the SHIFT key. When you

select an image, some square points (known as "handles") appear along its perimeter. While holding down the SHIFT key,
click and drag one of the handles on the image to modify its size.
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Figure 4.17: Resizing the Inserted Image

4. After you have resized the image, you need to position the image appropriately in the document. You can arrange and align
images using the tools on the Frame toolbar, which appears below the Standard toolbar when you select a graphic for

the first time.

Alternatively, you can right-click the image and then select from the available options, such as Arrange, Wrap or Anchor,

on the short-cut menu.
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Figure 4.18: Positioning the Inserted Image

5. After you have selected appropriate positioning options for the image, you may obtain a result similar to the following

screenshot.
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Figure 4.19: The Inserted Image

1. On the File menu, click Print. The Print dialogue box opens. You can use this dialogue box to specify the printer to be
used (in case you have more than one printer installed on your system), the pages to be printed, and the number of copies
to be printed. You can also click the Properties button in the Print dialogue box to define the properties of the printer,
such as orientation, the paper tray to be used and the paper size to be printed.

To define printer options for the current document, click the Options button in the Print dialogue box.
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Figure 4.20: Printing a Document

2. The Printer Options dialogue box enables you to select specific sections from the current document for printing. For
example, to save toner or ink, you may not want to print the background and the graphics in the document. You can specify
these details under the Content section by selecting or clearing the appropriate check boxes.
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Similarly, you can define the required printing options in the Pages and Notes section. After specifying the details, click
OK to save your settings.
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Figure 4.21: Defining Printer Options

3. You can now start printing the document by clicking OK on the Print dialogue box. NOTE:

Making changes in the Printer Options dialogue box will only apply to the current document and not change your default
settings permanently.

You can save your Writer document in the same way as you save any other document. To save a new text document:

1. On the File menu, click Save As. The Save dialogue box opens.
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Figure 4.22: Saving the Document

2. Navigate to the directory where you want to save the file, enter the file name and click Save to save the file at the desired
location.

OpenOffice.org also allows you to save your document in a number of other file formats, including Microsoft Word, Rich
Text, Star Writer and as an HTML document. This enables you to share your documents with other people who use other
office applications, such as Office.
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If you would like to save your current document as a Word file, select the appropriate type of Word format from the
drop-down menu at the bottom of the dialogue box. Then, click Save to save the file as a Word document.

[ Susz

Name; |C|asswc Apple Pie ‘

= Browse for other folders

‘IH"—dcharleswindsud Create Folder

Places Narr
&, search =

(%) Racently Usad =

T

L&l charleswindsor |=

OpenDocument Text (.odt)

P File type OpenDocument Text Template (.ott)
Openoffice.org 1.0 Text Document (.sxw)

[] Save with password
Openoffice.org 1.0 Text Docurment Template (.stw)

Microsoft Word 87/2000/%P {.doc) I

Microsoft Word 95 (.doc)

Figure 4.23: Saving in Word Format

4.3 Using OpenOffice.org Calc

Calc is the spreadsheet component of the OpenOffice.org office software suite. The comprehensive range of advanced functions
included in Calc helps professionals accomplish complex tasks. At the same time, Calc is user-friendly, which makes it easier for
new users. This topic will familiarise you with its key features and teach you how to perform some basic spreadsheet functions.

Similar to all other applications in the OpenOffice.org suite, Calc allows you to save spreadsheets in OASIS OpenDocument
(ODF) format. This XML-based format enables you to access your spreadsheets from any OpenDocument-compliant software.
In addition, Calc allows you to save spreadsheets directly as Portable Document Format (PDF) files without using any additional
software.

4.3.1 Key Features of OpenOffice.org Calc

Calc is a fully featured office application that includes all the advanced analysis, charting and decision-making features that you
expect from a high-end spreadsheet. Some of the key features of OpenOffice.org Calc are:

 Calculation: OpenOffice.org Calc provides you with over 300 functions for financial, logical, statistical, mathematical and
banking operations. This enables you to create formulae to perform complex calculations on your data. In addition, Calc
provides you with Function wizard that guides you interactively through the creation of formulae.

Another feature of OpenOffice.org Calc is that it allows you to create natural language formulae using words such as sales -
Costs.

* Scenario Manager: Allows you to perform ’what-if’ analyses and view the result of changes made to any factor of the
calculation. For example, when performing a loan calculation, you can change the period of the loan and can view the resulting
calculations for the loan-repayment amount or the interest rate.

* Data Pilot: Enables you to compare, combine and arrange large amounts of data. It helps you pull in raw data from corporate
databases, cross-tabulate, summarise and convert the data into meaningful information. You can use Data Pilot to create
interactive tables, which allows the data to be frequently arranged, rearranged or summarised according to different points of
view.

* Dynamic Charts: As the name suggests, these charts update automatically as the data in the spreadsheet changes.

* Opening and Saving Microsoft Files: Calc allows you to use your old Microsoft spreadsheets and save your work in Microsoft
Excel or a variety of other formats. This facilitates the easy sharing of data with others using Microsoft or similar applications.
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4.3.2 Performing Basic Spreadsheet Tasks

Similar to any other spreadsheet application, Calc is used to process numerical information or text in tabular form. It is primarily
used for tabulating numerical figures. It also allows you to sort and manipulate data, apply arithmetic, mathematic and statistical
functions to data sets and represent the datasets in charts or graphical forms. The following sections describe the instructions to
perform some basic spreadsheet tasks in Calc.

To format tables and cells in a Calc spreadsheet:

1. On the Applications menu, point to Office and then click OpenOffice.org Spreadsheet to open a Calc spreadsheet. A
new Calc window opens.

-Q Applications  Places System e 2 (7]

:1}’ Accessories ’

[w}t Games v

BN

4 ;
2 Graphics ’

’t:’ Internet L7
@ S » Q Evolution Mail and Calendar

.;," Programming 3 :?J Openoffice.org Presentation

m Sound & Videa  » E openoffice.org Spreadsheet

M openoffice.arg Word Processor

Performn calculation, analyze information
and manage lists in spreadsheets. »

@_. AddjRemove...

Figure 4.24: Launching Calc

2. Some of the key components of the main Calc window are described below:

s . Op j
File Edit View Insert Format Tools Data Window Help
e — A »
FEC |na|: Bfa W = @j % .
- A 4 A B | Inputline | 7
- fo E =] g [/
LY N
A [ 8 W ¢ ™o [ e [ ¢ [ & [ W& [ IF
2 L
| 2 ! I
% I Function wizard Function bUﬂClﬂ] |
| 6 | I I I
| & | =
| 2 | I I I I
| 10 | I I I I
| 11 |
12
13
12 Sheet tabs
15
16
14 /A | | | | | B
171700 shekt1 /Sheet? 7 Sheets Al on
Sheet1/3 | Default 100% STD Sum=0

Figure 4.25: The Calc Window

¢ The Name box contains the cell and the row number, called the cell reference, of the current or active cell.
* The active cell indicates the selected cell currently in use.

* The Function wizard opens the Function Wizard dialogue box.
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* The Sum button allows you to calculate the sum of the numbers in the cells that are above the current cell.
* Clicking the Function button inserts an equals sign into the current cell as well as in the input line, making it ready to
accept a formula.

* The sheet tabs at the bottom of the sheet indicate the number of worksheets present in the current spreadsheet. By
default, a new spreadsheet includes three worksheets.

3. After you have entered the required data in the spreadsheet, you can apply different formatting styles to it by selecting
from the wide range of options available in Calc. To apply desired formatting to a selected range of cells, on the Format
menu, click Cells. The Format Cells dialogue box opens.

ile Edit View Insert Format Tools Data Window Help x

m [e

= o ~ | Default Formatting Ctri+Shift+Space | o — »
i ol g = - ~ :
I ] -3 8- :
Cells... Ciri+1

ﬁ-_ﬂ | Arial Row

Column

Co—

Merge Cells

Name Gender ~ Page...
Pater lale Print Ranges

LT R

Fred ale fe

Ralph Vale | ¢

Sue  IFemale  change Case

Styles and Formatting F11

Ll e o A
Mike Male |
Harold Male | Conditional Formatting...

Dan Male | Anchor
Female |7 Alignment
Arrange

Hip

Melissa
Heather F
Hayden
Bach

Group

Graphic

P N ) P 8 .|

© m|u‘m|m‘a|w‘m »—4‘0 Ao 1 | b
=
@

~
=]

[4]

S\ Sheet1 Sreet B _
Sheet 1/3 Default 100% 5D [* Sum=0

E| [s) Untitled] - Openoffic... | D:_ﬂ

&
&

Figure 4.26: Formatting Cells

4. You can use the various options available under the Font, Font Effects and Alignment tabs to specify various formatting
attributes for the selected text. Similarly, for assigning formatting attributes to numbers, you can select from a number of
pre-defined formats available on the Numbers tab page or define a new one based on your preferences.

The Format Cells dialogue box also provides you with options to add smart borders and vibrant backgrounds to your
spreadsheet. It also allows you to select a background colour, from a spectrum of colours, for your otherwise bland and
dull spreadsheet.

Define the specifications and click OK to apply the formatting effects.

INumbers ‘Fﬂl'lfl Font Effects | Alignment | Borders' Background | cell Protection | I

Font Typeface Size
|Verdana | |[Cursiva ] 11 |
URW Chancery L =] Normal 10
URW Gothic L Cursiva 10.5
URW Palladio L Negreta 11
Vemana2000 Negreta cursiva 12
derdana 13
Webdings — 14
= 15
Language
| English (India) ==

Name Gender Age School

The same font will be used on both your printer and your screen.

| ox ” Cancel ]\ Help ][ Reset |

Figure 4.27: Defining Formatting Attributes
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5. After you have selected formatting attributes for the selected cell range, you may get a result similar to this one.

fs} Fi e e e e ]

Eile Edit View [nsert Format Teols Data Window Help

= Iy B = =l [ /o - g C™ A z o | =g |

8 DEe ([Huma v i |- 4% @ §ii. &l

Y [aral [l [-1l& 4 A v 8% Un | [

(123 - fo X = |

A I p Tcl p 1 E F G H 1 [ ] I K g

1 [Name |GenderAge School Favourite Subject

2 |Peter Male 17 AHS Science

3 [Casey Female 16 BHS Fine Arts

4 |Fred Male 17 CHS Science

5 [Ralph Male 15 BHS Fine Arts

6 [Sue Female 16/CHS English

7 _[Pat Male 17.BHS English

8 [Magan Male 15BHS Fine Arls

9 [Mike Male 16 BHS Fine Ars

10 JHarold Male 18 AHS Maths

11 fHenry Male 15 AHS ‘Sclence

12 [Dan Male 17BHS Science

13 fKerry |Female 16 CHS English =
14 Jlouis Male 15BHS Maths

15 QJeff Male 18 CHS Fine Arts

16 Melissa  Female 17 BHS Maths

17 JHeather Female 15BHS Science

18 JHayden Female 16 AHS English

19 JBach Male 16 AHS Maths

20

21

22

5 —

24

25

26

27 1 1 =
28 =

" Sheetl [Sheet2 [Sheel3 1N | I |
b /me VIS FE @ < -F -0 -4 0 A= &,
Sheet1/3 Default 100% STD Sum=0

Figure 4.28: The Formatted Spreadsheet

6. Calc provides you with another useful feature, called Autoformat, which enables you to create attractive and professional
table designs without undergoing the time-consuming process of selecting cell groups and assigning different formats to
them. The Autoformat feature allows you to quickly apply preset formats to an entire sheet or a selected cell range. To
apply Autoformat to a sheet or selected cell range, on the Format menu, click Autoformat.

s NUnEHEA = OpEnOTH ceror g calt
File Edit View Insert Format Tools Data Window Help x
= A [ e Default Formatting Ctri+Shift+Space L g e . — A o ES
8@l = J A 9@ gl v el |
Cells... Ctri+1
TRl o )
M (000 | Bow ’ % $% 3 )
Column . %
[AL:E19 ~| |  Sheet ,
Merge Cells v
F [ G H =
Page...

Print Ranges »

Change Case »
Styles and Formatting F11
AutoFormat... =
Conditional Formatting...

Anchor

- Alignment

Arrange

glip

Group
Graphic

Kl

1

=

Sum=292

Figure 4.29: Using Autoformat

7. This displays the AutoFormat dialogue box. To assign a pre-set format to the selected cells, select one from the Format




Ubuntu Desktop Training
110/348

list and then click OK to apply the selected format to the selection.

Format - 5

0 -
Default B
3D Cancel
Black 1
Black 2
Blue [Tip]
‘Brown
Currency Add...
Currency 3D [
Currency Grey W}
Currency Lavender
EL::renncy Turquoise = [ Maore ¥ l

Figure 4.30: Selecting a Format

8. The format of your choice is immediately applied to the selection, and you get an attractive and fully formatted table with
very little effort.

5

ie Edit View [nsert Format Tools Data Window Help X
%}W;@m'ﬁh'w@;z;aiﬂté

o-2afecFraa vm BtES |
B8 (aral o - ad4A Lo EEE- §
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K7 - fw B = |
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15BHS  |Fine Aris
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17BHS _ English ' ' —1

15\BHS  |Fine Arts
16BHS  |Fine Arts
18/AHS |Maths
15|AHS |Science
17]BHS  |Science
16/CHS  |English
15BHS |Maths
18ICHS  Fine Arts
17]BHS  Maths
15BHS [Science
16/AHS |English
16/AHS  Maths

[«

/\Sheet1 [Shestz 7Sheets 7 |[4] I 1

Y/ meVE®E -© ¢ BB &% 0 A&

[ Sheet1/3 | 5T

100% STD Sum=0

Figure 4.31: The Formatted Table

Entering Values and Formulas A formula is a spreadsheet function, complete with arguments, entered in a cell. All formulae
begin with an equal sign and may contain number, text and, in some cases, other data such as format details. The formulae may
also contain arithmetic operators, logic operators or function starts.

The quickest way to enter a formula is to type the formula either in the cell where you want the result to display or in the Input
Line on the Formula bar. You can also use the Function wizard, which helps you interactively create formulae.

1. In your spreadsheet, select the cell where you want the formula to be inserted. To allow the Function wizard to guide you
through the creation and application of a formula, on the Formula bar, click Function Wizard. This opens the Function
Wizard dialogue box.
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Formulae Description

=SUM(A1:A11) Calculates the sum of the cells A1:Al1

=EFFECTIVE(5%:12) Calculates the effective interest for 5% annual nominal interest with 12
payments a year

=B1*B2 Displays the result of the multiplication of B1 and B2

=C4-SUM(C10:C14) Calculates C4 minus the sum of cells C10 to C14

Table 4.1: Calc Formulae

4 L o —
File Edit View Insert Format Tools Data Window Help x
=y B =l = = % = B = gemo ¥ R oy = _ ) »
8 DA IHEEE 9% « Tl -2 ¢ gi.i. dF FsEm |
| = = : — - »
S [aal Mo [-1& 4 A F S KR R - R R
o 7 R
A ] B I C [ D E F g H 1 [ ] I K L [=
1 |Climatic Data
Mean daily  Mean daily
3 max min
Months temperature temperature Mean rain fall
4
5 |January | 25 13.5 108
6 |February | 244 13.4 92.4
7 |March 22.8 11.5 B69.5.
8  |April | 19.8 8| 40.9
9 |May 16.2 5.1 50.4
10 |June | 12.9 1.7] 54.3
11 |July 12.2 0.8 57.6
12 |August | 137 1.2 49 |
13 |September 16.4 4 99
14 |October | 19.6 & 76
15 |November 22 9.7 83.2
16 |December | 24 121 108.3
17
18
19
20
21
22
23
24
25 1 1 1 1 1 e
26 =
£l M Sheetl {Sheet? [Sheet3 1Kl | I |
h /EeY @ ¢

Sheet1/3 Sum=0

Figure 4.32: Launching Function Wizard

2. You can see the entire range of functions listed in the Functions list box. You can also select one category from the
Category drop-down list to display the functions listed under that category. Find the desired function from the Functions
list, and click to select it. You notice that the Function Wizard dialogue box provides you some information about the
selected function to guide you through your selection. After selecting the function, click Next to proceed with the task of
entering a formula.
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Functions | Structure Function resulti

Category AVERAGE
[ant

ar

AVERAGE( number 1; number 2; ... )

Function
AMORDEGRC
AMORLINC Returns the average of a sample.
AND
ARABIC ||
AREAS
ASC
ASIN
ASINH
ATAN
ATANZ

ATANH Formtila Result [Em520
AVEDEV

(AVERAGE = &
AVERAGEA

[[+]

141

[ Array Help ] [ Cancel | = | Next >> l [ oK

Figure 4.33: Selecting a Function

3. Now, you need to specify the numbers to which you want to apply the formula. To select the numbers, you need to go back
to the worksheet.

Click the Shrink button to shrink this dialogue box and return to the worksheet.

Functions | Structure AVERAGE Function result |#DIV/0!
Category Returns the average of a sample.
[Statistical =
Function number 1{required)
AVEDEV [<] Number 1, number 2;...are 1 to 30 numeric arguments representing a
AVERAGE = population sample.
QVEF.AGEA = number1 | % ||| |
BETADIST number 2 | & :]
BETAINV
BINOMDIST number3 | & |
CHIDIST
CHIINV numbera (&[]
CHITEST
CONFIDENCE Formula Result |#DIV/0!
CORREL — .
COUNT [FAVERAGE( ) =
COUNTA
COVAR =
[ aseay Help ] [ Cancel J [ << Back J | C n oK

Figure 4.34: Shrinking the Function Wizard Dialogue Box

4. The Function Wizard dialogue box shrinks to allow you to view the worksheet. To select the cell range, hold down the
SHIFT key and use the mouse to select the cell range containing the desired numbers.

After selecting the cells, you can go back to the Function wizard by clicking the Maximize button.
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[el Sample Calc document - OpenOffice.org Calc EIE"E
File Edit View Insert Format Tools Data Window Help X
= = e T = s S »
Ee B ERA Y B0 49 ¢ @n..dPF BimE |
1 | T ™ - b 1 i 2 .
[Aral N HadA BEEEEE 1 238 EEE- |
| D17
A L |=
1 |Climatic Data
2
Mean daily  |Mean daily
3 max min
Months temperature temperature Mean rain fall|
4 e
5 |January 25 13.9 108
6 |February 24.4 13.4 92.4)
7 |march 228 114 60.5]
8 |Aprl 19.8, g 40.9
9 |may 16.2] 5.1 50.4)
10 [June 12.9) 1.7 54.3)
11 [July 12.2/ 0.4 57.6
12 |August 13.7 1.3 49| [
13 |September 16.4] E 55
14 |[October 19.6 7.1 76
15 [November 22 9.7 85.2)
16 [December 24 12.1 1083
17
18 |
19
20
21
22
23
24
25 |
26 ]
[ \Sheetl /Sheet? fSheats /7 |J<] ] |
R/ EmeY[T® = "

Figure 4.35: Selecting the Cell Range

5. The cell reference for the selected cell range automatically appears in the number 1 box and the applied formula, complete
with arguments, appears in the Formula box at the bottom of the dialogue box. To complete the task of entering a formula,
click OK.

Functions | Structure AVERAGE Function result [#DIV/0!

Category Returns the average of a sample.
[Statistical -
Eunction number 1{required)

AVEDEV Number 1, number 2;...are 1 to 30 numeric arguments representing a
AVERAGE population sample.

AVERAGEA

BETADIST e I [ -]
BETAINV A
BINOMDIST number 3

CHIDIST

T —
CHITEST
Formula Result |#DIV/0!

CONFIDENCE

CORREL

COUNT [FAVERAGE(D4015) -
COUNTA

COVAR

[»]

[] Array Help ] l cancel J l << Back ] | e | [ oK l

Figure 4.36: Applying the Formula

6. The solution appears in the cell where you had applied the formula.
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5 ek
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1 [Climatic Data
2
Mean daily  Mean daily
3 max min
Months temperature temperature Mean rain fall
4
5 |January 25 13.5! 108,
6 |February 244 13.4 92.4
7 |March 2238 11.5] 69.5
8 |April 19.8 8 40.9
9 |May 16.2 5.1 50.4.
10 |June 129 1.7] 54.3)
11 |July 122 0.6 57.6
12 |August 137 12 49 u
13 |September 16.4 4 55|
14 |October 19.6 74 76
15 |November 22 9.7 85.2
16 |December 24 12 08
17 —
18
19
20
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22
23
24
75 ||
26 L
[)(3)(+)p1 Sheetl /Sheet2 [Sheets /7 |[4] 1

h " meVEI® m-©-<-0-

[Sheet1/3

Default 100%

Figure 4.37: Final Output

Sum=70.55

Inserting Charts You can present your data in the form of charts or graphs to compare your data series visually and view trends
in the data. Calc offers you a number of ways to represent spreadsheet data graphically.

1. Open a spreadsheet containing data and row and column headings, and select the data to be included in the chart. Then, on

the Insert menu, select Chart. The Chart Wizard dialogue box appears.

B AT,

File Edit View Insert Format Tools Data Window Help

Cells... Ctri++ 4 | i
o ows
] ) d
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B i coumns A 4A
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[€)(<)[»]01)% Sheetl {Sheet? [ Sheet3 7 [<]
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SR E:
8 "=
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3£ special Character...
Formatting Mark 3
Hyperlink I

Ctri+F2

Function...
Function List
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Note

B

Picture
& Video and Sound
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@& Chart...
[T] Floating Frame

Sheet1/3 Default 100%
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Figure 4.38: Launching the Chart Wizard
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2. On the first page of the Chart wizard, you can select the chart type and preview the chart output. Calc allows you to
select from a wide range of 2D and 3D charts. You may decide to follow the rest of the instructions of the Chart Wizard
by clicking Next or you can click Finish to insert a chart in your document.
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Choose a chart type

FLIRICL |

TS

4, Chart Elements =
% ;::'! et 3D Look |[simple =

2. Data Range & Pie
3. Data Series ks Area

Cy
Cone

Pyramid

] i Next>> |} Einish | [ Cancel

Figure 4.39: Selecting the Chart Type

3. The chart is inserted at the specified location in your spreadsheet. You can now move and resize the chart and edit it further
to suit your requirements.

s 8 [EEA T
|

A B [ C \ D [ E [ F \ G [ H [ | [[=
1 Climatic Data | |

IMonths

3

4 Hanuary
5 |February
6
i
8

March

A pril

May

9 pune

10 Huly

11 [August

12 [September
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Figure 4.40: The Inserted Chart

Exporting Spreadsheets to PDF Like the other OpenOffice.org applications, you can export your spreadsheets from Calc as
PDF files. With OpenOffice.org you do not need any additional third party software to convert your documents into PDF format.

1. On the File menu, click Export as PDF. The Export dialogue box appears.
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File Edit View [Insert Format Tools Data Window Help

JEdT =0
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& gpen o | B EBE Y e DH- 53 6 -& i
Recent Documents b = . »
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I
X Close 2z = ]
; R | c ] D E E | H .
Save As... Ctri+Shift+5 jc Data
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Versions... I
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Export as PDF... | 11.9 69.5 Fal
B Mean Daily
Send L 8 40,9 Min Tem- —
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[+] Propertjes... 17 54.3 W Mean Daily
Digital Signatures... 0.6 57.6 ph:’a.sTf:n
Templates v | 15 ;g
Preview in Web Browser 7.2 76
| 97| 85.2
Page Preview 121 108.3
= Print... Ctri+P | 0.6 7.33
45 Printer Settings... R
= == o
&l Exit cri+q (eeB/7 [ 2 |
[Sheet1/3 | Default | 100% | STD Sum=0

2. The four tabbed pages in this dialogue box allow you to define options, such as the pages to be included in the PDF, the
type of compression to be used and the level of security to be assigned to the file. After defining these specifications, click

Export to continue.

Figure 4.41: Exporting Spreadsheet as PDF

[Eanerall Initial View ‘ User Interface ‘Security]
Range
@ Al
() Pages
() Selection

Images -
@ Lossless compression

() IPEG compression

[] Reduce image resolution | 300 DPI 7‘ >~
General
[ Tagged PDF
[[] Export notes
W) Export boockmarks
Create PDF form
Submit forms in format: FDF =
I Export III Cancel J [ Help

3. Provide a file name for your spreadsheet and navigate to the directory where you want to save it. Click Save to export the

spreadsheet as a PDF file.

Figure 4.42: Defining PDF Options
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Name:

|[ cirnate geta

~ Browse for other folders

E] i williamwindsor

Create Folder

Places Mame: - | Modified
I8, search 5 .10_Lesson @ 20/10/07
&) Recently Used 2 .adobe Friday

53 williamwindsor = ;audacity-data 22/10/07
i@ Desktop = .cache 19/10/07
L File Systermn = .config 19/10/07
5 n 1 =3 .dbus-kevrinas 111m7

~ File type

PDF - Portable Document Format {.pdf}

i

PDF - Portable Document Formatl

pdf

Figure 4.43: Saving as PDF

Nice to Know:

To discover an Easter Egg tucked away in Calc, click within any of the cells of your spreadsheet, type =
GAME("StarWars") and start playing right away.

4. Your spreadsheet is now displayed as a PDF file.

Fle Edit wiew Go Help

g [1 | of 2 lFit Page Width 3
r Mexdt
Sheet1
Climatic Data
Mean Dally  Mean Daily
Max Min Mean Rain Climatic Data
Manths Temperaure Temperawre Fall
January 25 135 108
February 24.4 134 924
March 228 11.5 695
April 19.8 8 409
May 16.2 5.1 504
June 129 1.7 543
July 12.2 0.6 576
August 13.7 1.2 49
September 16.4 4 55
October 19.6 7.2 76
MNovember 22 9.7 B52
December 24 121 1083 e e aeh
25 0.6 7.33

Figure 4.44: The PDF file
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4.4 Using OpenOffice.org Impress

Impress is a fully featured presentation tool of the OpenOffice.org office software suite. It enables you to create effective
multimedia presentations by creating 2D and 3D clip art and images. It also allows you to create special effects and animations
by using high-impact drawing tools.

OpenOffice.org Impress is similar to Microsoft PowerPoint in its functionality. In addition to making it easy for you to create
PDF files from presentations, Impress lets you export the presentations into ShockWave Flash (SWF) files. This enables you to
run the output on any computer that has a Flash player installed.

4.41 Key Features of OpenOffice.org Impress

Some of the many useful features of Impress are:

Creating Vector Graphics: Impress comes bundled with various drawing tools that allow you to create vector graphics from
within the application. You can also export vector graphics to bitmap pictures and, inversely, convert bitmap pictures into vector
graphics.

Creating Slides: Choose from ready-to-use templates or use the drawing and diagram tools to jazz up your slides. Master view
adds the elements that you want to appear on all slides of your presentation.

Further, Impress users have the option to install the Open ClipArt library, which contains a huge selection of images for free use.

Animations and effects help add spice to your presentations. You can render stunning 2D and 3D effects to your text using
Fontwork, which lets you create life-like 3D images easily.

Publishing Presentations: Impress allows you to publish presentations as handouts, export them into PDF files, convert them
into SWF files and publish them as HTML documents. This enables you to access your presentation from a variety of platforms.

Saving Presentation in Other Formats: Similar to other OpenOffice.Org applications, Impress saves your work in the interna-
tional OpenDocument format. It also allows you to save your work in other formats such as PowerPoint.

4.4.2 Creating Multi-Media Presentations
To create and view presentations using OpenOffice.org Impress:

1. On the Applications menu, point to Office and then click OpenOffice.org Presentation.

-{3 Applications Places System e @ 0

‘!‘k Accessories »

[st Garmes »
A hi "
72 Graphics

L\.:',' Internet >

Tl office »| (=) Evolution Mail and Calendar

J" Programming 3 E Openoffice.org Presentation

m Sound & Video  » m Openoffice.org Spreadsheet

Create and edit presentations for
slideshows, meeting and Web pages.

;
OpenCffice.org Word Processor
@_‘ Add/Remove... | M

Figure 4.45: Launching Impress
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2. The Presentation Wizard dialogue box appears. The Presentation wizard allows you to define the basic structure of a
presentation in three brief steps. You can either continue defining the specifications as guided by the Presentation Wizard
or immediately create a new blank presentation by clicking Create.

@ Empty presentation
) From template

() Open existing presentation

[ Preview

] Don't show this wizard again

Help ] I Cancel ] | < Back | [ Next == ] [ Create

Figure 4.46: Using the Presentation Wizard

Nice to Know:
To be able to preview the slide template, slide design and slide transition effects, leave the Preview check box selected.

3. This figure shows the main Impress window with an empty presentation. From the Task pane on the left, you can select a
layout for your current slide.

Thipress
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I ] [¥] |k Slide Transition
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Figure 4.47: The Impress Window

4. Enter the required text in the provided text boxes to create the first slide. To make your presentation more attractive and
professional looking, you can either change the background and format the font size and colour for each slide or simply
select a pre-defined template from the Master Pages panel.
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Click Master Pages to open the Master Pages panel.
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Figure 4.48: Opening the Master Pages Panel

5. A number of templates are available on the Master Pages panel. Select the template of your choice to apply a whole new
look to your presentation. You can enhance the look of the presentation further by adding various elements, such as objects,
pictures and animated images, from the Insert menu. Alternatively, you can start adding new slides to the presentation.

You can add a new slide by clicking the Slide button on the Standard toolbar. Alternatively, click Slide on the Insert

menu.

Im fi
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Figure 4.49: Selecting a Slide Template

6. The inserted slide is also formatted as the first slide because that is the layout you selected last. According to the require-
ments of your presentation, you can select a new format from the Layout pane. The new layout has two columns, one for
text and the other for images. This allows you to display text along with an associated image on the same slide. Enter the
textual content in the provided text boxes, then double-click the house icon to insert a graphic in the provided placeholder.
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Figure 4.50: Selecting a Slide Layout

7. In the Insert Picture dialogue box, select the desired image and click Open to insert it into your slide.
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Figure 4.51: Inserting Picture in a Slide

8. Notice that the inserted picture is automatically resized to fit into the provided space. You can also insert an image by
selecting Picture from the Insert menu. A picture inserted in this way is not automatically resized, but you can move and
resize it as needed. You can insert new slides in a similar fashion.

Now, you are ready to display your presentation as a slide show. To configure the basic slide show setting, select Slide
Show Settings from the Slide Show menu.
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Figure 4.52: Setting up a Slide Show

9. The Slide Show dialogue box helps you define the basic settings for your slide show. In the Range section, you can specify
the slides to be included in the presentation and their order of display. In the Type section, you can define how to display
the slides. Similarly, the Options section allows you to define various other settings for your presentation.

After selecting the desired options, click OK to apply the settings.

Range
@ Al 3ides
() Erom: ,srl_\iuz,-’e 1 = | Cancel |
l Help |
Type Options
(@ Default ] Change slides manually
O Window [} Mouse pointer visible
() Auto 0 Mouse pointer as pen
00:00:10 D [ Navigator visible
Animations allowed
i) Change slides by clicking on background
[[] Presentation always on top
Multiple moniters

Figure 4.53: Configuring the Slide Show Settings

10. To start the slide show select Slide Show from the Slide Show menu or press F5.

File Edit View |Insert Format Tools Slide Show Window

Slide Show Settings...
Rehearse Timings

Lo

B custom Animation...
Slide Transition...

[} show/Hide slide
Custom Slide Show... |

Figure 4.54: Starting the Slide Show
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11. The presentation can be viewed as a running slide show. When you reach the last slide of the presentation, you are prompted
to exit the presentation by clicking once. However, you can exit a slide show at any point of time by pressing ESC.

12. You can choose to print your slides with notes, as an outline, with page numbers, with date and time and so on. To do this,
select Print from the File menu.
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Figure 4.55: Printing the Presentation

13. You can use the Print dialogue box to further define printer settings or accept the default settings, and click OK to start
printing your presentation.

z = ] @
Printer
Name [Generic printer ) | Propertjes... |
Status Default printer
Type SGENPRT
Location
Comment
[ Print to file
Print range Copies
@ All Number of copies [ j
() Pages [ i
|: j[‘;]
fn i rgjaj
| Options... OK. ] ‘ Cancel I | Help

Figure 4.56: Defining Printer Settings

To create a presentation with 3D effects and animations:

1. Open a new presentation in which you want to use 3D graphics and animations, and select a suitable template from the
Master pages panel. Now, you can start adding elements to your presentation to spice it up. Begin with placing the title of
your presentation on the first slide.

To create an eye-catching display for the title text, you can use one of the many wonderful text tools available in Impress.
One of these is Fontwork, which enables you to create special 3D effects to your text. To start using Fontwork, on the
Drawing toolbar, click the Fontwork Gallery button. The Fontwork Gallery window appears.
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Figure 4.57: Opening Fontwork Gallery

2. Select the style in which you want the title text to be displayed, and click OK.

Select a Fontwork style:

A PoMwek  Fofwok Gl
for N

:

Figure 4.58: Selecting a Fontwork Style

3. The text Fontwork, in the selected style, appears on the slide as an object. To display the title text in place of the Fontwork

object, double-click the object and type the title text in place of the black Fontwork that appears over the object. Click
outside the object’s selected area to exit the Fontwork edit mode.
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Figure 4.59: Editing the Fontwork Object

4. You can go ahead and do the same on the other slides too by inserting 3D images and animating them.
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Figure 4.60: The 3D Text

5. You can insert 3D graphic objects in your presentation from the 3D-Objects toolbar. By default, this toolbar is not displayed
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on the Drawing toolbar. To display the 3D-Objects toolbar, on the View menu, point to Toolbars and then click 3D-
Objects.
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Figure 4.61: Inserting 3D Graphics

Nice to Know:
You can also display the 3D-Objects toolbar by clicking the small arrow at the end of the Drawing toolbar and selecting it
from the Visible Buttons list.

6. The 3D-Objects toolbar appears as a floating toolbar. If you do not like floating toolbars, you can place it on one of the
existing toolbars. To dock the 3D-Objects toolbar, drag the title bar of the toolbar to the desired location and release the
mouse button.

3D-Objects - x

@@ a

eee

Figure 4.62: The 3D-Objects Toolbar

7. The 3D-Objects toolbar is now attached to the Line and Filling toolbar. You can pick up objects from this toolbar and
insert them into your slides. To insert a 3D Object on your current slide, click the desired object on the 3 D-Objects
toolbar. Then, move your mouse to the point where you want to insert the object. You can see a plus sign in place of the
mouse tip. Holding down the left mouse button, drag the mouse to insert the object on the slide. The selected 3D object
appears on the slide.
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Figure 4.63: Inserting a 3D Object

8. You can change the proportion and size of the object by holding the green handles that appear around it. Impress also
provides you tools to apply a number of 3D effects on the object to modify its look and feel as per your requirements. To
apply 3D effects on the inserted graphic, right-click the object. On the short-cut menu, click 3D Effects. The 3D Effects

dialogue box opens.
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Figure 4.64: Applying 3D Effects
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9. You can use the options available under the different buttons in this dialogue box to define the look and feel of the inserted
object. Click the Illumination button to fine- tune the illumination effect on the object. You can select the appropriate
options from the drop-down lists to render the desired illumination effect to the object. Alternatively, you can simply drag
the white dot in the graphic at the bottom of the dialogue box and move it to get the desired effect.

10. After specifying the desired options, click the Assign icon on the top right of the dialogue box to apply the effects on the

selected object. Click Close to exit the 3D Effects dialogue box.
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Figure 4.65: Defining 3D Effects

11. Notice that with a couple of mouse clicks, the 3D object takes on a completely new look. In a similar fashion, you can add
many more 3D and 2D elements to your presentation and apply various 3D effects to jazz it up. Impress also offers some
animation functionality to help you bring life to your presentations. To display the animation options available in Impress,
on the Slide Show menu, click Custom Animation.

The Custom Animations panel now appears on the right edge of the presentation window.
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Figure 4.66: Applying Custom Animation
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12. To apply an animation effect on an individual element in your slide, select that element and click the Add button on the

Custom Animation panel. The Custom Animation dialogue box opens.
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Figure 4.67: Animating Objects

13. You can now apply various animations to the selected object, define the entrance and exit animation for it and chart a
motion path for the object. Similarly, you can specify animation effects for other elements on the slides.

After defining all the desired settings for the object, click OK to apply the animation effects.
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Figure 4.68: Customising Animation Effects

14. The specified animations can be viewed at the bottom of the Custom Animations panel. You can now view the animation
effects in a slide show. Click the Slide Show button to view the presentation as a slide show.
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Figure 4.69: Launching a Slide Show

15. Your presentation runs as a spectacular and lively slide show.

Figure 4.70: The spectacular Slide Show

Exporting a Presentation As stated earlier, another useful feature associated with Impress is that it has the built-in capacity to
export presentations directly into several other file formats. As a result, Impress allows you to export your slide shows directly

as Flash (SWF) files.
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1. On the File menu, click Export. This opens the Export dialogue box.
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Figure 4.71: Exporting a Presentation

2. Here, you need to specify a file name in the Name field and navigate to the directory where you want to export the file. To
export the presentation as a Flash file, select Macromedia Flash (SWF) (.swf) from the file type drop-down list and click
Save. The file is exported to the indicated location. You can now view the presentation as a Flash file.
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Figure 4.72: Exporting Presentation as a Flash File

4.5 Using OpenOffice.org Draw

Note:
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Draw is a vector graphics drawing tool that enables you to create simple and complex drawings and export them in a number
of common image formats. Draw also allows you to insert tables, charts, formulas and other items created in OpenOffice.org
programmes into your drawings.

Graphics that are created using a vector graphics drawing tool do not blur when resized.

Draw is integrated with the OpenOffice.org suite, making it easy toexchange of graphics with other components of the suite. For
example, if you create an image in Draw, reusing it in Writer is as simple as copying and pasting the image. A subset of the
functions in Draw are also available in Writer and Impress, so you do not have to switch back and forth between them and Draw
to perform basic image manipulations.

4.5.1 Key Features of OpenOffice.org Draw

Note:

Vector drawing software follows a common notation for referring to all shapes, whether simple lines, rectangles or more compli-
cated shapes, as objects.

Draw provides extensive functionality that integrates more functions than the majority of drawing tools available in office suites.
Some of the key features of Draw are:

* Vector Graphics Creation : You can create vector graphics in Draw by using the lines and curves defined by mathematical
vectors. Vectors describe lines, ellipses and polygons according to their geometry.

* 3D Objects Creation : In Draw, you can create simple 3D objects, such as cubes, spheres and cylinders, and modify the light
source of the objects.

* Grids and Guides: You can align objects in your drawing by using grids and guides as visual cues. You can also snap an
object to a grid line, a guide or to the edge of another object.

¢ Connecting Objects to Show Relationships: You can attach objects to each other using special lines called connectors to
show the relationship between those objects. Connectors attach to glue points on drawing objects and remain attached when
those objects move. These are useful for creating things like organisation charts and technical diagrams.

* Displaying Dimensions: You can use dimension lines to calculate and display linear dimensions in technical diagrams, which
often show the dimensions of the objects in the drawing.

* Gallery: You can insert and use images, animations, sounds and other items from the OpenOffice.org gallery in your drawings
as well as in other OpenOffice.org programmes.

* Graphic File Formats: Export your creation to many common graphic file formats, such as BMP, GIF, JPG and PNG.

4.5.2 Performing Basic Drawing Operations

Note: Note: Note: Note:

1. On the Applications menu, select Graphics and then OpenOffice.org Drawing.

The main components of the Draw window are shown in the following graphic:
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Figure 4.73: The Draw Window

2. The drawings are created in the drawing area, which is surrounded by the following toolbars:

* The Menu bar lists the main menus available in Draw. It includes options to manage, edit and view the format of your
drawings.

* The Function bar displays icons to perform tasks such as Open, Save, Copy, Cut and Paste.

* The Line and Filling bar includes specific drawing tools to modify the appearance of a selected object such as line style,
colour and thickness; fill style and colour.

» The Drawing toolbar is the most important toolbar in Draw. It contains all the necessary functions for drawing various
geometric and freehand shapes. Creating basic shapes in Draw requires the extensive use of this toolbar. However, you
have to further edit, combine and manipulate them to create complex objects.

You can vary the number and position of the visible tools to make the interface look a bit different. To add or remove a
toolbar from the Draw window:

3. On the View menu, point to Toolbars. The Toolbar list displays the toolbars available, with a check mark next to the
toolbars that are displayed. To remove a toolbar from the Draw window, clear the corresponding check mark and click the
toolbar without a check mark to add it to the window.

To create an object by using the Drawing toolbar:

1. Click a specific object button such as Rectangle or Ellipse on the Drawing toolbar, and place the mouse cursor at the point
in the drawing area where you want the object to start.

2. Press the left button on the mouse, drag the cursor to where you want the object to end and release the button. The object
appears in the Drawing area.

Selecting Objects Before making any changes to an object, you need to select the object. Draw provides the following options
to select an object:

* Direct Selection: Click the object to select it.
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* Selection by Framing: On the Drawing toolbar, click the Select button and drag a large rectangle around the object to select
it. This option is useful for selecting multiple objects in the drawing area. Note: You have to enclose the object(s) completely
in the rectangle to select them.

Figure 4.74: Selecting by Framing

* Selecting hidden objects: To select an object that is covered by another object, press Alt key and click the object you want to
select. Note: To be able to select a hidden object, you must know the position of that object relative to the objects on top.

Editing Objects When creating objects, you may have to edit them or change their properties to get the desired output. However,
you may not always find that flexibility in the default software settings. For example, you cannot change the shape of the square
to a rectangle or rotate the square on its own axis by using the default Drawing toolbar. To perform these tasks, Draw provides
various other options with the required flexibility, such as:

All the options covered in the subsequent sections apply to a selected object or a group of objects. You can identify a selected
object from any other by the small, coloured square or circle around the object. These squares or circles are called handles and
form a rectangular frame that is just big enough to contain the object.

1. In the Drawing area, select the created object by clicking it. Handles appear on the object.

Figure 4.75: Selecting an Object

2. Place the mouse cursor over one of the handles. When the cursor becomes a double-headed arrow, drag the cursor in the
direction of the arrow to modify the size of the object. If you choose a corner handle, you will resize the object along two
axes at the same time. If you use a side handle, the objects will only be resized along one axis. The outline of the resulting
new object appears as a dotted line.

3. Release the mouse button when the object is sized correctly. The dotted line disappears, and the resized object appears.

Figure 4.76: Modifying the Object
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Arranging Objects If the document you are working on includes many overlapping objects, editing of individual objects (which
may or may not be visible) might pose a challenge. Fortunately, Draw provides a way to rearrange objects without affecting their
layout.

1. In the drawing area, right-click the object you want to rearrange, point to Arrange and select the appropriate option from
the Arrange list.

ER e i& Line...
File Edit VMiew Insert Format Tools Modify ﬂindov@" Area...
Text...

%‘ - E} E |;\ .‘E [ﬁ;i .'E' maéylﬁ%éa @ [ Position and Size... = é‘& 6’ 5}

farn) - - & Character... —
" .~ T S— R e x =
B g = - ——¢] foom [§ @.ﬂw Paragraphi 3| @@saimon 3] O "
fH] ¢ oeele- 2w 3o ool S B o Ten -Be - S ATAnGE + |[El Bring to Front © 180104
B Alignment + |[Zl Bring Forwards
Hlip + |m' Send Backwards
1 Convert v Send to Back
o Description... [ In Front of Object
: Name Object... [® Behind Object M
[ == -
] Edit Style... |
Ed oo Cut
b———a——/[] Copy

o
=
&
2]
o ~|
(Wi{«)(+](v]% Layout {Controls / Dimension Lines / [Nl | | D
o — = A >»
Ly / — iw?vguva. .(J._.Dv_vw.ﬂp _
Shape selected 13 5.50 /5.00 i 3.50%3.50 [100% |* Slide 1 /1 (Layout) | Default

Figure 4.77: Rearranging the Object

2. If you select the Send Backward option, the output is as shown in the following graphic:

[]

Figure 4.78: Object Sent Backwards

Duplicating Objects Often, you may need to create multiple objects of the same shape and size. In Draw, you can duplicate or
make multiple copies of an object. The copies can be identical or differ in size, colour, orientation and location.

1. Click the object to be copied, click Edit and select the Duplicate option. The Duplicate dialogue box opens.

2. Specify the appropriate values in the Duplicate dialogue box, and click OK to display the output in the drawing area.




Ubuntu Desktop Training
136 /348

Number of copies to be
created

A / DI

Specify the horizontal %’ s
distance between the centre Nufnber of copies i 3 [‘_71 oK
of the objects - P——
Placement ‘ Cancel |
X axi 0.50 - —_—
Specify the vertical dislanne@’ it 2=t = | Help |
between the centre of the Y axis psoecm [ —
objects J—- Angle |0 degrees ‘&l
- Enlargement Specify the angle of rotation
Enlarge or reduce the wwdthL Wider poocm 3 between the original and
of the copies - the copies
Height |0.00cm 2] :
Enlarge or reduce the height Colours Specify the start and end
of the copies Start |3 salmon = colours of the colour
End | salmen = \ gradient
J

Figure 4.79: Duplicating Objects

Grouping and Combining Objects When creating or editing an object, the object might be displaced from its original position.
This change in location disturbs the relative position of the object to the others in the drawing. This could be critical where
accuracy, in terms of position, is important such as in architectural drawings. Using Draw, you can combine drawing objects in
two distinct ways, grouping and combining.

Grouping Objects Grouping objects is like putting them into a container, where the objects are grouped with each other but
retain their individual identities. You can move the group as one entity and apply changes to all the enclosed objects. A group
can always be undone, and the objects that constitute the group can always be manipulated separately.

1. In the Drawing area, select all the objects you want to include in the group. Right click any selected object, and then select
the Group option.

2. Click any object in the group; handles appear around the entire group instead of around an object.

You can now modify the entire group, without applying effects to objects individually. To resize a group:

¢ Place the mouse cursor over one of the handles. When the cursor becomes a double-headed arrow, drag the cursor to increase
or decrease the size of the objects in the group. All the objects in the group are resized equally.

1. Double-click an object in the group. You can now enter the group and work on individual objects.

2. Click the object you want to edit; the handles appear around that object. In this mode, you can edit, add or delete this
object.

3. To re-instate the group after modifying the object, double-click anywhere outside the selection frame.

You can group objects of all shapes and sizes. You can group objects in 2D, 3D or a combination of both. However, you can
combine only overlapping 2D objects.

Combining Objects Combining drawing objects is similar to grouping, except that combining creates a permanent fusion of
objects, leading to the formation of a new object. The original objects are no longer available as individual entities, and you
cannot enter the group to edit the individual objects. When you combine the objects, the group takes on the properties of the
lower-most object in the arrangement.

1. In the drawing area, select multiple 2D objects. NOTE:

The lower-most object in the following graphic is the blue object.
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Figure 4.80: Combining Objects

2. Right-click any of the objects in the selection and click the Combine option in the list. Where the objects overlap, the
overlapping zone is either filled or empty, depending on the number of overlaps. When the number of overlaps is even,
you get an empty space. When the number of overlaps is odd, you get a filled area.

Figure 4.81: The Overlapping Zone

3. After you have combined the objects, you can select the combined objects as an entity. However, you will not be able to
select the empty area in the object.

TO SPLIT THE OBJECTS:

* In the Drawing area, right-click the combination created in the previous procedure and select the Split option from the list.

Figure 4.82: Splitting Objects

Note that the objects return to their original status. However, the properties of the objects have now changed as per the last
object in the arrangement.

Editing Colours and Textures When creating a drawing, you may need to work with objects of variable colours and textures in
the same drawing area. You can customise the area fill of an object by using the Line and Fill toolbar.

The OpenOffice.org term for the inside of an object is area fill. The area fill of an object can be of uniform colour, a gradient or
an image.

To edit the colour fill of an object:

1. In the drawing area, select the object you want to edit and click the Area button on the Line and Fill toolbar. The Area
dialogue box opens.
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Figure 4.83: Editing a Colour Fill

2. The Area dialogue box provides the option to change the existing colour fill of the object. Click the Colours tab, select a
colour listed under the Table category and click OK to apply the change.
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Figure 4.84: Selecting a Colour Fill

3. The Table category lists the standard colours or the colours that are used most often. However, if you need a colour or
shade that is not available in the list, go ahead and create it! To define a custom colour:

(a) Click the standard colour closest to your needs, and specify the RGB ratio to change its tone and hue. NOTE:
Draw provides you two options to define a colour. You can specify the colour in the RGB or CMYK ratio. For
CMYK, click RGB and then select CMYK from the options.

(b) If you want to add a new custom colour to the available list, type its name in the Name box, specify the RGB ratio
and click Add. The standard list under the Table category displays the new colour.

Nice to Know:
Every colour is specified by a combination of the three primary colours, Red, Green and Blue, hence the notation

RGB.

(c) Click OK to apply the change.
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Figure 4.85: The Customised Colour Fill

Editing a Gradient Fill A gradient is a smooth transition between two different colours or shades of the same colour, which you
can apply to a drawing object. To edit the gradient fill of an object:

In the Drawing area, select the object you want to edit and click the Area button on the Line and Fill toolbar. The Area dialogue
box opens.

Click the Gradients tab, select a gradient from the gradient list and click OK to apply the change to the object.

Figure 4.86: Editing a Gradient Fill

Editing Text Draw provides you the following options to insert text in the Drawing area:

* The Text tool on the Drawing toolbar: You can create a text frame anywhere in the drawing area, and you can work with this
text box like you do with any other object.

 Callouts next to the object: You can use this when you want to relate the text to the object. Click the Callouts tool on the
Drawing toolbar.

» Text superimposed on a drawing object: Double-click the object. A text box opens. Type the necessary text in it.

The following graphic displays various options for inserting text relevant to an object in the Drawing area:

Callout related to
the star

Star written using
the Text Tool

Figure 4.87: Editing Text in the Drawing Area

Visual Effects Apart from offering the basic drawing tools, Draw provides scope for you to add some visual effects to your
drawings.

Cross-Fading The cross-fading feature in Draw transforms one shape into another. The result is a new group of objects, including
the start and end objects and the intermediate shapes.
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1. Create two objects of different shapes in the drawing area and select them.

&
@

Figure 4.88: Applying Visual Effects

2. On the Edit menu, click the Cross-fading option to display the Cross-fading dialogue box.

3. In the Cross-fading dialogue box, select the number of incremental objects between the ends. Retain the default selection
for smoother transition, and click OK to display the result in the drawing area.

p
K7

Figure 4.89: Cross-Faded Objects

You can vary the order of the objects by changing their arrangement in the drawing area.

4.6 Using OpenOffice.org Math

Math is the equation writer component of OpenOffice.org office software suite. It contains a number of functions, operators and
formatting assistants to help you create properly formatted equations and formulae. These formulae can then be imported for
display in any other OpenOffice.org applications.

4.6.1 Key Features of OpenOffice.org Math

Note:
Some of the important features and capabilities of Math are discussed in the following section:
* Creating a Formula: Math offers you the convenience of creating formulae as objects within your document. You can invoke

Math from inside a document whenever you need to insert a formula or equation into the document. With Math, you have a
large selection of pre-defined symbols and functions at your disposal for creating, editing and formatting a formulae.

* Typing a Formula Directly: If you are familiar with the Math markup language, you can also type an equation directly in
your document and then invoke Math to convert the markup into a formatted formula.
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* Creating a Formula in the Commands Window: While you make entries in the commands window, you can simultaneously
view the results in the document.

* Creating Individual Symbols: Why not create or own symbols and import new characters from other fonts? You can add the
new symbols in the basic math catalogue or create a new catalogue for the new symbols.

* Creating Formulae in Context: Math provides you the ease of working with the context menus, which can be displayed at
a right mouse-click. These context menus contain all commands that are found on the Selection window. Moreover, you can
insert these into the document with just a mouse click.

Math is only used to create properly formatted equations in its symbolic form. It cannot be used for calculation purposes.

4.6.2 Creating and Editing Formulae
Though Math can be used with all the OpenOffice.org applications, it is primarily used as an equation editor with text documents.

1. Position the cursor on the document where you want to insert the formula. On the Insert menu, point to Object and then
click Formula.
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Figure 4.90: Launching Math

2. This invokes Math from inside the Writer window. Notice that the equation editor appears at the bottom of the document
window. You can now access all the Math tools from inside the Writer window. A placeholder box appears besides the
text where the equation is to be entered.

The simplest method to enter an equation in your document is to use the Selection window. By default, the Selection
window is not displayed. To display the Selection window, on the View menu, click Selection.
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Figure 4.91: Displaying the Selection Window

3. The Selection window appears as a floating toolbar. Notice that the Selection window is divided into two halves. The
upper half contains the symbol categories, and the lower half displays the symbols available in the selected category. You
can now start inserting the equation by selecting the symbols from the Selection window.

To insert a symbol, such as "a/b" select the appropriate category from the upper half and click the appropriate symbol from
the lower half of the Selection window.
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Figure 4.92: Using the Selection Window

4. You will notice that when you select the symbol on the Selection window, the markup for the selected symbol appears in
the equation editor. Simultaneously, some grey boxes appear in the main text body.
The <?> symbols appearing in the equation editor are placeholders where you need to enter the actual text or symbol
associated with your formula.
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Figure 4.93: Inserting Symbols

5. Asyou enter the required text or symbol into the placeholders, the grey boxes are simultaneously updated with the equation.
You can enter the rest of the equation in the same fashion.

6. Once you enter the complete equation using the Selection window, the equation appears as an object in your document
window and you can view the complete markup for the equation in the equation editor. Exit the formula editor by clicking
anywhere on the document body.
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Figure 4.94: The Inserted Equation

7. Once the formula is inserted in your document, you may want to modify it further. To edit a formula right-click once on it
and select Edit from the short-cut menu.
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Figure 4.95: Editing Equation

8. Now you can insert new symbols into your formula or delete ones you no longer need.

i & Selection X |
Lzl Algebra -‘J " D
o Tin 0sb A=A f(d 2
i1\ sk a
s Definition of division={ Z— x| 1| /
- V5! 5
= # Distributive prope riy= E———— d & (E) %
o~
| Geometry
= . +4 -a *a Fa -4 |
w0 Area of a circle= 5
= &9 Area of a rectangle= B
i a+b a-b axb axb arb 3
w | %
1] a-b % azb a/b avb
a over b=a times left({l over b right) ash

L

1 T > |

Figure 4.96: Inserting New Symbols

Though Greek characters are widely used in mathematical formulae, especially geometric formulae, these characters are
not available in either the Selection window or the Context menu.

10. You can enter Greek characters by typing the markup language for them in the equation editor. Alternatively, you can use

the Catalog window. To display the Catalog window, on the Tools menu, click Catalog.
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Figure 4.97: Launching the Catalogue Window

11. The Symbols dialogue box is displayed. Before selecting a character, ensure that Greek is selected under the Symbol set
drop-down window. Select the required Greek character from the Symbols window and click Insert.
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Figure 4.98: Inserting Greek Symbols

12. The character is inserted into your document and the markup is displayed in the equation editor. You can continue entering
formulas into your document following the same procedure. Once you have entered all the required formulae, your
document may appear like this:




Ubuntu Desktop Training
147 /348

File Edit View Format Tools Wi

i G pii) ._ v R W & K & e
el A, B8-S R « T Q.
L I ¥ 1, 2,3 4 5 6 7 8 9 1011 12 13 14 15 16 1f 18 | =
Equations
- =
Algehra
~
= _|a_ 1)
s #0 Definition of division= E-.aa|3‘|
5 g Distributive property= | &= (B+ci=a=b+asc
- Geometry
] —
& £ Area of a circle= [T 8 L=
@ Area of arectangle=" [z
~ g
4] [*]

EEIF ro(2]] =

1 I [+]

Figure 4.99: Final Equations

4.7 Additional Applications

4.7.1 GnuCash Accounting

GnuCash is an application that helps you track home or small business finances. Instead of tracking all your expenses on paper,
you can use GnuCash to ensure that you don’t lose any information at the end of the month. All details of income and expenditure
can be managed with this utility. Using GnuCash, a small business can track its customers as well as its vendors by entering their
details. You can also create a monthly profit/loss report for your business.

GnuCash can store and manage the details of all your bank accounts in one place. GnuCash is based on double-entry bookkeeping
(the sort that trained, professional accountants use) to ensure balanced accounts and accurate reports.

GnuCash is easy to use and can be tailored as per your needs.
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Figure 4.100: The GnuCash Accounting Application

Key Features of the GnuCash Application Using GnuCash is like filling your personal finance information in a register but in
a more organised way. The following features make GnuCash a very useful, powerful, yet flexible software programme:

» Easy-to-Use Interface: The interface of GnuCash is as simple to use as keeping records on a piece of paper. It also has a
Quick-Fill feature, which means that as soon as you type a few characters, GnuCash scans its list and completes the entry
automatically. If you use an entry on a regular basis, you don’t need to type it every time.

* Double Entry System: Following the principles of double-entry accounting, in GnuCash each transaction has to be mentioned
in two places -- debit in one account and credit in another. This means that the difference between income and expenses exactly
equals the sum of all assets and equity. This will help you verify that you have entered the details of the income and expenses
accurately, which, in turn, will also help you track all expenses.

* Reports: You can generate a vast range of reports using GnuCash. Home users can generate a Budget report, which will give
them a clear view of the income and expenses for the month. You can also generate a Tax report for calculating tax based
on tax-related income and expenses. A vast range of Business reports, such as Customer and Vendor reports, can also be
generated. Another report that can be generated is the Assets and Liabilities report, which includes the balance sheet.

* Multi-Currency Transaction Handling: You need not worry about transactions in different currencies; GnuCash automati-
cally handles currency conversions. In addition, GnuCash provides menus and pop-up windows in different languages.

* The Reconcile Window: GnuCash provides the Reconcile window, which contains the balances of all your accounts. As a
result, you don’t have to check the balances in various registers. Using this window, you can easily validate bank statements.

* Split Transactions: The split transaction feature allows you to split a transaction into multiple amounts and categories. For
example, you purchase a few things, which can be divided into different categories, from a store. Here, the main transaction
is the amount spent on the purchase of these items, and the split transaction consists of the entries of all the items on the split
transaction editor screen. You can re-check the main transaction at any time by simply displaying the split transaction entries.

* HBCI Support: GnuCash also supports the German Home Banking Computer Information (HBCI) protocol. This feature is
useful for German users who need not enter the details of their bank account manually. They can directly perform online bank
account transfers, download bank statements and make direct debits.

* Scheduled Transactions: Users can schedule transactions in GnuCash as per their requirements, and they can also set a
reminder for the transactions. This feature does not require you to remember which transaction needs to run at what time. The
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software will automatically keep track of the transaction and run the transaction at the scheduled time. You can also re-schedule
the transactions, when required.

Transaction Finder: The Transaction Finder dialogue box helps you locate even the smallest transaction. You can enter the
relevant fields in the Transaction Finder window, and GnuCash will find the transaction for you. For example, you want to
identify all expenses above a certain amount this month. GnuCash will be able to identify these transactions. You need to
mention the transaction as greater than and the amount in the amount field.

New User Manual and Help: GnuCash provides a new Tutorial and Concepts guide to give an overview of the accounting
principles to new users. This helps the users apply the principles effectively and gives them the exact procedure of each task.

48 L

In this les

esson Summary

son, you learned that:

* OpenOffice.org is the default office application suite provided with Ubuntu.

* The OpenOffice.org sofware suite contains five applications to help you handle your work effectively.

* Writer forms the word processor component of the OpenOffice.org office software suite and contains all the features that you
expect from a modern, fully equipped word processor.

e Calc fo

rms the spreadsheet component of the OpenOffice.org office software suite and offers a whole range of advanced

functions to help accomplish complex tasks.

 Impress is a fully featured presentation tool included in the OpenOffice.org office software suite.

e Math is

the equation writer component of OpenOffice.org office software suite.

* GnuCash is extremely useful application software for managing your home and/or small business finances.

4.9 Review Exercise

Question

Answer:

Question:

a) SWF
b) PDF
¢) ODF

Answer:

Question:

Answer:

Question:

Answer:

Question:

Answer:

Question:

Answer:

Question:

: List the applications included in the OpenOffice.org office software suite.

The applications in OpenOffice.org save files in which format, by default?

Name the equation editor component of the OpenOffice.org software suite.

Which software feature help you create multiple personalised form letters?

Which software feature in available OpenOffice.org helps you navigate inside your document?

Name the feature in the Openoffice.org software suite that allows you to perform a complete document makeover?

Do you require any additional software to convert a OpenOffice.org document into a PDF file?
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Answer:
Question: Name the software tool that guide you through the creation of a formula in OpenOffice.org Calc.
Answer:
Question: Math allows you to type your formula directly into the document if you are familiar with the ?
Answer:

Question: Name the feature available in OpenOffice.org Impress that allows you to create text
with stunning 3D effects?

Answer:

Question: Which feature of GnuCash helps you look for a transaction using a Query window?
1. Split transaction

2. Scheduled transaction

3. Transaction finder

4. Reconcile window

Answer:

4.10 Lab Exercise

Exercise 1: Performing BasicWord Processing Tasks Using Writer As an employee in an interior decorating company, you
have been asked to prepare an chapter on interior decoration that would feature in the company’s e-newlsetter. You have been
quite upbeat about the assignment as it would showcase your abilities to the fore. However, you will have to prepare the chapter
in the most aesthetically pleasing manner as possible. You plan to include lots of text, equally supported by some graphics and
tables all aligned to live up to the highly aesthetic sensibilities of the company employees.

To complete your assignment, you need to perform the following tasks:

¢ Create and format a text document
e Insert tables in the document
* insert images in the document

¢ Save the document

1. On the Applications menu, point to Office and then click OpenOffice.org Word Processor.

2. Enter the required text in the blank document.

3. On the Format menu, click Style and Formatting to display the Style and Formatting window.

On the Style and Formatting window, click a style category to reveal the various styles under that category.
Select the text on which you want to apply the style and formatting.

Double-click the desired style displayed in the Style and Formatting window to apply it on the selected text.

N o »nos

Repeat the same procedure to apply different styles and formatting for different components of the document.

You have created and formatted your document according to your requirements.

1. Position the cursor at the appropriate location in the document where you want to insert the table.

2. On the Table menu, point to Insert and then click Table
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3. Specify the table properties and click OK.
4. To display the Table Format dialogue box, right-click the inserted table and select Table from the short-cut menu.

5. Define the table specifications per your requirements and preferences in the Table Format dialogue box and click OK to
apply the changes.

You have successfully inserted tables in your text document. You can now populate the tables with the required data.

1. Position the cursor at the appropriate location in the document where you want the picture to be inserted.
2. On the Insert menu, point to Picture, then click From File.

3. In the Insert Picture dialogue box, navigate to the desired file, select the file and then, click Open.

b

To resize the inserted image, select the image, then press and hold the SHIFT key.
Holding down the SHIFT key, click and drag one of the handles on the image to modify its size.
To arrange and align the image properly, right-click the image, then select from the available options on the short-cut menu.

Define the appropriate positioning options for the image.

e N w

The image is now inserted properly into your text document.

—_

On the File menu click Save As.
In the Save dialogue box, Navigate to the directory where you want to save the file.
Enter the file name in the Name field.

Specify the file type by selecting from the drop-down menu at the bottom of the dialogue box.

A

Click Save to save the file.

You have successfully saved your document at the desired location.

Exercise 2: Performing Basic Spreadsheet Tasks Using Calc As the accounts manager for your company, you are assigned
with the task of preparing the quarterly accounts report for the company. You have been suddenly burdened with the task of
collating a huge amount of data, analyzing the data to derive the required reports, present the data before the management and
generate the reports in PDF format for documentation and future reference. In order to accomplish this feat, you shall have to
perform the following tasks:

* Entering and format the data in a spreadsheet
* Apply formulas and functions on the data
* Present the data graphically

¢ Generate the report in PDF format
To enter and format the data in a spreadsheet:

* On the Applications menu, point to Office and then click OpenOffice.org Spreadsheet to open a Calc spreadsheet.
* Enter the required data in the spreadsheet.
* To apply desired formatting to a selected range of cells, on the Format menu, click Cells.

* The Format Cells dialogue box is displayed. Use the various options available under the Font, Font Effects and Alignment
tabs to specify various formatting attributes for the selected text.

* Click OKk to apply the formatting effects.

* To apply Autoformat to a sheet or selected cell range, on the Format menu, click Autoformat.
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 To assign a preset format to the selected cells, select one from the Format list and then click OK to apply the selected format
on the selection.

You have successfully entered your data in a spreadsheet and applied the desired formatting to it.
To apply formulas and functions on the data:

* Select the cell in your spreadsheet where you want the formula to be inserted.
* To create and apply a formula or function with the help of Function Wizard, click Function Wizard on the Formula Bar.

* Select the desired function category from the Category drop-down list to display the functions listed under that specific
category.

* Find the desired function from the Functions list and click it once to select it.
* Click Next to proceed with the task of entering a formula.

* To specify the cell range on which you want to apply the formula, click the Shrink button. This shrinks the FunctionWizard
dialogue box and you are returned to the main spreadsheet window.

* Select the cell range containing the desired data.
* After selecting the cells, go back to the Function Wizard by clicking the Maximize button.
* To complete the task of entering a formula, click OK.

You have successfully applied a formula on the data. The solution appears in the cell where you had applied the formula.

To present your data graphically:

On the Insert menu, select Chart.

 Define the data range, the labels and the target sheet where the chart would be displayed

¢ Click Next to continue.

* Select the chart type and click Next to continue with the procedure of inserting charts.

* Specify a variant for the selected graph type and click Next to continue

* Specify the main title for your chart and title and labels for the axes. After specifying the required information, click Create.

* A chart is inserted at the specified location in your spreadsheet. You have successfully displayed your data in the form of a
chart.

To generate a PDF file of the report:

* On the File menu, click Export as PDF.

* Enter a file name in the Name field on the Export dialogue box
» Navigate to the directory where you want to save the file.

* Click Save to continue.

* Define the desired options on the PDF Options dialogue box, then click OK.

You have successfully exported your spreadsheet as a PDF file.

Exercise 3: Creating Multimedia Presentation Using Impress In your job profile as a trainer in an architecture firm, you are
required to develop a presentation on architectural designs and plans, which shall be used as training material for the new joins.
You want your training material to effectively demonstrate all the dimensional details of your architectural designs, which may
include floor plans, elevations and siteplans. You would also like to infuse some life into your presentation by adding animations
wherever required. Finally, you want to convert the presentation into a Flash file for easy future reference.

To accomplish the task, you will need to:
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* Create a presentation with the required text and images
* Add 3D graphics and animations in the presentation
* Configure and perform a slide show

» Export the presentation as a Flash file
To create a presentation with the required text and images:

* On the Applications menu, point to Office and then click OpenOffice.org Presentation.

* The Presentation Wizard dialogue box appears. To create a new blank presentation, retain the default selection and click
Next.

* Select the slide design and output medium for the presentation and click Next.
* Define the transition effect to be applied on the slides and click Create to proceed.
 Select a layout for your current slide from the Task pane on the left.

 Enter the required text in the provided textboxes to create the first slide, then click Master Pages to open the Master Pages
panel.

* Click once on the template of your choice to apply it to your presentation.
* Insert a new slide by clicking the Slide button on the Standard toolbar.

* Select a layout for the new slide.

* Enter the required text in the provided text box.

* To insert a picture in the presentation, on the Insert menu, click Picture.

¢ In the Insert Picture dialogue box, select the desired image and click Open to insert it.

Follow the same procedure to create the rest of the slides.
You have successfully created a presentation with the required text and images.

To add 3D graphics and animations:

» To render special 3D effects to a piece of text, on the Drawing toolbar, click the Fontwork Gallery button.
* Select the style in which you want the text to be displayed and click OK.

* Double-click the Fontwork object.

* Type the required text in place of the black * Fontwork’ that appears over the object.

* Click once outside the object’s selected area to exit the Fontwork edit mode.

* To display the 3D-Objects toolbar, on the View menu, point to Toolbars and then select 3D-Objects.

* To insert a 3D-Object in your current slide, click the desired object on the 3D-Objects toolbar.

* Then move your mouse to the point where you want to insert the object.

* Holing down the left mouse button drag the mouse to insert the object on the slide.

* Change the proportion and size of the object by holding down the green handles.

* To apply 3D effects on the inserted graphic, right-click the object. On the short-cut menu, click 3D Effects.
* Define the look and feel of the inserted object by selecting appropriate options in the 3D Effects dialogue box.

 After defining the options, click the Assign icon on top right of the 3D Effects dialogue box.
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Click Close to exit the 3D Effects dialogue box.
* To add animations, to the various elements in your presentation, on the Slide Show menu, click Custom Animation.
* Select an element and click the Add button on the Custom Animation panel to display the Custom Animation dialogue box.

 After defining all the desired settings for the object, click OK to apply the animation effects.
Your have successfully added 3D graphics and animations in your presentation.

* To configure and perform a slide show:
* On the Slide Show menu, select Slide Show Settings.
* Select the desired options on the Slide Show dialogue box and click OK to apply the settings.

* To start the slide show, select Slide Show from the Slide Show menu or press FS5.

Your presentation runs as a lively slide show.
To export the presentation as a Flash file:

¢ On the File menu, click Export.
* Specify a file name in the File name field and navigate to the directory where you want to export the file.
* To export the presentation as a Flash file, select Macromedia Flash (SWF) (.swf) from the File format drop-down list.

* Click Save to export the file at the desired location.

The file is exported at the indicated location. You can now view the presentation as an SWF file.

Exercise 4: Creating Formulae Using Math In your role as a high school mathematics teacher, you need to create a mathematics
test paper that also contains geometrical and arithmetical equations. You have to find a way to display the mathematical equations
properly in the text document.

Solution:

¢ Position the cursor on the document where you want to insert the formula.

* On the Insert menu, point to Object and then click Formula. The Equation editor appears at the bottom of the document
window.

* To display the Selection window, on the View menu, click Selection.

* Start inserting the formula by selecting a symbol from the Selection window.

* Enter the required text in the placeholders that appear in the equation editor.

* Follow the same procedure to enter the rest of the equation.

¢ Click anywhere on the document body to exit the equation editor.

* To insert some formulas containing Greek characters, display the Catalog window by selecting it from the Tools menu.
* Ensure that Greek is selected under the Symbol set drop-down window.

* Select the required Greek symbol from the Symbols window and click Insert.

* Follow the same procedure to enter the rest of the formula.
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Chapter 5

Ubuntu and Games

OBIJECTIVES

* Find and install games on Ubuntu
* Play some of the more popular Ubuntu games

* Configure other games

5.1 Installing Games on Ubuntu

Note:

The default installation package of Ubuntu 8.04 LTS comes with 17 Ubuntu games, including Aisleriot, Solitaire, Gnometris and
Mines. In addition, you can install many games from other repositories.

Enabling a repository is a one-time task. You do not have to enable the repositories every time before installing software.

5.1.1 Installing a Game from a Repository

Add/Remove Applications>and Synaptic Package Manager are the Graphical User Interfaces (GUI) that enables you to install
applications from the Ubuntu repositories. However, using Add/Remove Applications is the easiest way to install a game on
your computer.

1. On the Applications menu, select Add/Remove.

‘* B s
| 43 Applications | Places ~ System @ @
Y Accessories »

[} Games
_l_" Graphics »
&) Internet
Il office »
B3 sound & video  »

@ AddjRemove. ..

Install and remove applications

Figure 5.1: Launching Add/Remove

2. In the Add/Remove Applications window, select Games from the left pane of the window to display a list of games in

the top section of the right pane, along with the popularity of each game among users. The bottom section in the right pane
displays a brief description of the game selected.
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A show: |installed applications only  + | search: | 4
[iY Accessories z
- Application ~ | Popularity

e

@J Résisaien ¥ E‘ AisleRiot Selitaire ok ok ko
(s2) Games ‘ Play many different solitaire games

sl Blackjack

A Graphics ey Play the casino card game Blackjack * ok ok ok ok

(e Internet o Chess

&

=t B a5 e Famslevic sty Honrdcarels o e %k ok
[l office =

i " =]
5 other ) . - 3|
| || | ® AisleRiot Solitaire
| £ programming |
|
i Sound & Video games for the GNOME desktop & &
These are the games from the official GNGME release. They have the
{5} System Tools look and feel of the GNOME desktop, but can be used without it
@ uriversal Access The package contains the following games =

* sisleriot - different solitaire card games
* blackjack - the casino card game
*glchess - chess game with 3D graphics
*glines - color lines game, aka fiveormore

# grect - four in a row game

| | * anibbles - snake garme, up to four players

| @eep Qcancel || 2ol

(4]

Figure 5.2: Add/Remove Applications window

3. The right pane, by default, displays the games supported by Canonical Limited. To change the list of games, click Sup-
ported Applications and select the appropriate option from the drop-down list.

(s
i-{: All Show: | All available applications _ Search: | gl
E& RECE S = show all applications including ones which are
| = Ap possibly restricted by law or copyright,
]1’4‘;;] Education == _ unsupported by Canonical Ltd. or not part of
e [7] 208 Supported applications Ubuntu
! Games i |
LJJ ‘] Third party applications r
‘.‘i Graphics [ g * ok
E;J' T O \nsEa\Ied applications only | e
St “T° A guess-the-number game, aka Bulls and Cows
M office L
g — =N — oy
L5 other —
’ e 20,000 Light Years Into Space
" Programming TEARS
m S5und & Vidao single player real-time strategy game with steampunk sci-fi L
You have to build and maintain a steam distribution network on an alien
197 System Tools planet, while under attack from aliens and other hazards, The game has

three difficulty levels, an interactive tutorial, and a scoring system.
20,000 Light Years Inte Space" is written in Python using pygame and it

was rewarded with the second place in the Pyweek March 2006 Individual
Entries category.

@ Universal Access

This application is provided by the Ubuntu community.
Homepage: http /fwww jwhitham.org uk/biscuit_garmes/LightYears/

(0 o |

(€|

Figure 5.3: Changing List Option

4. You can navigate through the list of games or search a game by its name. To initiate a search, type the name of the game
in the Search box and press Enter. The top section of the right pane displays the search results. Select the check box next
to the game to mark it for installation and click Apply Changes. A dialogue box opens, which requires confirmation to
proceed with the installation.
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45 An

|ﬁl{’ Accessories
e

ijj;y Education
!Eﬂ Games

‘41 Graphics
;\3) Internet

|@ office

| g Other

f Programming
Im Sound & Video
;i_f_\J System Tools

:@ Universal Access

Show: |AH available applications - Search: |Frozen-Bubble| i

Application Popularity

im Frozen-Bubble & &k ok

Pop-out the bubbles |

E] Frozen-Bubble

Pop out the bubbles! v

Frozen-Bubble is a clone of the popular "Puzzle Bobble" game, in which you
attempt to shoot bubbles into groups of the same color to cause themn to
pop. It features 100 single-player levels, a two-player mode, music and
striking graphics.

This game is widely rumored to be responsible for delaying the Woody
release.

URL: http:/iwww.frozen-bubble.orgl

This application is provided by the Ubuntu community.

ogancel p

NOTE:

Figure 5.4: Searching a Game

The search result is dependent on the display mode selected in the previous step. To widen the scope of search, select All
Available Applications in the Show drop-down list.

Nice to Know:

To remove a game from your computer, clear the check box next to that game and click Apply Changes.

5. In the confirmation dialogue box, click Apply to proceed with the installation or click Cancel to return to the Add/Remove

Applications window.

@

. i

Apply the following changes?

Please take a final lookthrough the list of applications that
will be installed or removed.

Add

? Frozen-Bubble
Pop out the bubbles |

Figure 5.5: Confirming Changes

6. After the installation is complete, a dialogue box confirms the installation and provides the option to start the installed
game, return to the Add/Remove Applications window or close it. Select the appropriate option in the dialogue box.
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" New application has been installed

L%
8 To start a newly installed application double click on it.

Frozen-Bubble
Pop out the bubbles |

agluse

[ﬂdd[Remove More Applications

Figure 5.6: Dialogue Box Confirming Installation

7. To launch the installed game from the desktop, point to Games on the Applications menu and click the name of the game.

ghpphcahons_ Places System “ Q

LY, Accessories »

€3 all %4 Mon Dec 15, 8:aa e [8] Wiliam windsor

[+2) Games v [ Aisteriot solitaire

A% Graphics b “\'ﬁ Blackjack
&) Intemet +| o Chess
[ office »| 8 Five or More

B0 Sound & video v @2 Fourin-a-Row
T/ Freecell solitaira
m Frozen-Bubble
B crometns

[ff_‘ AddRemave..

.. laghe

&5 Klotsk

&l Mahjongg
ﬂ Mines

“'& Nibbles

& Robots

28 same Grome
P2 sudoky
£ mii

B merravex

Figure 5.7: Launching a Game

Let’s play!

5.2 Playing Ubuntu Games

Note:

Playing a game on Ubuntu is no different than playing it on any other Graphical User Interface (GUI)-based operating system.
There are no pre-requisites to play these games and the real fun is in exploring these games yourself.

Ensure that you have hardware-accelerated 3D drivers installed for your video card.

5.2.1 Playing Frozen-Bubble

Note:

In Frozen-Bubble, you attempt to shoot bubbles into groups of the same colour to cause them to pop. Frozen-Bubble is a clone
of the popular Puzzle Bobble game and features 100 single-player levels, two-player mode, music and striking graphics. You can
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play this game with another player on your Local Area Network (LAN) or invite a player on the Internet to play. Frozen-Bubble
is not in the list of default games so you should install it from the Universe repository.

This game does not have the option to turn off the sound. Therefore, if you are playing this game at your workplace and do not
want other people to know, ensure that the speakers are turned off before launching this game.

1. On the Applications menu, point to Games and click Frozen-Bubble to launch the game.

€3 all %4 Mon Dec 15, 5:02 o [ Willam windsar

) Applications Plsces System (@)~ @

LY Accessories

o Ga ol [ isteriat sl
[+ Games ![-, isleRict Solitaire
A% Graphics v [ Blackjack

) ntemet v o chess

gl office »| 3o Fve or More

Bg sound & videa  » @ Fourin-a-Row
[ Frescell solitaira

[EA Frozen-subble

E Gnometns

#g lagno

(15} Addimemave,

Pop out the bubbles |

=5 Klotski

i Mahjongg
4o Mines
§a, Nibbles
& robots
83 same criome
k2 sudoku

&9 Tl
B Tetravex

Figure 5.8: Launching Frozen-Bubble

2. The Frozen-Bubble 2 window lists options to select the playing mode, customise the levels, change the resolution of the
graphics, specify the keys on your keyboard with which you want to play this game or view the high scores list.

Figure 5.9: Frozen-Bubble Main Menu

3. To start playing the game in single player mode, select START 1P GAMe and press Enter to display the Start 1- player
game menu. Select PLAY DEFAULT LEVEL SeT and press Enter to launch Level 1 of the game.
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Figure 5.10: Single Player Game Menu

NOTE:

Use the up or down arrow keys to navigate through the options.

4. The aim of the game is to prevent the bubbles from reaching the penguin next to the igloo. At the start of the game, you
will see an arrangement of coloured bubbles on the window, a bubble gun that contains a bubble, and a pointer. Use the
left and right arrow keys to change the direction of the pointer and the space bar to fire the bubble. To pop the bubbles, you
should hit at least three bubbles of the same colour. If the fired bubble hits a bubble of a different colour, it sticks to that
bubble and is added to the arrangement.

Figure 5.11: Playing Window

5. You have to fire the bubble from the bubble gun within seven seconds of firing the previous one; otherwise, a Hurry
warning flashes three times and the bubble gun fires the bubble automatically. The bubble appearing in the igloo window
is the next bubble to appear in the gun.

Figure 5.12: Flashing Hurry Warning

To add to the plight of the poor penguin, FB-01 and FB-02 keep pushing the plank towards the penguin, reducing the area
for the bubble arrangement.
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6. If you succeed in popping all the bubbles, you win! You can then press any key to proceed to the next level.

A
- 7% \BOIe
: o o
£ M =

- .' ==

Figure 5.13: Displaying Level Results

NOTE:
Press the ESC key to go back to the previous window or close the application.
7. If you leave the game after achieving a high score, type your name in the window that opens and press Enter to display

the high score listings. In the list, you can view the level you reached and the time taken to reach that level. Press ESC to
return to the main menu.
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Figure 5.14: High Score Windows

If you do not like the pre-defined arrangement of the bubbles, you can create your own arrangement by selecting Level editor
from the main menu.

5.2.2 Playing PlanetPenguin Racer

PlanetPenguin Racer, also called ppracer, is a simple racing game featuring Tux, the Linux mascot. This game is based on the

popular Linux game Tux Racer. The goal of the game is to slide down a snow and ice covered mountain as quickly as possible,
avoiding the trees and rocks that will slow you down.

1. Install the planetpenguin-racer package from the Universe repository.

2. On the Applications menu, point to Games and click Planet Penguin Racer to launch the game.
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Figure 5.15: Launching PlanetPenguin Racer

3. Press any key on the keyboard to proceed to the next window.
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PRESS ANY KEY TO START.

o

Figure 5.16: Starting Window

4. The next window displays the main menu of the game. Click the options on this menu to take part in a racing event,
practise before entering any event, configure the game settings, view credits and quit the game.
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Enter an‘event
Practice
Configuration
Credits
Quit

Figure 5.17: Entering an Event

5. You can play this game by using a computer keyboard or a joystick. On the main menu, click Configuration and then
click Keyboard or Joystick to know their default key settings. You can also change the key settings according to your
preferences. Click Back to return to the main menu.

Configuration

Graphics
Video

Audio

G ybogd
Joysticl

Back

Figure 5.18: Configuration Options

6. On the main menu, click Enter an Event, select the event and the cup in which you want to participate and then click
Continue to proceed.
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Select event and cup

Event:

Herring Run

Cup:

Canadian Cup
) axi

Figure 5.19: Selecting Event and Cup

7. The next window prompts you to select a race. As a beginner, you do not have any option but to continue with the default
race. However, do read the Needed to advance information to know the minimum requirement to qualify for the next
round in the cup.

8. Click Race! to start the race.

Select a race

inny Hill

Use clever fur
Bunny Hill

ed by: Unknown

Figure 5.20: Selecting a Race
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9. The next window starts the race. The intent of the game is to make Tux reach the Finish line, collecting herrings on the
way. If you succeed in reaching the Finish line within the parameters mentioned in Needed to advance, you proceed to
the next round; otherwise, you have to play the round again. There are four attempts or lives that you get to compete in an
event. If you fail to satisfy the wining criteria, one life is deducted.

Figure 5.21: Playing PlanetPenguin Racer

You can win the cups only by practising and focusing on improving your performance.

5.3 Playing Other Popular Games

In addition to all the games available in Ubuntu, you can play games created for Microsoft Windows. However, to do so, you
need the ability to run Windows applications in Ubuntu. One of the programmes that provides this ability is named Wine.

5.3.1 Installing Wine

1. Install the wine and wine-dev packages from Synaptic Package Manager.
2. The configuration of wine can be altered through Applications, Wine, Configure Wine.
3. This window allows you to customise a variety of settings for Wine, such as the Microsoft Windows version that is being

simulated, drive mappings, as well as application-specific settings. Click OK to close the window.

Install the wine and wine-dev packages from Synaptic Package Manager.

Wine is configured on your computer with an artificial C: drive. You can now access many Microsoft Windows application on
Ubuntu.

5.3.2 Playing a Microsoft Windows Game on Ubuntu

A Microsoft Windows executable file can be started with Wine through right-click, Open with "Wine Windows Emulator".

If you install a Microsoft Windows application with Wine, an icon may be found in Applications, Other.
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5.4 Lesson Summary

In this lesson, you learned that:

* You can install and play many games available by default on Ubuntu and in repositories.
* You can install games by using the Add/Remove Applications or Synaptic Package Manager.

* You can play Microsoft Windows games on Ubuntu by installing a programme that provides a Microsoft Windows environment,
such as Wine.

5.5 Review Exercise

Intentionally left blank.

5.6 Lab Exercise

Exercise 1: Installing a game on Ubuntu During a recent get together with your friends, you heard a lot of good things about
a game that they play on their Linux operating system. You wish to play the same game, but you cannot find that game in the
games package that got installed with Ubuntu. What do you need to do in order to play this game on your computer?

1. On the System menu, point to Administration and click Software Sources to display the Software Sources dialogue
box.

2. On the Software Sources dialogue box, select the check boxes next to main and universe options. Retain the Main server
option in the Download from category and clear the CDrom check box.

3. Click Close to display a prompt and then click Reload on the prompt to update the list of applications available.
4. To install the game, select Add/Remove on the Applications menu to display the Add/Remove Applications window.

5. Select Games in the left pane of the window, change the Show list option to All Open Source Applications, type the
name of the game in the Search box and press Enter.

6. Select the check box next to the game to mark it for installation and click Apply Changes.
7. On the confirmation dialogue box, click Apply to proceed.

8. After the installation of the game is complete, a dialogue box confirms the installation and provides the option to launch
the installed game. Double-click the name of the game to launch it. Alternatively, you can close this dialogue box and
launch the game by using the Applications menu on the desktop.

Exercise 2: Installing Wine and playing a Microsoft Windows game on Ubuntu You were browsing the Web one day and

came across an interesting game. You downloaded it and every thing seemed fine until you realise that the game could be played

only on Microsoft Windows, which is not installed on your computer. You really liked the game, how do you play this on Ubuntu?
1. Install wine and wine-dev packages from Synaptic Package Manager.

2. Open the games setup tool with Wine.

3. Start the games from the Applications menu.
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Chapter 6

Customising the Desktop and Applications

OBIJECTIVES

* Customise the look and feel of the Ubuntu desktop

* Work with the Nautilus file manager

* Add and remove applications

* Identify the types of single package files and their use

* Install and uninstall Debian packages

Identify the categories of software repositories

* Add extra repositories

6.1 Introduction

The Ubuntu desktop comes completely clean and free of pre-determined icons and buttons. Customising your desktop allows
you to add icons to suit your work style.

In this lesson, you will learn about various ways to set up your Ubuntu desktop to suit your requirements. You will also learn
how to install and uninstall various software applications.

6.2 Customising the Desktop

Note:
Ubuntu and its derivatives can be customised through a Graphical User Interface or a Command Line Interface.

The graphical tools to customize the desktop are available as menu options in the System menu. Point to Preferences on the
System menu to view the tools.

The System - Preferences menu enables users to customise their own desktop environment but not that of other users on the same
computer. In contrast, applications on the System - Administration menu will make changes to the computer that will affect all
users.
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6.2.1 Changing the Background

The desktop background is the image or colour applied to your desktop.

1. On the System menu, point to Preferences and then click Appearance. The Appearance Preferences dialogue box
opens.

1@

% Preferences v‘ ﬂ About Me

lications Places System

42y Administration , |ii Appearance |
@ AssiJCustomize the look of the desktop

0 Help and Support
‘€ About GNOME
Q About Ubuntu

Quit...

D Bazaar Preferences
Bluetooth

H Default Printer

| . Encryption and Keyrings
== Keyboard

= Keyboard Shortcuts

? Main Menu

) Mouse

g} Netwark Proxy
PalmOS Devices

% Power Management
jl' Preferred Applications
Remote Desktop

@ Remowvable Drives and Media

)

[J] sciM Input Method Setup
I@ Screen Resolution

'3':_#% Search and Indexing
Sessions

G Sound

= Windows

Figure 6.1: Launching Appearance Preferences Dialogue Box

Nice to Know:
You can also right-click the desktop and select Change Desktop Background to open the Appearance Preferences
dialogue box.

2. In the Appearance Preferences dialogue box, select a desktop wallpaper from the available wallpapers. The background
changes immediately.
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Wallpaper

Style: | Zoom

Colors

Therme | Background | Fonts ]I Interface l\fisual Effects

[ b Add...‘ | = Bemove‘

[Solid colar

:]

]

=

‘ Eglose

Figure 6.2: Changing the Desktop Wallpaper

Nice to Know:

To view the name of the wallpaper, move the pointer over its name.

3. Click Close in the Appearance Preferences dialogue box to apply the changes.

23 Applications Places System

@0

] i Tue Dec 16, 412 P [8] William Windsor

Figure 6.3: Applying Preference Change
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In addition to the wallpapers available with Ubuntu, you can download wallpapers from other sources and add them to the
available wallpapers list in the Appearance Preferences dialogue box. To do this:

1. Open the Web site http://art.gnome.org/ and click Backgrounds.

Fle Edit Wiew History Bookmarks Tools Help

= - & & [ € [hupartgnome org/ M [ ~] @r]ceoge @)

[&] Most Visited~  @»Getting Started [5|Latest Headlines ~

&/ i

GNOME~  About GNOME - Download - Users - Art & Themes - Developers + Foundation - Contact

Art.gnome.org -
Artwork and Themes for the GNOME desktop -

welcome to art.gnome.org - a place for high quality artwork and themes for the GNOME desktop. All

% News
themes and artwork on art.gnome.org are tested and moderated (see the Submission Policy) to ensure 4 FAQ
a high standard of quality and to make certain they work with your GNOME desktop. . Tutorials
[G] Latest News 2 ;"""mf‘h 1 7
Help us with future Art.Gnome.org version creenshots

Search..,

Latest Updates Top Rated = =

The most recent additions to art.gnome.org The top rated items on art.gnome.org = Advanced Search

| | red-o-splash | | Drops Il
Backgrounds - Abstract | } Backgrounds - GNOME
20 Octaber 2008 | | 7 september 2008
| B o cominents | | ewaeed 7comments =] Backgrounds
| Linux. Join the [ Contact 5 g:ﬂf
Revolution! Backgrounds - GNOME Y Abstract
Backgrounds - Other 4 Octaber 2008 o Cikes
20 Octaber 2008 L = @ e wE 5 comments

(2 2 comments

(I

Done

Figure 6.4: Opening Wallpaper Source

2. Download the wallpaper of your choice. During the download, you can view the screen resolutions available for the
selected wallpaper. You should download and save the version of your chosen wallpaper that matches the screen resolution
of your computer.

3. On the System menu, point to Preferences and then click Appearance. The Appearance Preferences dialogue box
opens.

4. Click the Background tab and then click Add. The Add Wallpaper dialogue box opens.

Theme | Background |Funts } Interface } Visual Effects

Wallpaper

Style: | Zoom - b Add.. | == Rarmove
Colors

Solid color S |

(7 J=E1 ‘ Eglose |

Figure 6.5: Adding a New Wallpaper
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5. In the Add Wallpaper dialogue box, select the downloaded image and click Open.

(i

Places Name ~ | Modified -

|& search | | NATURE-AutumnLeaves 1600x1200jpg  Today at 16:18
@ Recently Used
58 williamwindsor
& Desktop

L File System
= backgrounds
L Pictures

[ Documents

(&5 Music

(& videos

| ‘ ‘ Images | 3 ‘

Figure 6.6: Selecting Downloaded Wallpaper

This step adds the image as new wallpaper.

6. Click Close in the Appearance Preferences dialogue box to accept the changes. You can now view the new desktop
background.

ail] 4 Tue Dec 15, 4:20 pM (@] willam windsor

-quphCE‘llol'IS Places System C, @9

#
-

Figure 6.7: Added Wallpaper

Nice to know:

You can, of course, use a picture from any other source to use as your desktop background. Many popular online photo
collaboration sites allow visitors to download and use their content for personal use. Many people also use their own digital
photographs as backgrounds.
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To change the colour of the background:

1. On the System menu, point to Preferences and then click Appearance to open the Appearance Preferences dialogue
box.

2. Click the Background tab and select the wallpaper No Wallpaper. You can only view colours if you have not set any
desktop wallpaper.

There | Background | Fonts I Interface }\.’\sua\ Effects |

Wallpaper

MNo Wallpaper - -

Style: | Zddry = | #Add‘..|
Colors

Figure 6.8: Changing Background Colour

3. The Colours box provides three types of background: Solid colour, Horizontal gradient and Vertical gradient. Select
the desktop colour of your choice and then click the colour chip next to the Colours box. The Pick a Colour dialogue box
opens.

Theme | Background | Fonts } Interface IV\suaI Effects |

Wallpaper

Style: | Zoom = ok Add...| | == Remove |
Colors

Herizontal gradient | = | | [N | | I
=

Figure 6.9: Selecting a colour Option

4. Select a colour or the attributes of a colour such as hue and saturation to create a colour of your choice. Click OK. The
desktop reflects the new settings immediately.
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T Picica CoTonT |

Hue: Red: 205

Graen:
Blue: E

Saturation:

WYalue:

£ 2
i) 17 G

Colour name; | #CDF571

CED e

Figure 6.10: Specifying Colour

5. Click Clese to close the Appearance Preferences dialogue box.

Applications  Places  System (@)= @

4 Tue Dec 16, 8:10 PM il William Windsor

Figure 6.11: Changed Background Colour

6.2.2 Customising the Theme (Buttons & icons etc)

The desktop theme controls the visual appearance of the buttons, scroll bars, icons, panels, borders etc. A number of themes are
provided with Ubuntu.

1. On the System menu, point to Preferences and click Appearance. The Appearance Preferences dialogue box opens.

2. On the Theme tab, select the theme of your choice. The desktop reflects the theme automatically. To customise your theme
further, click Customise. The Customise Theme dialogue box opens.
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High Contrast Inverse  High Contrast Large
Print Inverse

Human Human-Clearlooks Human-Murrine

:_—;},?Cgstom\ze...H i:‘;]lhstal\m |

‘ gﬂelp ‘ ‘ lense ‘

Figure 6.12: Customising Desktop Theme

3. The default selection is Controls tab. The setting on the Controls tabbed page defines the visual appearance of windows,
panels and applets. Select a control from the Controls list. You will see an immediate change in the appearance of the
open windows. NOTE:

You can customise the following objects on the screen:

Window: A rectangular area of the screen with a border and a title bar at the top. All graphical applications run inside
windows.

Panel: An area on the desktop from where you can access information such as date and time. You can also launch
applications and add or remove objects from panels. The Ubuntu desktop contains two panels, the top edge panel at the
top of the screen and the bottom edge panel at the bottom of the screen.

Applet: A small application whose user interface resides within a panel.

Window Border: The border that appears around windows. It has a frame at the top of the window that contains the name
of the application and the edges that allow you to resize the window.

Icon: A graphical symbol for the applications and options on the panels and windows.

Similarly, you can customise the background and text colour of your windows, input boxes and selected items by config-
uring the settings on the Colours tab.

If you want to customise your window borders and icons, click the Window Border and Icons tabs in the Customise
Theme dialogue box. NOTE:

Ubuntu provides additional options to customise your themes. You can download more controls, window borders and
icons from the Web site http://art.gnome.org and save it at any location on your computer. While customising the theme,
click Install in the Appearance Preferences dialogue box. The Select Theme dialogue box opens, and you can select the
downloaded objects.
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Controls !t:alurs |Wihdnw'Burder | lcons | Pointer‘
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oo @ ® Human
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"-';iJQPan. v @ Industrial
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-
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Figure 6.13: Selecting Theme Controls

4. Click Close in the Customise Theme dialogue box. To save the theme, click Save As in the Appearance Preferences
dialogue box. The Save Theme As dialogue box opens.

B

Ne @

Clearlooks Crux

Glider Glossy High Contrast Inverse

';-:l:'ga\ete [P save As... ‘ @Cgstumlze... | Elnstal\‘.. ‘

@ telp ‘ fid close

Figure 6.14: Saving a Modified Theme

5. Provide a name for the theme in the Name box and a description, if you want, in the Description box. Click Save.
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Name: New Custom Theme

Description:

[ save background image

Qo [T

Figure 6.15: Specifying Theme Name and Description

6. In the Appearance Preferences dialogue box, click Close.

If you open a menu or window, you can see the changes in their appearance.

Calculator Edit \View Help
0
Bk5p| CE ‘ clr | + ‘
A LI I
2| IEN e
S NI T
o || =] + |
Activated expression mode with oper...

Figure 6.16: Viewing an Application in a Modified Theme

You can also download other Ubuntu-compatible themes from Ubuntu’s recommended source. To install these themes:

1. Open the Web site(http://art.gnome.org/) and click DesktopThemes.
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Figure 6.17: Opening Theme Source

4. On the Theme tab, click Install. The Select Theme dialogue box opens.

Custom

B

M ® —

| [ ;ﬁsave As... ‘ [ @Cgslumisa.”

| "ruz‘lnsta\lm

L] (4]

Eglusa

Figure 6.18: Installing a New Theme

5. Select the downloaded theme and click Open.

2. Download a theme of your choice. Select any theme and follow the instructions as they appear.

3. On the System menu, point to Preferences and click Appearance. The Appearance Preferences dialogue box opens.
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Figure 6.19: Selecting the Downloaded Theme

6. You can apply a new theme or retain the current theme. Click Apply New Theme to apply the new theme. The screen will
reflect the new theme immediately.

fj The theme "BlueHeart" has been installed.

o Would you like to apply it now, or keep your current theme?

‘ Keep Current Therme

l Q’/ Apply New Therme

Figure 6.20: Applying New Theme

7. Click Close in the Appearance Preferences dialogue box.

If you open any menu or window, it will reflect the selected theme.

Eopen

vie mm

Appearance Preferences

Clearlooks

¥ ®

Figure 6.21: Chess in Blue Heart Theme
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6.2.3 Customising a Screensaver

A screensaver displays (often moving) images on the screen when your computer is switched on but not in use. To go back to the
workspace, you can move the mouse or press any key on the keyboard.

1. On the System menu, point to Preferences and click Screensaver. The Screensaver Preferences dialogue box opens.

-g}; Applications  Places SQJstem @|2| 0
% Preferences r ﬂ About Me

dif] il Tue De

[0 Administration  » ;lw Appearance

0 g - o @ Assistive Technologies
elp and Suppo

Bazaar Preferences
€ About GNOME 0

Bluetooth

-{j About Ubuntu .
iﬂ’. Default Printer

E Quit...

} Encryption and Keyrings
=i Keyboard
= Keyboard Shortcuts

:;47 Main Menu

h y Mouse

Q Metwork Proxy

E PalmOs Devices
@u’:d Power Management

_"gg Preferred Applications
Remote Desktop

@ Removable Drives and Media
1) ScIM Input Method Setup
E‘ Screen Resolution

g, Screensaver

'-"33_ Search and Indexing

Sessions

g‘ Sound

~= windows

Figure 6.22: Launching Screensaver Preferences Dialogue Box

2. Select a screensaver from the list. You can preview the screensaver in the right pane.

Screensaver theme;
T e
Blank screen

Random

: 4D Hypertorus
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| Atunnel

BioF

BlinkBox
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Regard the computer as idle after;

[ Activate screensaver when compuzer is idle

I [J Lock screen when screensaver 1s active I

eﬂa\p ‘ ‘ @Puwar Management

| aguse ‘

Figure 6.23: Customising Screensaver Settings
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3. The Regard the computer as idle after slider specifies when a screensaver starts to work if the computer is not in use.
The default time is set to 10 minutes. You can use this slider to select how long the computer needs to be idle before the
screensaver activates.

4. To prevent any tampering of your computer in your absence, you can automatically lock your screen the moment the
screensaver activates. Locking requires users to type their password to reactivate the desktop. Select the Lock screen
when screensaver is active check box to lock the screen when the screensaver starts.

5. Click Close.

The selected screensaver displays when the computer is idle for the specified period.

6.2.4 Customising the Screen Resolution

The screen resolution determines how large or small an item looks on the screen.

1. On the System menu, point to Preferences and then click Screen Resolution. The Screen Resolution Preferences
dialogue box opens.
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Figure 6.24: Launching Screen Resolution Preferences Dialogue Box

2. The default resolution is 1280x1024. You can change the resolution in the Resolution box.
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Figure 6.25: Customising Screen Resolution

3. Click Apply. The Keep Resolution dialogue box opens, prompting you to confirm settings or use the previous resolution
and revert to the original settings. Click Keep resolution to apply new changes.

Do you want to keep this resolution?
0 Testing the new settings. If you don't respond in

S seconds the previous settings will be restored.

h Use previous resolution J I Keep resolution

Figure 6.26: Resolution Confirmation Dialogue Box

The screen resolution will change.

6.3 3D Effects

A computer screen is two-dimensional (2D) and until recently most applications were developed in a 2D layout.

However, advancements in technology fuelled the demand for more life-like on screen visuals, as in three-dimensional (3D)
modelling and games. The operating system needs to perform complex calculations to display 3D images in 2D. Consequently,
to reduce the burden on the operating system and increase the speed of applications, 3D accelerator cards were developed, which
use the graphics processor on the graphics card instead of consuming valuable CPU resources. Almost all modern graphics cards
have a built-in acceleration to display 3D.

Ubuntu can utilize the 3D capabilities of a graphics card for desktop effects. An example of these can be seen with Compiz
Fusion — spinning cubes, floating windows etc. Compiz Fusion is a fun application used to liven up your desktop experience and
make it 3D in appearance.

The effects are enabled by default and can be controlled from the Appearance menu. From here the desktop effects can either
be completely disabled or enabled. The number of effects can be controlled via the normal effects and extra effects setting.

If a graphics card does not have 3D capabilities or support for 3D is missing from the Linux drivers for the card, you will be
notified that Desktop effects could not be enabled.

6.4 Working with Files Using Nautilus

The Nautilus file manager in Ubuntu provides a simple and integrated way to manage files and applications.
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6.4.1 Features of Nautilus

The Nautilus file manager enables you to organise files into folders and perform tasks such as:

* Create and display folders and documents: Create new files, organise them into folders and save them.
» Search and manage your files: Classify files and search them as per their classification.

* Open special locations on your computer: Access the local network and save your files.

* Write data to a CD or DVD

* Navigate using two modes:

— Spatial mode: Allows you to open each folder in a separate window, which then helps open your files as physical objects in
different locations. You can view the content of various folders simultaneously.

— Browser mode: Opens your folders in a single window. Only one file manager opens in browser mode, and it is updated
when you click another folder in the file manager.

6.4.2 Nautilus

1. Click the Places menu. A list of items appears:
* Home Folder: This is a personal folder created by default for every user to create and work on files. It takes the user
name by default.

* Desktop: An active component that lies behind all the screens on your computer and provides easy and quick access to
the files saved on it.

* Computer: Contains all drives and file systems; makes document backup onto CD and DVD really simple.
* CD/DVD Creator: It consists of folders that you can write to a CD or a DVD. You can also back up your documents on
aCDoraDVD.

2. Click any of the above items on the Places menu.




Ubuntu Desktop Training
185/348

e

-?,jApplications Places System §

L@
;fa Home Folder
H Desktop

|57 Documents
[ Music

[ Pictures

| CD/DVD Creator
HP
FACTORY_IMAGE

WD Passport

Metwark

g Connect to Server...

Search for Files. .,

LI Recent Docurments  »

Figure 6.27: Using File Browser

The Nautilus file manager opens files in browser mode by default. If you open a folder in this mode, the folder will open
in the same window. The location bar shows the current location of the opened folder in the hierarchy of folders, and the
sidebar shows other folders saved on your computer.




Ubuntu Desktop Training
186 /348

..
File Edit View Go Bookmarks Help
@ . . # G o = S
Back Forward Up Stof Reload Horme  Computer Search G
EH!;_Q williamwindsor [Examples S, 100% © |Viewaslcons %
Places ¥ %] —— = — =
5 williarnwindsor o )
y . - = S

[ Desktop = = "

L. File System ! - - =] e e

[ HP logos case_Contact.pdf case_howard case_KRUU.pdf

county._library.pdf
[ FACTORY_IMAGE = e

L wo Passport

2 Metwork Servers

i@ Trash ] e i =3
o’
=4 Documents i il ==
& Music case_ case_oxford_ case_skegness pdf case_ubuntu_
= OaklandUniversity. archaeology.pdf johnhopkins_vz2 pdf
&5 Pictures pdf
&2 Videos :
-
- -]
> =2
d - JJ
case_ubuntu_ case_Wellcome.pdf Experience ubuntu.,  fables_01_01_zesop.
locatrix_v1.pdf ogg spx

— —
- - -
gimp-ubuntu-splash. kubuntu-leaflet.png oo-about-these-files.  oo-about-ubuntu-ru.
xef odt rtf

.

<]

24 items, Free space: 151.6 GB

Figure 6.28: Files Display

While in browser mode, you can move to the parent folder that contains the currently open folder. To move to the parent
folder, click Open Parent on the Go menu in the window. NOTE:

You can also click Up on the navigation toolbar or press the BACKSPACE key to move to the parent folder.

3. On the Edit menu, click Preferences. The File Management Preferences dialogue box opens.
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Figure 6.29: Launching File Management Preferences

4. Click the Behaviour tab in the dialogue box. To change the mode to spatial mode, clear the Always open in browser
windows check box and then click Close.
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\Views | Behavior | Display | List Columns l Previewl Media |

Behavior
() single click to open items
@ Double click to open items

Always open in browser windows

Executable Text Files
() Run executable text files when they are opened
() Wiew executable text files when they are opened

@ Ask each time

Trash
Ask before emptying the Trash or deleting files

[ Include a Delete command that bypasses Trash

€ Help

Figure 6.30: Changing File Management Behaviour

5. Close the file manager window and open it again. Your files will now open in spatial mode. If you open another folder, it
will open in a different file manager window.

- williamwindsor - File Browser
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Desktap Documents
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24 tems, Free space! 151.6 GB

Figure 6.31: Confirming File Management Behaviour Changes

NOTE:

Each time you open a particular folder in spatial mode, you will find its window displayed in the same place on the screen
and of the same size as during the last view. For this reason, this mode is referred to as spatial mode.

To move to the parent folder in spatial mode, click Open Parent on the File menu. Alternatively, you can press the
ALT+UP arrow key.
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Nice to Know:

Konqueror is KDE equivalent of Nautilus file manager, which is used in the Kubuntu derivative of Ubuntu. It is a multi-
purpose application that can act as a file manager, Web browser and universal viewer. As well as allowing you to browse
Web sites, this application provides basic file management and can many view different file types.

6.5 Package Managers

One of the biggest differences between Ubuntu and other operating systems is how you install and uninstall applications. In
Microsoft Windows, most applications provide their own installation and removal methods. Some applications provide a method
to keep themselves up to date, but others do not and there is no easy way to ensure that everything on your computer is up to date.
Keeping track of all the programmes that have been installed and keeping all those programmes updated is largely up to you.

Ubuntu has a sophisticated package management framework that keeps track of all the software installed, automates the
process of installing and removing applications, and ensures that all the software is kept up to date with the latest enhancements
and fixes. All you have to do is decide what applications you want installed, and then use a package manager to tell Ubuntu to
install them.

6.5.1 Types of Package Managers

Note:

Ubuntu includes a few package managers by default and which one you use depends on how advanced the package management
tasks are that you want to achieve. This course covers Add/Remove applications utility and the Synaptic Package Manager.

If you open more than one package manager at the same time, they may not work. Close all the package managers and open just
one.

6.6 Using Add/Remove Applications

Note:

The Add/Remove tool is the easiest to use and will enable you to install and uninstall many popular packages. You can search
for the package or packages you want to install by simply searching a keyword such as ’email’ or by looking through the given
categories, selecting applications and choosing "Apply" to start the installation.

You need administrative access to use any package manager. Type the password for your user name at the prompt. This means
that applications can not be added / removed from your computer without your knowledge (and password).

1. On the Applications menu, click Add/Remove.
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_ @ Add/Remove...

Install and remove applications

Figure 6.32: Launching Add/Remove Applications

2. The Add/Remove Applications dialogue box displays a list of applications. The check boxes against the applications that
are already installed are pre-selected. NOTE:

Many package names in Ubuntu are quite obscure, so the package manager will also look at the package description when
searching.

i-j}AII | Show: [A\I available applications ¥ | Search: ‘ fl

&k Accessories i
| Application ~  Popularity
/145 Educat =z = :
1‘1331 HEAHDT [ 20 20.000 Light Years Into Space A
1“'1' Games ] 5% Create a steam network to power a city and repairin ...
s | y h
A . | #4 3D Chess
| 2 Graphics iD == 3D chess for X11 % K
L6 Internet | — & adigits
w |
Q Hifia ’D Lr' A guess-the-number game, aka Bulls and Cows ok
| = | 4o 72ip
i) | i
| m|==fj Other |D == 7zip compression/uncompression toal %k k&

i o Programiming || Quick Introduction

m Sound & Video | | To install an application check the box next to the application. Uncheck the
o box to remove the application.

| g# System Tools | To perform advanced tasks use the Synaptic package manager.

‘@ Universal Access

0=

Figure 6.33: Add/Remove Applications Window

3. If you know the name of the package to be installed, you can type the name in the Search box. Otherwise, you can click
the appropriate software category in the left pane and select the check box next to the required package in the right pane.

Nice to Know:
For more details about a package, click the package and view the bottom pane.
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three difficulty levels, an interactive tutorial, and a scoring system.

"20.000 Light Years Into Space" is written in Python using pygame and it was
rewarded with the second place in the Pyweek March 2006 Individual Entries
category.

This application is provided by the Ubuntu community.
Homepage: hitp: Jwhitham.org.uksbiscuit_games/LightYears

I ogancal || Apply Change

Figure 6.34: Searching for a Package in All Available Applications

4. When you have finished selecting the packages to be installed or removed, click Apply Changes.
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O é ?:trrilss-hke game * ok

| w Atomix

puzzle game for building molecules out of isolated atoms €
Atomix is a game designed for GNOME in which you have to build melecules,
from simple inorganic to extremely complex organic ones, out of isolated
atoms,

The first levels can be misleadingly easy, but added complexity always
comes with the next level, so that several minutes (or even much more
than that) can be spent on getting out of ene single level.

| ogancel l [ Apply Changes

Figure 6.35: Applying Changes to the Package List

5. You are prompted to confirm your selection. Click Apply to proceed.
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Figure 6.36: Confirming Changes

6. The progress indicator shows the status of the package being installed or removed.
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Figure 6.37: Installing Selected Package from Repositories

7. After the changes are applied successfully, the package is installed.
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Figure 6.38: Installation Confirmation

8. Double-click the package to launch it. If you want to add or remove more applications, click Add/Remove More Appli-
cations or else click Close in the New application has been installed dialogue box. The following figure shows Atomix,
which has been installed by performing this procedure.

Game  Help

| Statistics

Level:

Molecule:

Farmula;

Scaore!

Time:

Figure 6.39: Launching the Installed Application - Atomix

NOTE:

After installing a package, you can open it by using a particular menu based on its category.

6.7 Using Synaptic Package Manager

Add/Remove Applications does not enable you to install and remove some more advanced packages, such as the Apache web
server, the PHP programming language or Scribe. In such cases, use Synaptic Package Manager.
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You can install, remove, configure or upgrade software packages, browse, sort and search the list of available software packages,
manage repositories or upgrade the whole system. You can queue up a number of actions before you execute them. Synaptic
informs you about the additional packages required by the software package you have chosen as well as conflicts with other
packages that are already installed on your system. In addition, it presents more information such as package status, origin and
filters.

1. On the System menu, point to Administration and then click Synaptic Package Manager.

e

System (& |2|9
ﬁ Preferences »

I.ILS_JJ Administration  » '-‘a-}.'._, Authorizations

-13 Applications Places

ﬁ Hardware Drivers
0 Help and Support x

€ About GNOME

A

|« Hardware Testing
m Language Support
[l Login window

% Netwark

| ‘-| Metwork Tools
LHJ Printing

Services

-:3 About Ubuntu

8 auit...

3‘ Software Sources

@‘ Synaptic Package Manager
]E System Log I
Efi| system Monitor
f:% Time and Date
@ Update Manager
5 Users and Groups

3%] Windows Wireless Drivers

Figure 6.40: Launching Synaptic Package Manager

2. In the Synaptic Package Manager dialogue box, you can select the package you need. The left pane lists the categories,
and the right pane lists the packages. If you do not know the name of the package, select the category in the left pane to
filter the list of packages. You can then select the check box next to the required package in the right pane. NOTE:

If you want to view the installed and uninstalled packages, click Status. To know the source repository of the package,
click Origin. Click Custom Filters if you want to know the whether a package is broken or can be upgraded.
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Figure 6.41: Synaptic Package Manager Window

3. If you know the name of the package, click Search. The Find dialogue box opens. Type the name of the package in the
Search field and click Search. NOTE:

To return to the list of categories after searching the packages using Search, click Sections.

'Q Synaptic Package Manager IZ]@1

Flle Edit Package Ssttings Help .
Reload  Mark All Upgrades Appl Propertie Search

All = s Package Installed Version | Latest Ver}I =
Amateur Radio (univel [ 2veard 0.5-2 ‘
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Base System (univers M1 adiaits 0.8-1 .7
Communication Wl [})
communication (mult [ |NO package is selected.

=== D)

[—] Search: |abiword -
Status

Lookin: | Description and Name | 3
Origin
Custom Filters &

[ Search Results |

125083 packages listed, 1141 installed, 0 broken, 0 to installjupgrade, 0 to remove

Figure 6.42: Searching a Package to Install

4. Choose the action to be performed on the selected package. Select the Mark for Installation check box to install the
package or select the Mark for Removal check box to remove it. If you change your mind, select the Unmark check box.
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Synaptic Package Manager

File Edit Package g_ett'ings Help

N Le

Reload  Mark All Upgrades Apply Properties Search
All Installed Version Latest Ver |-
abiword 2.46-3ub
2.4.6-3ub
2.4,6-3ub
2.4,6-3ubllx
5 - D
o o
ol - . 'based on GTK2
B3 Mark for Complete Removal
@Al V| Aplwera s TneTrstappicatoners complete, open source office

suite. The upstream source includes cross-platform support for win32,
Sections

Be0S, and QNX as well as GTK+ on Unix,

|

Status

This package contains the Abiword binary built with GTK2,
rigin
Custom Filters
Search Results.

|13 packages listed, 1141 installed, 0 broken, 0 to installjupgrade, 0 to remove

Figure 6.43: Marking the Package for Installation

5. If the package that you choose to remove or install depends on other packages, you will be notified about the dependencies.
To continue making changes, click Mark.

& EypaatisiEackageilianeagen

Sethings: Help

Mark additional required changes?

abiword @

The chesen action also affects other packages,
The following changes are required in order to
proceed,

+ To be installed
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Figure 6.44: Confirming Additional Changes

6. To confirm that you want to make the marked changes, click Apply.
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Figure 6.45: Applying Changes to Update Software Information

7. The Summary dialogue box opens, prompting you for a final check before making the marked changes. Click Apply to
continue with the changes.
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Figure 6.46: Final Confirmation to Install the Package

8. When all the marked changes are made, you are notified about the changes applied. Click Close to close Synaptic Package
Manager.
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Figure 6.47: Installation Confirmation

This step completes the procedure of installing packages by using Synaptic Package Manager. You can access the installed
package by selecting a particular menu, depending on the category of the package. The following figure shows Abiword,
which has been installed using this procedure.
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Figure 6.48: Launching the Installed Application - Abiword

6.8 Installing a Single Package File

Note: Note:

The preferred method of installing programmes is by using package managers. If some packages or files are not available, you can
download and install them from Web sites. These files are associated with the package managers of specific Linux distributions
and are referred to as single package files. Examples are Debian package files-.deb files and tarballs-.tar files.

You should download files that are not present in Ubuntu archives only from a safe source.
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» Debian Package files: These files are associated with Ubuntu and have the .deb suffix.

* Tarballs: Zipped archive files that contain the source code of a programme. This source code needs to be compiled before use.
Installing programmes by compiling them from source is not covered by this course.

Compiling and installing programmes from source tarballs can can be very complex to debug when things go wrong. Tarballs are
simple structures which don’t specify what dependencies are required to enable compilation to take place. For this reason it can
also be time consuming and complex to determine the necessary dependencies and either install or compile them also. Compiling
from tarball is therefore not covered on this course.

It is not guaranteed that the single package files will be compatible with your system. Also, you will not receive security updates
if you install these files. Therefore, wherever possible use a native Ubuntu package of the application available through a package
manager.

6.8.1 Installing/Uninstalling Debian Packages

Debian packages are installed and uninstalled using the graphical installer (gdebi). gdebi will attempt to install any dependen-
cies which are in the Ubuntu repositories, however if the package requires further dependencies which are not in the Ubuntu
repositories these will also need to be installed manually.

To install a Debian package, open the .deb file from the folder in which it resides.

1. Download the package XVidCap xvidcap_1.1.6_i386.deb. As this package is not in the Ubuntu repositories, you will
need to download it from the following website: http://sourceforge.net/projects/xvidcap/.

2. Once downloaded, simply double click the .deb file and the gdebi installer will start. It will check to see if you have all the
necessary dependents, and if so will offer an Install button. Simply press the button to start the installation. In the event
that dependencies cannot be resolved, an error message will be displayed and you will not be able to install the package
until they are fulfilled.

3. To uninstall the package, simply use the Synaptic Package Manager, as outlined previously in this section.

6.9 Software Repositories

A software repository is a library of packages (applications) available over the Internet. The Ubuntu software repository contains
tens of thousands of freely available packages for you to download and install. These packages have been specially built and
selected for Ubuntu.

6.9.1 Software Repository Categories

Ubuntu repositories are categorised into four groups based on the level of support that software development teams provide for a
programme and the level of compliance the programme has with the free software philosophy.

¢ Main
¢ Restricted
¢ Universe

¢ Multiverse

The Main Component The Main component contains software packages that are free and fully supported by the Canonical
team. These packages comply with the free software philosophy and are available by default while installing Ubuntu. For all
packages in the Main component, security updates and technical support are available free of cost. OpenOffice.org, Abiword and
the Apache web server are some of the packages available there.
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The Restricted Component The Restricted component consists of packages for commonly used software that are supported by
the Ubuntu team but not available under a completely free license. Binary drivers produced by some video card vendors are an
example of packages available there. Packages in this component are also available on the standard Ubuntu installation CD, but
they can be easily removed.

The Universe Component The Universe component includes thousands of packages for software that is not officially supported
by Canonical. The software is available under a variety of free licenses, taken from a variety of public sources. This component
is available only through Internet downloading.

All the packages in this component are expected to work perfectly. However, there is no guarantee of security fixes and support
for these packages. These packages are maintained by the community.

The Multiverse Component The Multiverse component contains packages of non-free software, which means that the licensing
requirements of the software does not meet the license policy of Ubuntu’s Main component. It is the user’s responsibility to verify
their rights to use the software and comply with the individual licensing terms. Support and security updates are not provided.
Examples of these packages include VLC and the Adobe Flash plugin.

Many packages are not available in default Ubuntu repositories. These packages can either be installed from other Ubuntu
repositories or from third-party software. To use the packages present in third-party software, you need to add the software and
the repositories.

1. On the System menu, point to Administration and then click Software Sources.
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() Printing
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-33 About Ubuntu
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r‘}?ﬁ‘ Synaptic Package Manager
12! system Log
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(ﬁ Time and Date

;;é; Update Manager

ﬂ Users and Groups

3%] Windows Wireless Drivers

Figure 6.49: Launching Software Sources Dialogue Box

The Software Sources dialogue box opens. The software sources for Ubuntu are selected by default.
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[ Software restricted by copyright or legal issues (multiverse)

[= Source code
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Installable from CD-ROM/DVD
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Figure 6.50: Selecting the Required Sources

NOTE:

You can also open the Software Sources dialogue box by using the Add/Remove applications or Synaptic Package Man-
ager to enable the repositories under the Ubuntu Software tab.

2. To add a repository from the third party, click the Third-Party Software tab and then click Add.

Ubuntu Software | Third-Party Software ‘ Updates IAuthenticatmn 1 Statistics I

[[] edrom:[Ubuntu 8.04.1 _Hardy Heron_ - Release i386 {20080
[¥] http:/farchive.canonical.com/ubuntu hardy partner

[] http:/farchive.canonical.com/ubuntu hardy partner (Source Col

4 | [¥]

b add... | | cdite, | [ = mermove) |VE_WAddCD-ROM..‘

Figure 6.51: Adding a Third Party Software Source

3. Type the APT line for the repository you want to add as a source. To access the Debian main repositories, type deb
http://ftp.debian.org sarge main in the APT line box. Click Add Source. NOTE:

The APT line should include the type, location and components of a repository.
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components of a repository, for example 'deb httpy/
archive ubuntu.com/ubuntu/ gutsy main'.
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Figure 6.52: Stating the Source APT Line

4. Click Close to save changes. The repository specified in the APT line is added to the third-party software box.

Software Sources EE=

Ubuntu Software | Third-Party Software IUpdE‘tEE IAuthentl:atmn } Statistics ‘

[] edrom:[Ubuntu 8.04.1 _Hardy Heron_ - Release i386 (20080
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[¥] http:jtarchive.canonical.com/ubuntu hardy partner (Source Co
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€l I I+
[ <= Add... ] | Sttt | | =gsme ! [n;?_i_JAdd CDVROM...]
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Figure 6.53: Software Sources Dialogue Box Displaying the Added Source

5. With the addition of an extra repository, you will be prompted to update information about available software. Click
Reload to do so.
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Figure 6.54: Reloading Available Software Information

6. The progress indicator shows the status of package being installed or removed.

You can authenticate your downloads from the Authentication tab in the Software Sources dialogue box. When you
do not authenticate your downloads, your computer may show the error shown below after downloading the package
information. This error can be ignored. To authenticate the downloading process, you need to import the GPG key, which
is different for every repository. Click Close in the dialogue box showing the error. This step will end the process of adding
extra repositories and updating package information.

& Software Sources E

e Could not download all repository indexes

The repository may no longer be available ar could not be
contacted because of network preblems. If available an older
version of the failed index will be used. Otherwise the
repositery will be ignored. Check your network connection
and ensure the repository address in the preferences is
correct,

[Failed to fetch http:m"tp.debian.orgfdists}sarge;mainjbinary-i386fFf
!Some index files failed to download, they have been ignored, or ql

[v]

Eglose

Figure 6.55: Public Key Error

6.10 Adding New Language Settings

Ubuntu provides the option to enable numerous language settings for your desktop.
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Support for new languages can be installed via Language Support, which is found in the Administration/System menu. De-
pending on the language, the input method and keyboard mapping may need to be changed as well. The Smart Common Input
Method(SCIM) is used in Ubuntu to switch between different input methods for complex characters in many non-Latin languages.
The ctrl space hotkey is a convenient switch between different input methods.

6.11 Lesson Summary

In this lesson, you learned that:

* GNOME is the default desktop for Ubuntu. You can use the Preferences option on the System menu to customise the Ubuntu
desktop look and feel.

* You can manage your file system using the Nautilus file manager. Use the spatial mode to open each folder in a separate
window and view the content of various folders simultaneously. Use the browser mode to open folders in a single window.

* Add/Remove Applications is the easiest tool to install or uninstall packages.
* You can use Synaptic Package Manager to install or uninstall advanced applications that cannot be installed using Add/Remove.

 To install a package that is not available in the Ubuntu archives, you can download and install it from Web sites. These files
are associated with the package managers of specific Linux distribution and are referred to as single package files.

* Tarballs are zipped archive files that contain the source code of a programme. You can use advanced command line tools to
install or uninstall the tarball file.

6.12 Review Exercise

Question: What is the default desktop for Ubuntu?

Answer:

Question: From which Web site can you download additional Ubuntu wallpapers and themes?
Answer:

Question: Mention any three features of the Nautilus file manager.

Answer:

Question: Which is the file manager for the KDE environment?

Answer:

Question: What is a package manager?

Answer:

Question: Differentiate between a graphical package manager and a command line package manager. Provide examples of each.
Answer:

Question: Software that is not licensed under Ubuntu’s main component licensing policy is referred to as

Answer:
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6.13 Lab Exercise

Exercise 1 You have installed Ubuntu 8.04 on your personal computer. You want to view your pdf files, use a spreadsheet
application for creating your daily tasks and archive your files. Install the following packages:

a) xpdf

b) gnumeric

1. On the Application menu, click Add/Remove. The Add/Remove dialogue box opens.

2. In the Search box, type xpdf.

3. Select the check box next to xpdf.

4. Click Apply Changes.

5. Click Apply to make the changes.

6. In the New application has been installed dialogue box, click Close.

1. On the System menu, point to Administration and then click Synaptic Package Manager. The Synaptic Package
Manager dialogue box opens.

2. Click Search to find gnumeric and select the gnumeric check box.

3. Select the Mark for Installation check box. A dialogue box displaying the dependencies of this package on other packages
opens.

4. To continue making the required changes, click Mark.

5. To confirm making the marked changes, click Apply. The Summary dialogue box opens, prompting you for a final check
before making the marked changes.

6. Click Apply to continue with the changes.

7. When all the marked changes are made, you are notified of the changes applied. Click Close.
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Chapter 7

Making The Most of Images and Photos

OBIJECTIVES

* View and edit images

* Scan and send images

7.1 Introducing Graphics Applications

Graphics applications form an integral part of Ubuntu. They enable you to organise your photo collection, create and edit photos
and images, scan and send objects and more.

In this lesson, you will learn about the various graphics applications available on Ubuntu and which one to use when. These
graphics applications are available either with the Ubuntu installation or in repositories (those libraries we mentioned earlier).

Applications Available with the Ubuntu Installation The following applications are included in the Ubuntu installation pack-

age:

* GIMP Image Editor: An image editor used for advanced image creation and editing such as changing the contrast, colour or
the texture of an image.

* F-Spot Photo Manager: A photo manager used to organise and manage photos. F-Spot enables you to tag (label), categorise
and sort photos.

* XSane Image Scanner: An image scanner which also enables you to photocopy documents and fax or e-mail scanned images.

Applications Available in Repositories In addition to the default applications, you can search through the repositories and install
applications using the Synaptic Package Manager or the Command Line Interface (CLI).

Some of the graphics applications are available in Ubuntu software repositories:

'

Agave: A colour scheme designer. After you select a base colour, Agave suggests the appropriate complementary colours or
shades of the same base colour. You can also drag and drop a colour from another application, such as GIMP. Whether you
are designing a Web page or a pamphlet or painting your house, this programme enables you to identify the appropriate colour
scheme. Visit the Web site http://home.gna.org/colorscheme/ for more information on Agave.
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Blender: An open-source 3D content creation suite. You can create 3D models and animations, add post-production effects
or use it as a graphics editor to define interactive behaviour without programming. Blender has a distinctive user interface
that is implemented entirely in Open GL and designed for speed. Python bindings for scripting and import/export features
for popular file formats such as 3D Studio are available in Blender. Blender can output still images, animations, models for
games or other third party engines and interactive content in the form of standalone binaries or web plug-ins. Visit the Web
site http://www.blender.org/ for more information on Blender.

-

Dia: A diagram editor similar to Microsoft Visio. Dia offers the capability to produce precise and professional-level graph-
ics. You can draw entity relationship diagrams, flowcharts and network diagrams and export them to various formats, including
EPS, SVG, XFIG, WMF and PNG. You can also print diagrams spanning multiple pages. Visit the Web site http://live.gnome.org/-
Dia for more information.

' J

Geceolor2: A simple colour selector and picker that facilitates quick and easy selection of colours. It also enables you to save
new colours and delete existing ones. Visit the Web site http://gcolor2.sourceforge.net/ for more information.

-

GNU paint: A user-friendly painting programme for GNOME. It offers easy-to-use drawing tools to perform various image-
processing operations. Visit the Web site http://gpaint.sourceforge.net/ for more information.

In addition, several third-party applications, such as Picasa, a free software download from Google, are compatible with Ubuntu.

Picasa enables you to locate and organise all the photos on your computer, edit and add effects to your photos and share
your photos through e-mail and print and post images on the Web. You can download Picasa from the following Web site
http://picasa.google.com/linux/download.html.

The following section outlines the features of some of these graphics applications and how to use them.

7.2 Viewing and Managing Photos with F-Spot

F-Spot is a personal photo management application for the GNOME desktop. You can import and view pictures from the hard
disk on your computer, digital camera or even the ipod. You can attach tags to your photos and categorise them, build a photo
CD, export photos over the Internet and share them online or perform basic colour-correction and editing. F-Spot supports 16
common file types, including JPEG, GIF, TIFF and RAW.

The following graphic shows the elements in the F-Spot interface:



http://www.blender.org/
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http://live.gnome.org/Dia
http://gcolor2.sourceforge.net/
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Figure 7.1: F-Spot Window

7.2.1 Importing Photos in F-Spot

After importing the photographs, you can categorise and tag them as you would to create a playlist in a music player.

To import photographs into F-Spot from the hard disk of your computer:

1. On the Applications menu, point to Graphics and click F-Spot Photo Manager. The F-Spot window opens.

2. Click the Import button on the toolbar. The Import dialogue box opens.
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Figure 7.2: Importing Photos

NOTE:

You can also click Import on the File menu to open the Import dialogue box.
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3. In the Import Source box, the Select Folder option is selected by default. Retain the option, navigate to the folder that
contains the photographs and click Open.
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Attach Tags: [ ]

Copy files to the Photos folder
& Include subfolders

l ogance\

Figure 7.3: Selecting Photo Import Source
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Figure 7.4: Displaying Images to Import

4. Click Import in the Import dialogue box.
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Figure 7.5: Importing Photos

The photographs are listed as thumbnails in the F-Spot window.

Notice that the timeline slider is positioned according to

the dates on which the images were saved on the hard disk of your computer.
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Figure 7.6: Browsing Photos

NOTE:

The photographs listed in the F-Spot window are not associated with any category or parent tag.

To import photographs into F-Spot from a digital camera:

1. Click the Import button on the toolbar. The Import dialogue box opens.
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2. Click the Import Source box. Plug the camera on the computer. F-Spot detects the camera and displays the model and
type of the camera in the Import Source box.
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Figure 7.7: Selecting Photo Import Source

3. Click the camera as the source for the photographs. The Select Photos to Copy From Camera dialogue box opens, which
lists all the photos in the camera. Select the photos you want to import and click Copy.
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Figure 7.8: Selecting Images to Copy

4. F-Spot copies the photographs to the specified location and displays the copied photographs in the right pane of the F-Spot
window.

7.2.2 Viewing Photos

After importing, you can view all the photographs as thumbnails in the right pane of the F-Spot window. You can view pho-
tographs in F-Spot by:

* Double-clicking each thumbnail to enlarge the view
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¢ Select a thumbnail and click Fullscreen on the toolbar

The image opens in fullscreen mode.
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Figure 7.9: Browsing Photos

Figure 7.10: Viewing Photos in Full Screen Mode

Click Exit fullscreen to return to the F-Spot window.
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7.2.3 Organising Photos

By default, F-Spot organises photographs based on the dates in which they were saved on the computer. You can view pho-
tographs for a specific date and time by clicking the corresponding year on the timeline slider or moving the slider along the
timeline. For example, assume that there are 100 images in the right pane, 50 of which were saved in 2004 and 50 in 2007. To
view the images for 2004, position the slider on the timeline at the 2004 mark.

To organise the photographs differently, you can attach a tag or a label to each photo and categorise them. You can then view
photographs based on these categories.

Some categories are already predefined and visible in the left pane of the F-Spot window. You can group your photos under these

tags.

To add a tag to a photograph:

* In the F-Spot window, right-click a photograph, point to Attach a Tag and click the tag with which you want to associate the
photograph. The tag is displayed at the bottom of the photograph.
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Figure 7.11: Tagging an Image
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Figure 7.12: Viewing Tagged Images

The tagged image is now displayed under the tagged category.

7.2.4 Removing Red Eye

In some cameras, the proximity of the flash to the lens causes the light from the flash to reflect from the subject’s retina to the
lens, leaving a red eye mark on the image. Referred to as a red eye, the size of the mark depends on the amount of light reflected.
F-Spot Photo Manager software can be used to remove the red eye from images.

Figure 7.13: Image with a Red Eye

1. In the F-spot Photo Manager window, click the thumbnail of the image that has a red eye. Click the Edit button in the
navigation toolbar. Use your mouse to select the area you wish to correct on the image. You can zoom in on the area by
using the slider bar in the bottom of the work area.




Ubuntu Desktop Training
215/348

Photo Edit View Find Tags Help

= = = =
+ & ¥ EE = N B
Import Rotate Left Rotate Right Browse | Edit Image Fullscreen  Slideshow

Favorites

O

Hidden

0|

i People
Places

Events

el

(=

name redeyel.jpg

date 12/20/2008

11:46 AM o Cumment:[—J

size 232x307

exposure (None) Mo Constraint A S B - .Y 1of1 »

M =CT—=4]

Figure 7.14: Removing Red Eye

2. Click the Redeye Removal icon underneath the image. F-spot automatically corrects the image. NOTE:

The edited image also replaces the image stored on your computer. Ensure that you save a copy of the image before editing
it.

7.3 The GIMP

GNU Image Manipulation Programme (GIMP) is the default graphic application in Ubuntu, licensed under the GNU General
Public License. It is an open-source multi-platform image manipulation tool, available in many languages. You can use GIMP
to re-touch photos, compose and create images, re-size, crop, manipulate colours and convert image formats.

GIMP has a number of useful features:

* A full suite of painting tools, including brushes, a pencil and an airbrush

* Selection tools such as rectangle, ellipse, free, fuzzy and bezier

 Transformation tools such as rotate, scale, shear and flip

* Tile-based memory management so that the image size is limited only by available disk space
* Multiple undo/re-do operations limited only by disk space

» Advanced scripting capabilities

 Layers and channels for complex drawings

 Sub-pixel sampling for all paint tools to minimise distortion while representing high-resolution images in lower resolution or
stretched mode

* Full alpha channel support to simulate transparency in images
* Support for multiple file formats, including GIF, JPEG, PNG, XPM, TIFF, TGA, MPEG, PS, PDF, PCX and BMP

1. On the Applications menu, point to Graphics and click GIMP Image Editor. The GIMP Tip of the Day prompt is
displayed. Click Close on the GIMP Tip of the Day prompt. The GIMP window opens.
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Figure 7.15: GIMP Tip of the Day Dialogue Box

Nice to Know:

The GIMP mascot is a coyote named Wilber. He provides useful tips while you use the application. If you do not want to
see the tips, clear the Show tip next time GIMP starts check box.

2. To open an image for modification, on the File menu, click Open and select the image you want to modify.
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Figure 7.16: Opening an Image for Editing

3. The selected image opens in the Image window.
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Figure 7.17: Editing Image

You can now modify the image by using the tools available in the GIMP window.

Nice to Know:
You can drag and drop a colour from the toolbox or from a colour palette onto an image. This fills the current image or
selection with the selected colour.

7.4 Drawing with Inkscape

Inkscape helps you draw illustrations for the Web, graphics for mobile phones, simple line drawings, cartoons, complex works
of art, figures for chapters and books or organization charts.

Inkscape is a high-end graphic tool with capabilities similar to Illustrator, CorelDraw or Xara X. It is multi-platform software
that is freely available for the Linux, Microsoft Windows, Solaris and Mac OS X operating systems.

You can use it to rotate, re-size, skew, proportion, fill and stroke objects with a high level of precision. Advanced visual effects
such as gradient and transparency are also available.

Inkscape is not part of the default graphics package in Ubuntu however, you can install this package from repositories.

7.4.1 Installing Inkscape

Note:

There are two ways to install Inkscape. You can install this application from the repositories by using Synaptic Package Manager
or from the Command Line Interface (CLI).

Your computer must be connected to the Internet while installing the application from the repositories.

1. On the System menu, point to Administration and click Synaptic Package Manager. The Synaptic Package Manager
window opens.
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Figure 7.18: Launching Synaptic Package Manager

2. In the Synaptic Package Manager window, the left pane lists the categories of software and the right pane lists the
packages in a category. Click Search. The Find dialogue box opens. Type Inkscape in the Search field and click Search.
NOTE:

To view installed and uninstalled packages, click Status. For the source repository of the package, click Origin. Click
Custom Filters to determine whether a package is broken or upgradeable. To return to the list of categories after searching
the packages, click Sections.
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Figure 7.19: Searching Inkscape

3. The Search results are displayed in the right pane of the Synaptic Package Manager window. Right-click Inkscape and
select the Mark for Installation check box.
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Figure 7.20: Marking Inkscape for Installation

4. Click Apply on the toolbar to begin the installation process. A Summary dialogue box is displayed, which prompts you
to confirm the changes. Click Apply to proceed with the installation.
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Figure 7.21: Confirming Changes

5. After the installation is complete, click Close in the Changes applied dialogue box.
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Figure 7.22: Changes Applied Confirmation

To launch Inkscape, on the Applications menu, point to Graphics and click Inkscape Vector illustrator.

7.4.2 Creating Vector Graphic Images Using InkScape

Note:

Page: This area enables you to specify various options for the output. For example, you can specify the Page dimensions for
printing on A4 size paper. The Page adjusts accordingly and you can adjust the proportion the drawing relative to the Page.

Menu Bar: This toolbar provides menus such as file save and zoom. You can perform all operations in Inkscape by using the
options listed on these menus.

Command Bar: This toolbar provides shortcuts to major operations on the menu bar.

Drawing Toolbar: This toolbar provides options to perform drawing operations. You can create basic shapes such as a rectangle,
a square or an ellipse.

Tools Control Bar: This toolbar provides options specific to a tool on the Drawing toolbar. For example, if you select the
polygon tool from the Drawing toolbar, the Tools Control Bar displays options to set the corners in the polygon.

Status Bar: This toolbar indicates the status of objects such as dimensions and layers. For example, when you roll the mouse
over the window, the Status Bar indicates the position of the cursor relative to the window.

Vector drawing software uses standard notation to refer to shapes such as simple lines, rectangles and complicated shapes as
objects.

Creating and Saving Objects Creating a new object in Inkscape requires extensive use of the Drawing toolbar. However,
the options in this toolbar help you to create basic shapes. To create complex objects, you need to further edit, combine and
manipulate these shapes.

1. Click the object button associated with the shape you want to draw. Point anywhere in the page where you want to start
drawing the object.

2. Drag the cursor to the desired size of the object. The object is displayed in the page.
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Figure 7.23: Drawing an Object

The Tools Control Bar displays options to create the object. For example, if you are creating a rectangle, the toolbar
provides the option to specify the height and the width of the rectangle.

3. After creating the shape, click Save on the Command Bar. The Select file to Save to dialogue box is displayed. Type the
name of the file in the Name text box, specify the location where you want to save the file and click Save.
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Figure 7.24: Saving an Object
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NOTE:

Inkscape saves images as vector graphics. You can resize a vector image without affecting the resolution of the image.

7.5 Using a Scanner

Scanning an object in Ubuntu is simple. If you have a USB scanner, plug the scanner directly into your computer. Most plug-
and-play devices are compatible with Ubuntu, if however, the computer fails to detect the scanner, you will need to check its
compatibility with Ubuntu.

7.5.1 Checking Scanner Compatibility
You can check the compatibility of your scanner with Ubuntu in one of two ways:

* Visit this Web site for the list of scanners and drivers compatible with Ubuntu: https://wiki.ubuntu.com/HardwareSupportComponentsS

* Check the status of your scanner at the following Web site: http://www.sane-project.org/sane-backends.html. This site lists the
drivers distributed with sane-backends-1.0.18 and supported hardware and software.

7.5.2 Scanning an Image

You can scan an image by using the scanner interface or the scanning application XSane, which is available in Ubuntu.

1. On the Applications menu, point to Graphics and click XSane Image Scanner. XSane automatically searches for a
scanner attached to the computer. After your computer detects the scanner, the XSane Options dialogue box is displayed.

2. The XSane Options dialogue box provides options to modify the default settings of the output. You can specify the number
of copies to be scanned, the name of the output file, the output file type, and colour and contrast options. After you specify
the properties of the output file, place the object on the scanner and click Scan to begin scanning the object.
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Figure 7.25: Using XSane

3. After the object is scanned, a viewer window displays the output.
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Size 637 x B71 pixel, 8 bit/colour, 1 colours, 75 dpi x 75 dpi, 541.8 KB

Figure 7.26: Viewing Scanned Output

NOTE:

Before beginning the scanning operation, check the compatibility of your scanner with Ubuntu. Sometimes, Ubuntu detects
the scanner as hardware but fails to scan if the required driver is missing.

4. Continue to scan other images or close the XSane Options dialogue box to exit the application.

7.6 Lesson Summary

In this lesson, you learned how to:

* View and organise your photo collection by using the default Ubuntu graphic applications:

— The F-Spot Photo Manager enables you to import pictures, organise your photos using tags, create a photo CD, display
photos as a slide show and create albums of your photo collection for the Web.

Use GIMP for advanced image manipulation and creation.
* Create graphics in the SVG format by using the Inkscape vector graphics editor.

* Scan your images and save them in various formats by using XSane Image Scanner.

7.7 Review Exercise

Question: Which of the default graphics applications provides the option to display only a category of images from a randomly
stored pool of images?.

a) Inkscape
b) F-Spot
¢) Xsane
d) GIMP

Answer:
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Question: Which default graphics application in Ubuntu facilitates photo sharing over the Internet?
Answer:
Question: Is there any additional software required to import images from a digital camera?

Answer:

7.8 Lab Exercise

Exercise 1: Creating a Web Album by using F-Spot You have just returned from a vacation with your friends. You decide to
write about this experience on your blog and post some photographs of the trip. However, uploading images one by one to the
Web site involves a lot of effort and time. You want to find a more convenient way to do this.

1. Launch F-Spot Photo Manager. The default window is displayed.

2. Click Import on the navigation bar. Navigate to the folder containing the photos Open. The workspace displays all the
images available in the folder.

3. Select the images you want to include in the Web album.

4. Click Copy to import the selected photos. F-Spot displays the photos in the preview window.

5. In the preview window,select the photos you want include or use Select All from the Edit menu.
6. In the Photo menu, select the Export to and then Web Gallery.

7. You will need to enter the name of the Gallery, as well as the URL and log-in information for the site. F-Spot will then
upload the selected items to the website.
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Chapter 8

Playing Music and Videos

OBIJECTIVES

* Play, edit and organize music and video files.

8.1 Legal Restrictions

Ubuntu fully supports playback of music, videos and DVDs available in free and unrestricted formats. A number of multimedia
formats are restricted by licenses and software patents in some jurisdictions. Ubuntu does not offer this capability by default for
these formats but it easy to enable playing a variety of proprietary formats. This section will guide you through the patent and
copyright restriction considerations for using proprietary file formats.

The license of the format is different from the license of the content itself. For example a video’s content can be licensed under a
Creative Commons license, and be available as MPEG file. While the content can be distributed freely, the format is proprietary
and a software for playback may need to be licensed in some jurisdictions.

To understand the legal issues associated with the use of proprietary formats, you first need to understand the difference between
free and non-free or proprietary formats.

8.2 Playing Music Files

Ubuntu comes with the Rhythmbox Music Player to play and organise music files. Similar to iTunes in its interface, this music
player is a free software application designed to work in the GNOME desktop environment. Using Rhythmbox, you can play your
music files, listen to Internet radio, import music from CDs and organise your music files. Rhythmbox offers comprehensive audio
support for a large number of audio formats and contains various useful features that make playing music easy and enjoyable.

8.2.1 Playing Music using Rhythmbox

1. On the Application menu, point to Sound & Video and then click Rhythmbox Music Player. A welcome screen is
displayed.
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Figure 8.1: Launching Rhythmbox

2. The main window of the Rhythmbox Music Player opens. Now, you will be able to organise your favourite music using
this window.
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Figure 8.2: The Rhythmbox Music Player

3. To start playing music in Rhythmbox, you need to first select the music source from the Source list. By default Library is
selected as the source when you open Rhythmbox for the first time.
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Library is the main source available in Rhythmbox. You can import all your music files into the Rhythmbox library and
can start playing immediately. You also use the music files in your library to create smart customised playlists and play-
queues. To start importing individual music files, right-click Music and click Import File. It displays the Import File
into Library dialogue box.

Music Edit Miew Control Help
>3 [ % © = @
Play =viny Jext Repeat  Shuffle Browse Visualization
Not Playing
Library ~  Search: I i‘] [ All ] Artists  Albums  Titles
=E! Play Queus !Artlst El Album
i = ———
‘@ Music | |_I import Ele... ; (0) All 0 albums (0)
" Podcasts ‘ 3 Import Foldar.., |
@ Radio
Stores -
@ Magnatune
Jamendo =
Aliyiiste - wl Track Title Genre Artist Album Time -

|§! My Top Rated
§| Recently Added
|§! Recently Played

Choose file to be added to the Library

Figure 8.3: Importing Music Files

4. In the Import File into Library dialogue box, navigate to the folder from which you want to import the files. Select the
files that you want to import and click Open.
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Figure 8.4: Selecting the Files to Import

Nice to Know:
While importing music files from your music collection, Rhythmbox also imports the metadata tags associated with the
files. These tags are used by Rhythmbox to categorise the music files by genre, artist, album, title, and track number.

5. The selected music files are imported into the library and displayed in the the Rhythmbox window. You will notice that
the main Rhythmbox window is split into various panes. Each pane displays different details about your music collection.
To play music from the library, you can use the Artist, Album and Track panes to select the music tracks that you want to
play and then use the playback controls to start playing the music tracks. Click the Play button to start playing the selected
track.
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Figure 8.5: The Rhythmbox Window

6. If you click the Play button without selecting any track, Rhythmbox will start playing the first track from your current
view. You can use the Shuffle button to play tracks randomly. You can also create a play list by right-clicking a music
track and selecting Add to Playlist. To stop or pause a track, click the Play button again.
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Figure 8.6: Creating New Playlist

7. Rhythmbox offers many additional useful features in the form of various plugins. Some of these plugins are not turned on
by default. To access these plugins, on the Edit menu, click Plugins. The Configure Plugins dialogue box opens.
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Figure 8.7: Accessing Plugins

8. You can view all the available plugins in the left pane of the Configure Plugins dialogue box. Selecting a plugin displays
its details in the right pane of the dialogue box.

9. Depending on your requirements and preferences, you can activate these plugins to get extra functionality in your Rhythm-
box. For example, the Magnatune Store plugin enables iTunes-style song previews and paid downloads. Activating
Visualization renders a real-time visualization of the music on the screen while you listen to a song track. Similarly, if
you want to automatically retrieve the lyrics of the song being played, activate Song Lyrics by selecting the corresponding
check box and click Close to exit the Configure Plugins dialogue box.
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Figure 8.8: Activating Plugins

10. You are returned to the main Rhythmbox interface. To start retrieving the song lyrics, on the View menu, click Song
Lyrics.
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Figure 8.9: Retrieving Song Lyrics

11. Amazingly, Rhythmbox retrieves the song lyrics for you. Now, you can sing along while listening to your favourite song.
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it off an aux speak, grunt, no, strength, Ladder

start to clatter with fear fight down height. Wire

in a fire, representing seven games, a government

for hire and a combat site. Left of west and coming in

[+

Figure 8.10: The Song Lyrics Retrieved

12. Similarly, if you wish to view animations while listening to a song, click the Visualization button.
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Figure 8.11: Activating Visualisation

13. You can view animations while playing a song.
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Figure 8.12: Viewing Animations
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14. Rhythmbox also enables you to listen to music from a variety of sources, such as Internet radio stations and podcasts.

To play music from a podcast of your choice, right-click the Podcast option in the Source list and select New Podcast
Feed.

. Ce
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Figure 8.13: Adding New Podcast Feed

NOTE:

Podcasts are audio shows broadcast over the Internet that you can subscribe to. Subscribing to a podcast enables you to
download each new audio release from the subscribed podcast source.

15. Enter the podcast feed URL in the New Podcast Feed text box and click Add.

NG PodCast Foea) EETE|

URL of podcast feed:

Ids.feedburner.comebuntuL.IkPodcastOgg-high?farmatzxml]

[ °gancel

(o )

Figure 8.14: Entering Podcast Feed URL

16. Rhythmbox automatically looks for the latest podcasts and downloads them for you. To play a podcast episode, select the
episode that you want to play and click the Play button.
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Figure 8.15: Playing a Podcast

17. Rhythmbox also allows you to listen to radio streamed from Internet radio stations across the world. To listen to Internet

radio, click the Radio source in the Source pane.
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Figure 8.16: Playing Internet Radio

on the radio station of your choice to listen to the streaming media.

18. By default the Radio source lists several radio stations, each of them broadcasting a different genre of music. Double-click
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Figure 8.17: Listening to a Radio Station

19. You can also add a new radio station to the existing list by clicking New Internet Radio Station and pasting the URL of
the new radio station in the URL of Internet radio station text box. Click Add to add the radio station in the existing list.
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Figure 8.18: Adding New Radio Station

20. You can add many more Internet radio stations in the same way and listen to your favourite radio stations with just a click
of your mouse.

8.3 Playing and Extracting Audio CDs

Note:

Sound Juicer is the default application available in Ubuntu for playing and extracting audio compact discs (CDs). It is an easy-to-
use CD player and ripping tool that requires minimal user intervention in playing and extracting audio CDs. Using Sound Juicer,
you can play audio tracks directly from the CD and extract audio tracks and convert them into audio files. Sound Juicer allows
you to extract audio files into the following three formats:

* Ogg Vorbis: Ogg vorbis is a free, unpatented and open source alternative to the proprietary MP3 format. Like the MP3 format,
it discards parts of the sound that humans cannot normally hear. An Ogg Vorbis file is typically a tenth of the size of a WAV
format file containing the same content.

* FLAC: FLAC stands for Free Lossless Audio Codec. It is an unpatented, open source audio format. Unlike MP3 or Ogg Vorbis,
FLAC compresses audio without discarding any information. A FLAC file is typically half the size of a WAV file containing
the same content.

* WAV: WAV is short for Waveform Audio Format. It is an uncompressed format typically used for short snippets of sound and
voice recordings.

To know more about Ogg Vorbis and FLAC audio format, visit the following Web sites:
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* http://www.vorbis.com/faq/

* http://flac.sourceforge.net/

8.3.1 Playing Audio CDs

1. Insert an audio CD in the CD drive of your computer. The Sound Juicer CD player and ripper is launched automatically. To
start Sound Juicer manually, click the Applications menu, point to Sound & Video and then click Audio CD Extractor.

-Q Applications Places System i =) 7

‘1&, Accessories 8

;iﬁi Games 3
‘.4'__5 Graphics G
h\.:, Internet 4
I_H Office S
.._’-" Programming 3
m Sound & Video FI- ':H‘ Audio CD Extractor

(.} Brasero Disc Burning

@. Add/Remove...

= Movie Player

Rhythmbox Music Player

=]

9_@ Sound Recorder

Figure 8.19: Launching Sound Juicer

2. Sound Juicer’s main interface is displayed. When Sound Juicer detects a CD, it examines the CD and tries to search the
Internet to locate information about the CD’s content. If you are connected to the Internet, Sound Juicer will retrieve the
CD artist, title, and track data from MusicBrainz.org.

To play all the tracks sequentially, you can simply click the Play button. NOTE:

MusicBrainz.org is a community-maintained online database, which contains data on over 360,000 published albums.
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Disc Edit Help

Title: [Séo Vicente I
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Genre: | ‘ Year: |ﬁ Disc: El
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N1 Sdo Vicente Di Longe Cesaria Evara
¥z Homem Na Meio Di' Homem Ceséria Evora =
¥ 3 Tiempo Y Silencio (feat. Pedro Guerra) Ceséria Evora
¥ a Sabor De Pecado Cesaria Evora
¥ 5 Dor Di Amor Cesaria Evora
I Ritridink CenAria Cinr Z

I [+]

[ [> Play } ['\;,' Extract

Figure 8.20: Playing Audio CD

Notice that Sound Juicer has fetched the track information from MusicBrainz.org. In the upper part of the Sound Juicer
window, you can see the basic information about the disc, including title, artist, genre and total duration. The lower part of
the window displays a list of tracks, each with its full title, artist and duration.

3. To play only the tracks of your choice, select the particular tracks by selecting the corresponding checkboxes and then
click the Play button.

S'i)'lil_'_lj.ﬂ:]'_l'.llt'éi"'

Disc Edit Help

Title: [Séo Wicente l

Artist: [Ceséria Ewvora l

Genre: [ Year: |ﬁ Disc: l:|

Duration: 64:17

| Track Title Artist &

¥ IU LIEPUSLUIE SUUGU (TEdL, OUTTTE Rdllly WeEsSdlid CVUTd

W] 11  Linda Mimosa (feat, Orquesta Aragon) Cesaria Evora

¥ 12 Negue (feat. Chucho valdés) Cesdria Evora
[¥] 13 Bondade E Maldade Cesaria Evora -
¥ 142  Fada Cesdria Evora
W] 15  Pic Nic Na Salamansa Cesdria Evora =

[A] | [+]

l [> Play H"E}E_mact

Figure 8.21: Selecting the Song tracks




Ubuntu Desktop Training
242 /348

4. You can now enjoy listening to your favourite music tracks.

Disc Edit Help

Title: [Have | Told You Lately l
Artist: {Various ]
Genre: [ ]

Duration: 78:06

Track Title Artist
M1 Right Here Waiting Richard Marx
I:| 2 4 It Must Have Been Love Roxette I I
¥ 2 Un-Break My Heart Toni Braxton
v a Goodbye Air Supply
¥ s That's Why (You Go Away) Michael Learns To R
|#1 & Ansinet All ndde (Tala A | anlk At Ma Aoud Dhil Caline (=)

[ I [v)
[ in Pause ‘ ‘ -i-;lEgtract ] (il e |

[ |0:45 f 4:20

e

Figure 8.22: Playing the Selected Tracks

8.3.2 Extracting Audio CDs

If you want to listen to your favourite music tracks without needing to insert a CD every time, you can create a copy of the CD
and extract the music tracks on your computer.

1. Insert the audio CD and click the Extract button. However, if you want to define the audio quality, format and the location
where the files would be stored, click Preferences on the Edit menu. This displays the Preferences dialogue box.
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G I [v]

[ [ Play ] [ ';' Extract

Figure 8.23: Defining Preferences For Audio Files

2. You can use the Preferences dialogue box to define a number of things such as how the folder hierarchy should be saved,

how the files should be named and whether to eject the CD automatically after the tracks are extracted.

In the last section of the Preferences dialogue box, you can define the file format in which the tracks would be stored on

your computer. Based on your requirements, select any one format from the Output Format drop-down list.

Nice to Know:

You can also extract CD audio files to the proprietary, non-free MP3 format. Instructions for extracting audio files into
the MP3 format can be found in the help for Sound Juicer. Go to Help>Content and then navigate to the Preferences

section.
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Device

CD drive: DWD-RAM GHI10L

[] Eject when finished

] Open music folder when finished

Music Folder

Eolder: li] Music

Track Names

Folder hierarchy: lAIbum Artist, Album Title

Ak

File name: l Number - Title

[[] Strip special characters

Example Path: /The Beatles/Helpi/07 - Ticket To Ride.ogg

Format CD Quality, Lossless (FLAC audio)

Output Format: CD Quality, Lossy (Ogg multimedia) @Edit Profiles...

“oice, Lossless (WAV audio)

e Haip ‘ Woice, Lossy (Speex audio) B Close

Figure 8.24: Specifying Audio Format

3. Each of these file format has its own customisable profile. Depending on the type of the music track and the destination
where it has to be stored, you may need to customise these file formats. Click the Edit Profiles button, then select the
desired profile and click the Edit button to edit the profile of the selected file format according to your needs.

Brofiles:

CD Quality, AAC = [#yNew
CD Quality, Lossless

CD Quality, Lossy %Edit

CD Quality, MP3

Voice, Lossless

(oI

\oice, Lossy

(0 |

Figure 8.25: Editing Audio Profile

4. The Editing profile dialogue box for the selected audio profile is displayed. You can edit the audio profile according to
your requirements and the click Close to exit.
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Profile name; CD Quality, Lossless ]

Profile description:  |Used for converting to CD-quality sudie, but
with a lossless compression codec. Use this if
you later want to edit the file or burn it to CO.

GStrearrer pipeline; ‘audioj)c-raw-int,rate:44100,channe|s:2 ! flacer|

File extension: ‘Flac |

[ Active?

| eﬂelp ‘ ‘ agcse |

Figure 8.26: Customising Audio Profile

5. You can also use the Preferences dialogue box to define the location where you want the audio files to be stored on your
computer. By default, Sound Juicer stores the audio files in the Home directory. To define a location of your choice, select
a directory from the Music Folder drop-down list and click Close to exit the Preferences dialogue box.

[ = Deskiop 4|

Device

CD drive:

Music Folder

Folder:

Track Names

. File System

(@ Audio Disc
_136.7 GB Volume
LBKINGSTON

== Network Servers

[ Music

& Documents

Folder hierarchy: = Music
&3 Pictures
File name: o
(& Videos
Other...
Format

Output Format: (CD Quality, Lossless (FLAC audio) 5 ] ‘ ;::;?Edit Eroﬁles...‘

@ =elp ‘ | pd close

Figure 8.27: Specifying Audio File Location

6. After configuring your preferences, you can go ahead and start extracting all the tracks by clicking the Extract button.
However, if you want to exclude some tracks, deselect them by clearing the corresponding check boxes.

Depending on the speed of your computer, the extracting process can take a long time. You can watch the total progress of
the process in the lower left section of the Sound Juicer window.
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Figure 8.28: Extracting Song Tracks

7. Sound Juicer notifies you after the selected tracks are extracted successfully. Click Open to view the tracks copied on your
hard disk.

O e

@ Have | Told You Lately has been copied successfully.

‘ Eject l \ﬂ—_j‘gpen ﬁgose

Figure 8.29: Viewing Copied Tracks

8. The CD audio tracks are now copied as audio files on your hard disk. You can listen to these tracks by simply double-
clicking them.
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Figure 8.30: The Copied Tracks

8.4 Burning Audio CDs

Besides copying audio tracks from a CD to your computer, Ubuntu also enables you to copy music files from your computer
onto a CD or DVD. Brasero is the CD/DVD burner application that comes bundled with Ubuntu, by default. It is an easy-to-use
application that also allows CD/DVD data disc creation, CD/DVD copying and burning of existing images to CD/DVD.

1. Launch Brasero by selecting the Applications menu, point to Sound & Video and then click Brasero Disc Burning. The
Brasero window is displayed.
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Figure 8.31: Launching Brasero

2. The Brasero Window displays. Click the Audio Project button. You will need to navigate to the folder containing the
audio tracks you wish to add to the new CD project.

File Edit View Help
=ﬂ & Add

Track Fation

I ¢ Preferences

Disc Usage:

Disc Capacity:

Empty

74 minutes

Figure 8.32: Starting a new Audio Project
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Disc copy Burn image

Create 11 copy of a CD/DVD Burn an existing CO/DVD image to disc

Choose a recently opened project:

No recently used project

Figure 8.33: The New Audio Project window

3. Now you need to specify the files that you want to be copied onto the blank CD. To start specifying the desired audio files,
click the Music folder. This displays the contents of any items previously imported. Double-click the title of the folder
where the music files are located. The files are listed in the middle window. You can now add files to the project using any
of the methods described in the right side window.

Project Edit View Tools Help
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5 Videos iz
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Audio files only | &
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w;’TI Empty (0 min /1 h 40) =S|
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Figure 8.34: Specifying Audio Files to Copy

4. The selected files now appear in the project window. You can also view the estimated disc usage once these files are written
to the disc at the bottom of the project window. Based on this data, you may decide to add or delete some files from your
current selection. Once you are sure of the files to be copied to the disc, click the Burn button to start writing the audio
files from your computer to the CD.
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Figure 8.35: Writing Audio Files to Disc

5. The Disc Burning Setup window allows you to change the Properties of the project. You can select the Options checkbox
to leave the disc open to add a data session later. Click the Burn button to begin writing the files to the disc.

Select a drive to write to

DVD-RAM GH1OL | 2 | || dwPropertie

Type: DWVD+R
@ Size: 4.4 GB free
Contents: empty
Status: the medium can be recorded

Title

Training Team Favorites

Disc options

| ogancel

Figure 8.36: Confirming the CD Writing

6. Brasero now starts writing the music files to the media disc. You can view the progress in the Burning Audio Disc dialogue
box. This process may take some time depending on the size of the files to be written to disc. Once the process is complete,
you have a new CD containing all your favourite songs.
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Figure 8.37: Writing an Audio CD

8.5 Playing Proprietary Multimedia Formats

Note:

As previously stated, due to the legal restrictions associated with the use of proprietary formats, Ubuntu does not offer support
for such formats by default. If you wish to play proprietary formats, you will need to install additional multimedia codecs. A
multimedia codec is a small piece of software that allows you to watch videos or listen to music of a specific format. Although
Ubuntu includes many codecs by default, you may need to install more because there are many different multimedia formats and
it is unrealistic to provide them all.

Playback of multimedia files in Ubuntu is handled by the Gstreamer multimedia framework. GStreamer by itself does not provide
any multimedia codecs, it relies on codecs that have been packaged into a plugin that it uses to perform the actual recording and
playback. Typical plugins are:

* gstreamer(.10-plugins-ugly
* gstreamer(.10-plugins-ugly-multiverse
* gstreamer(.10-plugins-bad
* gstreamer(.10-plugins-bad-multiverse

* gstreamer(.10-ffmpeg

To know more about which Gstreamer package contains which plugins, visit the following Web site: http://gstreamer.freedesktop.org/-
documentation/plugins.html.

Other applications, such as VLC, MPlayer and Xine, do not use the Gstreamer framework.

You can use the Synaptic Package Manager, or the Command Line Interface (CLI) to install these multimedia codecs available
in the repositories.
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Nice to Know:

Codecs can be installed directly from the Movie Player. When Movie Player recognizes a format it cannot play, it checks if a
Gstreamer plugin is available for this format. If it finds one, you can install the codec easily without following the lengthy solution
presented below.

1. On the System menu, point to Administration and then click Synaptic Package Manager. The Synaptic Package
Manager window opens.

Q Applications  Places Sy;tem i_me | Sat Dec 20, 4:48 PM
% Preferences L

n'l-;c;jn Administration  » "Ur-.‘u Authorizations

[ Hardware Drivers
9 Help and Support i

- ;
| « 3 Hardware Testing
& About GNOME el

W Language Support
L’E Login Window
% Network

".:-i Metwork Tools

‘2} About Ubuntu

E Quit...

& partition Editor

iﬂ Printing

__;_ Services

@ Software Sources

@ Synaptic Package Manager 4
B sptem g
@ System Monitor

@ Time and Date

@ Update Manager

Figure 8.38: Launching Synaptic Package Manager

2. The Multiverse and Restricted repositories are not activated by default in Ubuntu. To install the additional multimedia
codecs, you need to first activate these repositories. On the Settings menu, click Repositories. The Software Sources
dialogue box is displayed.
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Figure 8.39: Displaying Software Sources

3. To enable the Multiverse and Restricted repositories, select the third and fourth check boxes available on the Ubuntu
Software tabbed page, and click Close to exit the dialogue box.

Software sources

Ubuntu Software |Th'ird-|3r=1r’c).ur Software l Updates lAutherﬂticati'on l Statistics l

Downloadable from the Internet
| Canonical-supported Open Source software (main)
® Community-maintained Open Source software (universe)
] Proprietary drivers for devices (restricted)
M Software restricted by copyright or legal issues (multiverse)

Source code

1r

Download from: | Main server

Installable from CD-ROM/DVD

To install from a CD-ROM or DVD, insert the medium into the drive.

‘ Hevrart ‘ lglose

Figure 8.40: Enabling Repositories

4. You may receive a notification that your repository information has changed. Click Close to exit this message.
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Figure 8.41: Repositories Information Notification

5. Once you return to the Synaptic Package Manager window, you are required to click the Reload button to apply your
changes.

Synaptic Package Manager.

File Edit Package Settings Help
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Figure 8.42: Applying Changes

6. On clicking the Reload button, the system starts checking the repositories for new, removed or upgraded software packages.
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Figure 8.43: Checking Package Information

7. After the Multiverse and Restricted repositories are added in the Ubuntu software sources, you can download and install
additional multimedia codecs. To install a software package, you need to first locate the package in the Synaptic Package
Manager window. You can either search for a specific software package manually or run a search using the search utility
provided in the Synaptic Package Manager. To initiate a search for a specific package, click Search.
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Figure 8.44: Initiating Software Search

8. In the Search field, enter the name of the software package that you are looking for. Click Search to begin the search.
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Figure 8.45: Searching a Software Package

9. The search results are displayed in the right pane of the Synaptic package Manager window. Right-click the package to be
installed and select Mark for Installation.

Synaptic Package Manager,

File Edit Package Settings Help
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E gy . 0.10.6-0ubuntul  GS
B va P =
\E g Mark for Rer ‘ 0.10.6-Oubuntul  GS|x|
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a Marl e tallat to playing videos, and just
[ origin ] et i . .
auuuL anyunng eIse rmeuEs-rerdiey. s prugin-based architecture means
[ Custom Filters ] that new data types or processing capabilities can be added simply by -

installing new plug-ins.

[ Search Results ]

(o]

5 packages listed, 1139 installed, 0 broken. 0 to installjupgrade, 0 to remove

Figure 8.46: Marking Packages for Installation

10. You can mark multiple packages for installation by following the same procedure. Once all the required packages are
marked, click Apply to start downloading the packages. The Summary dialogue box is displayed.
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Synaptic Package Manager
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l Sgarch Results J

(]

5 packages listed, 1139 installed, 0 broken. 1 to installjupgrade, 0 to remove; 618 kB will be used

Figure 8.47: Initiating Package Download

11. The Summary dialogue box allows you to take a last look at all the software packages that you have marked for installation.
To go ahead with the marked installations, click Apply.

Summarny

Apply the following changes?
This is your last opportunity to look through the list

of marked changes before they are applied.

P To be installed =

Summary Show Details

1 new package will be installed

618 kB of extra space will be used
0 B have to be downloaded

[] Download package files only

l ogancel y <« Apply

Figure 8.48: Conforming Package Installation

12. After all the marked software packages are downloaded and installed, the Changes Applied dialogue box is displayed.
Click Close to exit the Changes Applied dialogue box.
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Changes applied

Successfully appled all
changes. You can close the
window now.

] Automatically close after the changes have been successfully asplied

I Details

Figure 8.49: Changes Applied Notification

13. The check box corresponding to the recently installed software package has changed to green, indicating that the software
has been installed successfully. You can repeat the same procedure to install all the multimedia codecs required for playing
proprietary multimedia formats.

File Edit Package Settings Help
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Search Results ]

5 packages listed, 1140 installed, 0 broken. 0 to installjupgrade, 0 to remove

Figure 8.50: Software Successfully Installed

8.6 Using an iPod

The iPod is a popular portable media player, designed and marketed by Apple. You can play music in MP3 and AAC (Advanced
Audio Coding) audio file formats and store up to ten thousand songs on the device itself. The iPod does not support free
multimedia formats.

8.6.1 Playing Music Using an iPod

1. Plug your iPod into one of your computer’s USB ports. Ubuntu automatically mounts it and places it as an icon on your
desktop. Simultaneously, the iPod device opens in the Rhythmbox Music Player window. You can view all the files loaded
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on your iPod device in the lower right pane of the Rhythmbox window. To play a music track from your iPod, just select
the track from the list and click the Play button.

Music Edit VMiew Control Help
B =
> KK Bl (=] % = = @
Play  Previous  Next Repeat  Shuffle wisualization  Eject
Not Playing
I
T = Search: ‘ jl l All J Artists  Albums ~
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& ¥ Q !Amst Album
I Music | 3 |
All 206 artists (466) All 167 albums (466) 1=
’ Podcasts ‘3 Doars Down (1) (1) |
_ Ix]
@ Radio 2 -
= il Track Title Genre Artist Album Time
Last.fm
Lecture 23* 2007 (Ted ... Podcast Unknown UCTV - Gam.., 57:34
st - c
£les 69  UDS, Mot really. Technol... Harlem Quij... Fresh Ubuntu  1:33:21
@ Megnatine Hardy +1 Month - Rou... Podcast Harlem Quij... Fresh Ubuntu  42:21
Jamendo 71 Lots of news Podcast Harlem Quij... Fresh Ubuntu  53:21
Playlists ~ 72 Technoviking Technal... Harlem Quij... Fresh Ubuntu  1:02:02
@] My Top Rated 73 Bugmaster Podcast Harlem Quij... Fresh Ubuntu  1:03:56
‘Q Recently A... 74 LoCo Talk Technol... Harlem Quij... Fresh Ubuntu  54:13
}@ Recently Pl... 75  WINE Maintainer Technol... Harlem Quij... Fresh Ubuntu  53:13
] EPISODE22 - Ubuntu f... Podeast  Wizkid Ubuntu for N... 28:37
= st Y IR Y L Al innr Eandh e o R o =) 5 P g e A0 Butl
466 songs. 2 days, 20 hours and 56 minutes, 9.8 GB v

Figure 8.51: Plugging in an iPod

2. The song starts playing in the Rhythmbox Music Player. However, if the format of the music file is not supported by the
Rhythmbox Music Player, you may not be able to play the file and you will receive an error message. In this case, you
will need to follow the procedure described in the previous section to download all the necessary software codecs from the
Ubuntu repositories.
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2 [4]

466 songs, 2 days, 20 hours and 56 minutes, 9.8 GB

Figure 8.52: Playing Music from iPod

3. Ubuntu also allows you to transfer music files to and from the iPod device. However, this is not possible using Rhythmbox.
You will need to install the gtkpod software to be able to transfer music file between your computer and the iPod device.
You can easily download this software from the Universe repository using the Synaptic Package Manager.

To access gtkpod, after it is successfully installed on your computer, on the Applications menu, point to Sound & Video
and then click gtkpod. The gtkpod window opens.
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Q), Internet »
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_._,_-.’ Programming »

m Sound & Video >] (] Audio CD Extractor

| @. Add/Remove...

.:-) Brasero Disc Burning
j gtkpod

@ MG Bl Manage songs and playlists on your Apple iPod

[} Rhythmbox Music Player

% Sound Recorder

Figure 8.53: Launching gtkpod

4. You can view all the music files stored on the iPod device in this gtkpod window. Notice that in the gtkpod interface, your
music files have automatically been categorised based on artists, album and genre. This categorisation helps you quickly
browse through your collection and select.

You can use the gtkpod interface to manage the files on your iPod in multiple ways. You can create and edit playlists,
normalize the volume on single tracks or multiple tracks at a time. You can also use the gtkpod interface to add more files
in your iPod or transfer files from your iPod onto your computer. To add files from your computer to your iPod device,
click Files. This displays the Add Files to ’device name’ dialogue box.
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Figure 8.54: Using gtkpod to transfer files to iPod

5. In the Add Files to ’device name’ dialogue box, navigate down to the folder from which you want to add the files to your
iPod. Depending on your preferences you may either add a single file at a time or an entire directory. Select the tracks that

you want added and click Open.
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Figure 8.55: Selecting the Files to Transfer
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6. Gtkpod starts adding the files to your iPod. When the process is complete a message "Successfully added files" is quickly
flashed at the bottom of the gtkpod window. You can also view the recently added files in the bottom pane of the gtkpod
window.

You can repeat the aforementioned steps to add more files from different folders. After you have added all the required
files to your iPod, click the Save Changes button to load and save the files.
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Figure 8.56: Updating the iPod

7. When you are done updating your iPod and want to disconnect it, close down the Rhythmbox window. Right-click the
iPod icon on the desktop and then select Eject. You now can safely remove your iPod from the computer.

8.7 Creating and Editing Audio Files

Ubuntu provides you with various tools to create your own music and audio files. The default application available in Ubuntu for
creation of audio files is the GNOME Sound Recorder. Similarly, you can also edit audio files using Audacity.

8.7.1 Creating Audio Files

Ubuntu provides you with tools to create new audio files using an input device such as a microphone. Sound Recorder is the
default application available in Ubuntu for creating audio files.

1. On the Applications menu, point to Sound & Video and then click Sound Recorder.
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Figure 8.57: Launching Sound Recorder

2. Sound Recorder allows you to record and play .flac, .ogg, and .wav audio files. To start a recording session, you need to
select an input device, such as a microphone, phone or line-in, from the Record from input drop-down list. You can also
select the audio quality from the Record as drop-down list.

File Control Help

Record from input: [Microphone

ar

ar

Record as: {CD Quality, Lossy (Ogg multimedia)

File Information
Filename: Untitled
Length:

Ready

Figure 8.58: Selecting the Input Device

3. Before starting the recording, it is advisable to configure the volume control settings to derive quality audio output. To
access the volume controls, on the File menu, click Open Volume Control.
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Figure 8.59: Accessing Volume Controls

4. You use the slider buttons on the tracks to set the volume control for all the audio input and output devices. To further
specify your volume preferences, click Preferences on the Edit menu. This opens the Volume Control Preferences
dialogue box.

Voltme Gontrol: HDANNtel (AlSatmixer)

Fle Edit Help
“«{ Preferences
i 3 ¥ 2 "
Headphone PCM Line-in Microphone PC Speaker
‘es ‘ea ‘es -
Q) Qi Qi ) Qi
iConfigure the application

Figure 8.60: Displaying Volume Preferences

5. The Volume Control Preferences dialogue box allows you refine the sound settings by selecting or clearing the various
options. Click the Close button to exit this dialogue box.




Ubuntu Desktop Training
266 / 348

Select tracks to be visible:

[¥] Headphone =
V] PCM

(] Front

[¥] Line-in

[] Line-in Capture

[¥] Microphone

(] Microphone Capture
(] Mic Boost

[] IEC58

[ ] IEC958 Playback Source §5]

¥

Figure 8.61: Configuring Sound Settings

You are returned to the Sound Recorder window. Now, you can start recording the audio from the selected input device
by clicking the Record button. The recording starts.

File Control Help
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_MNew : Open Record

ar
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Record from input: [Microphone

ar

Record as: [CD Quality, Lossy (Ogg multimedia)

File Information
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Length:

Ready

Figure 8.62: Recording Sound

6. After the recording is complete, you can play the recorded sound file by clicking the Play button. The progress indicator
moves along the progress bar as the sound file is playing. You can also view the duration of the recorded file in minutes
and seconds under the File information section.
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Figure 8.63: Playing Recorded Sound File

8.7.2 Editing Audio Files

You can use Audacity for editing audio files. Audacity is not included in the default installation of Ubuntu but it is a free and
open source software application, which can be installed easily from the Universe repository of Ubuntu. You can install Audacity
using either the Add/Remove Applications or the Synaptic Package Manger.

1. On the Applications menu, point to Sound & Video and then click Audacity Sound Editor.
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Figure 8.64: Launching Audacity

2. When you access Audacity for the first time, it will ask you to select a language to use with the application. Apart from
English, Audacity provides language support for more than 30 languages, including Arabic, Bulgarian, catalan, Czech,
Danish, Finnish and many more. Select your language preference from the Choose Language for Audacity to use drop-
down list and click OK.

Choose Language for Audacity to use: I English = |

o

Figure 8.65: Selecting Language for Audacity

3. The Audacity main interface window is displayed. You can use the various controls and tools to play, create and edit audio
files.
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Figure 8.66: The Audacity Window

4. You can now start editing an existing audio file in Audacity. To do so, you need to first import the audio file into Audacity.
To import an audio file, on the File menu, point to Import and then select Audio. The Select one or more audio files
dialogue box opens.
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Figure 8.67: Importing Audio Files into Audacity

5. Select the audio file that you want to edit and click Open to open the file in Audacity.
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Figure 8.68: Selecting the Files to Import
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6. The selected audio file opens in the Audacity interface. The audio file is represented as the blue waves in the lower part of
the Audacity window. Now you can perform a whole range of tasks on this file.You can cut off some unwanted portion of
the imported audio file, insert silence at some point, can add various audio effects on different sections of the file and may

even export the file into an altogether different file format.

Audacity also allows you to play an audio file. Click the Play button to start playing the audio file.

7. The audio file starts playing in the Audacity audio editor. You can use the various tools available with Audacity to start
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editing the current audio file:

|C|ick and drag to select audio

Figure 8.69: Playing the Imported File

Magnifying tool: If you find that due to the length of the current file, you are unable to view the portions that you want
to edit, you can use the Magnifying tool. This will let you zoom in on a specific area.

Envelop tool: This enables you to change the volume of specific selections of the sound file.

Time Shift tool: Allows you to move the entire sound file in relation to time; helpful when you are working with multiple

Selection tool: Enables you to highlight portions of the sound file on which you want to work.

To start editing a specific portion of the sound file, activate the Selection tool by clicking it.
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Figure 8.70: Picking the Selection Tool

8. Select the area you wish to edit by dragging across the area while pressing the left mouse button. The selected area appears

in a shade of darker gray.
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Figure 8.71: Selecting Audio Portion to Edit

9. You can now cut the area if you wish to remove this part of the audio file otherwise, edit this portion by applying various
sound effects to it. The Effect menu contains all the digital audio effects that you can apply on an audio file. Some of these
are:

Amplify - Increases or decreases volume without altering sound quality
BassBoost - Increases the volume of a specific frequency.

Echo - Allows you to add an echo specify the delay time.

Fade in - Fades from silence to the present volume

Fade out - Fades from present volume to silence

Invert - Flips the audio samples upside down

Noise Removal-Allows you to remove background noise

Reverse - Allows you to play the selection backward

To increase the volume of the selected portion, on the Effect menu, select Amplify. The Amplify window opens.
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Figure 8.72: Applying Sound Effects

10. In the Amplify window, you can use the slide bar to increase or decrease the amplification. Click OK to apply the effect
to the selected portion of the audio.

Amplify by Dominic Mazzoni

Amplification (dB): |5.3 |

New Peak Amplitude (dB): |5.1

™ Allow clipping

l Preview l logame‘] @QK

Figure 8.73: Amplifying the Audio Clip

11. Notice that the blue waves in the selected area have changed. You can now listen to the changed audio by clicking the Play
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Figure 8.74: Verifying the Edit Effects

12. After you are satisfied with all the edit effects, you can save the edited audio file. Because the default audio format of
Audacity is not readily supported by many applications you should save the file in a more popular audio format, such as
Ogg Vorbis or MP3.

To save the file in a different file format, click Export.

File Edit view Tracks Generate Effect Analyze Help

New Cri+N A1 =¢

Open... ctr+o »‘/ ./ f:p‘ﬂ *

Recent Files... 3 = = =7 = T
LhN=] i (= ey

s o ml@wlen_o|o| » 212 10]

Save Project ctrl+s

Save Project As..

Check Dependencies...

Open Metadata Editor...
Import.., »

Export...

Export Selection...

Export Labelsi.. E;a\ect\on Start: @ End () Length Audio Position:
Export Multiple... )0h02m05s~ 00h02m58s> 00h00mOOSs~

Apply Chain.., ‘
Edit Chains...

Page Setup...

Print...

Exit ctr+Q

Figure 8.75: Exporting Audio File

13. In the Export File dialogue box, select the folder where you want to save the file. Then, select the desired file format from
the drop-down list and then click Save to export the file in the specified file format.
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Figure 8.76: Exporting as MP3 File

14. Audacity starts exporting the file in the specified file format. This process may take up some time depending on the length

of the audio file.
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Figure 8.77: Export Progress Indicator

The audio file is exported to the specified location. You can now close the Audacity window and listen to the edited audio
file whenever you wish.

8.8 Playing DVDs

Note:

Most commercial DVDs are encrypted with the Content Scrambling System (CSS), which attempts to restrict the sotware that
can play a DVD. By default, Ubuntu is capable of playing DVDs that are not encrypted. Due to legal restrictions surrounding the
CSS format, as well as Ubuntu’s commitment to free multimedia formats, some software packages needed for encrypted DVD
playback are not installed by default in Ubuntu. You can install these packages from Ubuntu repositories to enable the playback
of encrypted DVDs.

It is possible that the use of some of the following software to play or copy DVDs is not permitted by law in some countries.
Please check your rights before proceeding.

You may also consider downloading the following additional applications that are capable of playing certain formats by default:

* Mplayer movie player

* VLC media player

* Xine

* Totem-xine

Totem Movie Player, the default movie player included in Ubuntu can automatically play a DVD when it is inserted into the DVD

drive. However, it will not provide access to the DVD menu. Other free software media players like VLC, mplayer and xine do
make the DVD menu available.
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8.8.1 Playing DVDs in Totem Movie Player

After you have installed all the required software packages from various Ubuntu repositories, you can play a DVD on your Totem
movie player.

1. Insert the DVD in the DVD drive of your computer. This will automatically launch the Totem and the DVD will start
playing.

Movie Edit View Go Sound Hel

[ Playlist il I

[> cdromo

Time: = ;

0 k4 o ‘j“i“j‘

Playing | 1:50 / 2:10:22

Figure 8.78: Playing a DVD in Totem

2. To view the DVD in full screen mode, on the View menu, click Fullscreen. Alternatively, you can simply press F on your

keyboard.
i._.. -
Movie Edit View Go Sound Help
i Fullscreen F
Fit Window to Movie 4
Aspect Ratio r
Deinterlace |
Switch Angles G
+ Show Controls H
Subtitles 3
¥ Sidebar Fg

Figure 8.79: Enabling the Full Screen View

3. You can enjoy the DVD in full screen mode or press ESC and return to the Totem window.
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Figure 8.80: Viewing DVD in Full Screen

4. Totem also allows you to configure some settings to view the DVD according to your preferences. To configure the
preferences settings, on the Edit menu, click Preferences.

) caromo) (=)

Movie Edit View Go Sound Help

i) s .. Ctrl | @
#al Take Screenshot rl+S Playlist =i~ |

Bepaat Mads [> cdromo
Shuffle Mode

Clear Playlist

Plugins...

& Preferences

Time: |

m ka A

Playing | 16:34 / 2:10:22

Figure 8.81: Displaying Totem Configuration
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5. You can use the Preferences dialogue box to define various display settings, such as the brightness, colour, hue and
saturation of the display. After specifying your preferences, click Close to exit the dialogue box.

General

Display

udia |

] Automatically resize the window when a new video is loaded

o Allow the screensaver to activate even when audio-only is playing

Visual Effects

™ Show visual effects when an audio file is played

Type of visualisation: | GOOM: what a GOOM!

\isualisation size: | MNormal

ar

Color Balance

Brightness:

Contrast:

Saturation:

Hue:

| Reset To Defaults |

[ leose

Figure 8.82: Customising Display Settings

6. When watching a DVD, you can use the various options provided in the Go menu to navigate inside the DVD. To skip to
the next frame, on the Go menu, click Skip Forwards.

@ RETET
Movie Edt Wiew Go Sound Help

i DVD Menu

Playlist =

Title Menu .
Audio Menu [> cdromo
Angle Menu

[ Chapter Menu

B MNext Chapter/Movie
¥l Previous Chapter/Movie

A skip to...
4> Skip Forwards

<K Skip Backwards

Tirme:

1 54 R = | il

Playing | 20115/ 2:10:22

Figure 8.83: Navigating Inside a DVD

7. You are taken to the next frame in the DVD. If you do not want to view the side bar when playing the DVD, click the
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Sidebar button.

Movie Edt Wiew Go Sound Help

Playlist =

-
> cdromo .

Time: il

i @ |2 sdsbar] (4] —| [

Playing | 23:06  2:10:22

Figure 8.84: Hiding the Sidebar

Tirme:

0 k4 e i Ersldebaré

Playing | 26:28 [ 2:10:22

Figure 8.85: Viewing the DVD

8. This hides the side bar and now you can view the DVD on a larger space and simultaneously, have all the playback controls
right in front of you.

8.8.2 Backing up DVDs

Note:
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If you have a collection of old and not-so-easy-to-find DVDs, you may wish to back up these on your computer or create extra
copies of them. You may even want to extract certain tracks from your DVD and watch it later. To do so, Ubuntu provides you
with a number of DVD backup applications or DVD rippers. Although these applications are not included in Ubuntu by default,
you can download and install them from the Ubuntu repositories. Some of these applications are:

* Thoggen

* K9copy

e dvd:rip

* HandBrake

Backing up DVDs Using Thoggen Thoggen is a DVD backup utility for Linux, based on GStreamer and Gtk+. This application
is designed to be easy-to-use. Rather than exposing the complexities of the DVD ripping process, which many other applications
tend to do, it tries to simplify the process for average users by offering sensible default options.

Thoggen includes certain key features:

* Is easy to use and has a nice graphical user interface (GUI)
 Supports title preview, picture cropping, and picture resizing
* Provides language Selection for audio track

* Encodes into Ogg/Theora video

¢ Can encode from local directory with video DVD files

* Is based on the GStreamer multimedia framework, which makes it fairly easy to add additional encoding formats/codecs in
future.

Thoggen is still beta software, but should work fine nevertheless. It is advisable, however, to check the list of known issues at
http://thoggen.net/download/.

To be able to back up your DVD using Thoggen, you need to first install it. You can easily find this application in the Universe
repository of Synaptic Package Manager and install it on your computer.
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File Edit Package Settings Help

I ey
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thoggen
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0.6.0-2ubuntul

[« l

IDVD backup utility based on GStreamer and Gtk+

(e l

D Thoggen is designed to be easy and straight-forward to use. It attempts
»

Sections

to hide the complexity many other transcoding tools expose and tries to

offer sensible defaults that work okay for most people most of the time.

Features:

Origin

* Easy to use, with a nice graphical user interface (GUI)

* Supports title preview, picture cropping, and picture resizing.

|
‘ Status
|
|

Custom Filters

S S WS i W

* Language Selection for audio track (no subtitle support yet though)

* Encodes into Ogg/Theora video

[ Search Results

* Can encode from local directory with video DVD files

1 packages listed, 1163 installed, 0 broken. 0 to installfupgrade, 0 to remove

Figure 8.86: Installing Thoggen

1. On the Applications menu, point to Sound & Video and then click Thoggen DVD Ripper.
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Extracts Video from your DVDs

Figure 8.87: Launching Thoggen

2. The Thoggen window appears. As a first step to backing up your DVD, it simply asks you to select the specific tracks on
the DVD that you want to back up. Specify the tracks by selecting the corresponding check boxes and then click OK to
proceed.
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Figure 8.88: Specifying the Tracks to Back up

3. In the next step of the backing up process, you are allowed to view and configure some of the settings according to your
requirements. You can select the picture size from the corresponding drop-down list and define the output crop, by clicking
the Configure Cropping button. Otherwise, you cam simply click OK to accept the default settings and continue with the
process of backing up your DVD.
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Figure 8.89: Changing Default Settings

4. The DVD backing process starts immediately. You can view the progress of the current as well as the entire process in the
Progress section of the Thoggen window. Thoggen takes quite long to backup a DVD. However, the final output is of a
very high quality.
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Figure 8.90: Backing up DVD

8.9 Playing Online Media

Ubuntu provides you with tools to directly play music and videos available on the Internet. You can listen and watch online
videos and audios directly from within your browser but may require to install some special player for this. Your ability to watch
or listen to online media depends on how the provider of the music and video has made them available.

8.9.1 Watching Videos in a Web Browser

Note:

You can play many of the videos available on the Internet directly from within your browser. For example, You can watch the
Google videos and the You Tube videos directly in your FireFox window without installing any special player or additional
browser plugins. The following screenshot displays a video being played inside the Firefox window:
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Figure 8.91: Watching Video in a Web Browser

However, depending on the format of the video that you want to watch, you may also require to download and install certain
additional browser plugins. Some of the plugins available for the default Firefox web browser are:

* Totem Xine plugin: Install the totem-xine-firefox-plugin package from the "Universe" repository.
* Totem gstreamer plugin: Install the totem-gstreamer-firefox-plugin package from the "Universe" repository.
* Mplayer plugin: Install the mozilla-mplayer package from the Universe repository

* Flash plugin: install the flashplugin-nonfree package from the "Multiverse" repository

The plugin installation process depends on the framework you use. If you use Totem-gstreamer, the default movie player included
in Ubuntu, you need to install the totem-gstreamer-firefox-plugin package. However, to enable playing streaming video in your
browser, you need to first install the Microsoft Windows codec and then install the totem plugin.

You can even install an additional mediaplayer, such as RealPlayer 10, to watch online video streams in Realmedia formats.
When you have installed all the above mentioned plugins and codecs, you can watch RealMedia files even with your default
media player, such as Totem. But, you may also want to install RealPlayer on your computer because RealPlayer supports
streaming RealMedia files slightly better than other players.

The RealPlayer, developed by RealNetworks, supports a number of audio and video codecs such as realaudio, realvideo 10, mp3,
ogg vorbis and theora, h263 and AAC. The RealPlayer for Linux is available in the Canonical commercial repository and can
also be freely downloaded from the RealPlayer web site.

RealPlayer is a proprietary software and is not supported by the Ubuntu community.

Installing RealPlayer As mentioned above, the realPlayer for Linux is available in the Canonical commercial repository. Ubuntu
does not include this repository by default. Therefore, you will first need to add Canonical’s commercial repository to your
system. Once the repository is added, you can search for the Realplayer package and then install it on your computer.

1. You can now access the realPlayer from the Applications menu. To access RealPlayer, on the Applications menu, point to
Sound & Video and then click RealPlayer 10.
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Figure 8.92: Launching RealPlayer

2. The RealPlayer Setup Assistant is displayed to guide you through the set up of the RealPlayer. Click Forward to start
the set up process.
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Welcome to RealPlayer
Click "forward" to set up RealPlayer.

I #]j Quit

@) Forward

Figure 8.93: Initiating RealPlayer Set up

3. After reviewing the release notes of the RealPlayer 10, click Forward again to proceed.

|Release Notes

| Please review the release notes.
RealPlayer 11.0.1.1056 for Linux
Release Motes
September 2008
The RealPlayer 11.0.1.1056 for Linux is a desktop media

| player that includes support for RealAudio, Realvideo,
| MP3, Flash 4, MP4 Audio, Windows Media and other

| ogancel I | &aBack | [ é)ﬂeﬂj

Figure 8.94: Reviewing realPlayer Release Notes

4. Before installing the RealPlayer application on your computer, you need to review the terms of the end user license
agreement and accept it to be able to proceed with the setup. Click Accept.
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| License Agreement

Please review the terms of the end user license
agreement, By clicking "accept" you indicate that you
accept the terms of the license agreement

| REALMNETWORKS, INC.

END USER LICENSE AGREEMENT

REALMETWORKS PRODUCTS AND SERVICES

REDISTRIBUTIOM NOT PERMITTED

License for RealMetworks Products and Services
IMPORTANT -- READ CAREFULLY BEFORE USING THIS =

‘View RealMetworks Privacy Policy...| M Accept

| ogancel H (= Back H w9 Next |

Figure 8.95: Accepting the License Agreement

5. You have reached the final screen of the Realplayer setup Assistant. Specify the provided options and click OK to complete
the set up.

[Almust Finished

The setup assistant can configure your
mozilla helpers, and check far any player
|updates,

| @ Check for updates

® Configure Mozilla helpers

logancel ‘ ‘ @@ Back H & Einish |

Figure 8.96: Completing the Set-up Process

6. The RealPlayer window is displayed, indicating that the set up was successful. Now you can watch online streaming
media in the RealPlayer.
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Figure 8.97: The RealPlayer Window
7. To start viewing the online video of your choice, launch Firefox and navigate to the Web page from which you want to

view the streaming media.
8. On the Web page, click the link to open the video of your choice.
==

@ HEAIVIDEOS = MozillatRretox
File Edit View History Bookmarks Tools Help
- & S httpiwww.babylons.org.ukfvideos html [+ B Cl~
(4 #PGetting Started [ Latest BBC Headlines
%] =

5 REALVIDEOS

BABYLONS UK

|G| realvideos - Google Search

babylonS.org.uk

Done

Figure 8.98: Selecting the Link to the Online Video

9. You are asked to specify whether you want to open the linked file in RealPlayer or save it to your computer. To view the

video as online streaming media, accept the default selection and click OK.
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Figure 8.99: Viewing Video as Streaming Media

10. The Downloads dialogue box displays the progress of the download. After the file is downloaded to your temporary
Internet folder, the video starts playing in the RealPlayer window.
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lla Firefox = |E=DE3

|

babylons.ram
Done Remove

“-?
D
=

ukpvideos.html v @1'

GTk2-BlueHeart tar.gz

Done L; -

e BB

5 BB
<
(D

GTK2-Pharago tar.gz
Daone (& HealPlayer =iBabylons’

File Play View Tools Favorites Help

GDM-Konwalia tar.gz

All files downloaded to: &
—

L. »

Starring

BRUCE BOXLEITNER

mm Cantain | Inhn Shacicrizam

=

k 1

\F| E| \@ — T

Playing (520 kbps) 0:02 / 0:57

Figure 8.100: Watching Online Video in RealPlayer

11. You can add the link to your Favorites list to be able to view the video again without searching for it on the Internet. To
save the video as a Favorite, on the the Favorites menu, click Add to Favorite.
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Figure 8.101: Saving a Video as Favourite

12. The video is now saved as your favorite. In future, you can view this video directly from inside your RealPlayer by
selecting the link from the Favorites menu. You can also play an online video directly from inside the RealPlayer by
specifying the location of the video. To do so, on the File menu, click Open Location.

& LR a0 L V)

File Play View Tools Favorites Help

[L2 Open File... ctrl+0
[- | Open Location... ctrl+L
Clip Properties »
1. babylons-2.ram
2. babylons-1.ram
3. babylonS.ram And
‘R JURASIK
& Quit il s Londo Mollari
(] [=] (@] =—=
Playing (520 kbps) 0:45 [ 0:57

Figure 8.102: Viewing Online Video Directly from RealPlayer

13. Type the URL or the file path of the video in the Open Location dialogue box and click OK to start playing the online
streaming video.
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Figure 8.103: Specifying Video Location

8.10 Editing Videos

In addition to viewing movies and videos, Ubuntu also provides you tools to help you edit a video. The tools available with
Ubuntu include:

Kino: An advanced video editor, Kino captures video to disk in Raw DV and AVI format. It allows you to load multiple video
clips, cut and paste portions of video, and save it to an edit decision list in SMIL and XML formats.

Stopmotion: Stopmotion is a free application for creating stop-motion animation movies. It enables you to create stop-motions
from pictures imported from a camera or from the harddrive, add sound effects and export the animation to different video
formats such as mpeg or avi.

Subtitle Editor: Subtitle Editor is a GTK+2 tool to edit subtitles for movies and videos. you can use it for creating new subtitles
or to transform, edit, correct and refine existing subtitles. This programme also shows sound waves, which makes it easier to
synchronise subtitles to voices.

Pitivi Video Editor: Pitivi Video Editor is a non-linear editor, which allows you to easily edit audio and video projects. Using
Pitivi, you can capture audio and video, mix, resize, cut, and apply effects to audio and video sources. It also allows you to save
the projects in any format supported by the GStreamer framework.

8.10.1 Editing videos using Pitivi video editor

Pitivi Video Editor is not included in Ubuntu by default. It is available in the Universe repository of Ubuntu. You can install
Pitivi using Synaptic Package Manager.

1. On the Applications menu, point to Sound & Video and then click Pitivi Video Editor. The Pitivi vo 11.1 window opens.
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2. The main Pitivi interface is divided into a number of panes. You can use the various buttons on the task bar to perform
tasks such as opening, importing, adding, viewing and saving video clips. To edit a video clip, first import the clip in the
Pitivi Video editor by clicking the Import Clips button.

@
File wiew Help

Contain imported L m, Py View video clips

video clips

Import clips...  Render project | Fullscreen

~ <
Yamara]iuniuave.... 00m40s
Video: 320 x 240 pixels a...

e Audio: 2 channels at 320...

i

Add selected clips to the
time line by draging
them here

= 00mO0S000 / 00M40s039

Yamaraj_on_Ldg

00m40s

Figure 8.104: The Pitivi Interface

3. In the Import a clip dialogue box, navigate to the folder from where you want to import the video clip, select the single or
multiple clips to be edited and click Add to import it in the Pitivi window.
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Figure 8.105: Importing Video Clips in Pitivi

4. The selected video clip is now imported into the Pitivi Video editor. You can double-click the video clip to view it in the
right pane. Click the Stop button on the control bar to stop the playback.




Ubuntu Desktop Training
298 / 348

3
File Edit \iew Help

+ & =
= Save SEve As Import clips... = Fender project | Fullscreen  Advanced view

~ Video: 654 x 480 pixel ..
Audio: 2 channels at ...
Clip 04.dv 00m05s

Video: 654 x 480 pixel ..
Audio: 2 channels at ...

Clip 05.dv 00mO08s
Video: 654 x 480 pixel ..
Audio: 2 channels at ...

Clip 03.dv 00ml3s
Video: 654 x 480 pixel ..
Audio: 2 channels at ...

[*]

Clip 06.dv 00mo03s
Video: 654 x 480 pixel ..
Audio: 2 channels at ...

Clip 216.dv 00m1l7s
Video: 654 x 480 pixel ..
Audio: 2 channels at ...

Clip 217.dv 00mlos
Video: 654 x 480 pixel ..
Audio: 2 channels at ...

|

44 An error occured while importing |Q| <Kl lD l B 00:00:03.183 / 00:00:05.505

Add clips to the timeline
by dragging them here.

Figure 8.106: Viewing the Imported Video

5. To edit the imported video clip, you need to drag them to the bottom pane to add them to the time line and then select the
Project Settings option from the File menu. This opens the Projects Settings dialogue box.




Ubuntu Desktop Training
299 /348

.8

File Edit \iew Help

EaveAs Import clips... = Fender project | Fullsereen  Advanced view

[+

I:;'q Project settings

oF Import clips... Hatnthe

2F Import folder of clips. ..
00mO08s

o CMQ foomiss
Video: 654 x 480 pixel ..

Audio: 2 channels at ...

Clip 06.dv 00m03s

Video: 654 x 480 pixel...
Audio: 2 channels at ...

_ Clip 216.dv 00m17s
Video: 654 x 480 pixel .
Audio: 2 channels at ...

Clip 217.dv 00mlos
Video: 654 x 480 pixel..
Audio: 2 channels at ...

4 An error occured while importing |Q| (=] Dl B 00:00:03.183 / 00:00:05.505

Add clips to the timeline
by dragging them here.

Figure 8.107: Displaying the Project Settings Dialogue Box

6. In the Projects Settings dialogue box, you can edit the various aspects of the selected movie clip by defining various
specifications according to your preferences. You can use the Video Output section to define the height, width and the

frame rate of the video. Similarly, you can define the audio specifications under the Audio Output section. Click OK after
specifying your preferences.
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Project Settings
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Export to
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) Audio Codec: [Vorbis audio encoder [vorbisenc] = [Settings}

Vfidea Codec:)| Theora video encoder [theoraenc] - [Settings}

l ogancel

=

Figure 8.108: Specifying Edit Preferences

7. You return to the Pitivi window. To start applying your specifications on the selected video clip, click the Render project
button. This displays the Render project dialogue box. You can use the Modify button on the Render project dialogue
box to further modify your specifications for the video clip. Otherwise, click the Choose file button to specify a file name
for the edited video clip.
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PiTiVi v0.11.1 == EY

Clip 04.dv 00mo5s
Video: 554 x 480 pixel... — |
Audio: 2 channels at ... i

1 Output file: Choose File | [

clip 04.dv Settings
Video : 320 x 240 pixels at 30.00 fps (smokeenc)
Audio : 2 channels at 44100 Hz (18 bits) (vorbisenc)

=) o Please choose an output file |

@J [ @ pecora ‘

Figure 8.109: Specifying the Output File

8. This opens the Choose file to render to dialogue box. Use this dialogue box to assign a name for the edited video clip and
specify the location where you want it to be saved. After specifying these details, click OK to continue.
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Figure 8.110: Selecting the File to Render to

9. The name of the file now appears on the Output file button. Start editing the video clip by clicking the Record button.

Hender project

Output file: baseball

‘Settings a
Video : 320 x 240 pixels at 30.00 fps (smokeenc)
Audio : 2 channels at 44100 Hz (16 bits) (vorbisenc]

Modify .

| |
‘ ﬁglose

‘ @ Record ‘

Figure 8.111: Editing the Video File

10. The Pitivi Video Editor has started rendering a new project based on your specifications. You can view the progress of
the process in the progress bar. Once the rendering is complete, click the Close button on the top-right corner to exit the
Render project dialogue box.
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Output file; basehall
Settings-

Video : 320 x 240 pixels at 30.00 fps (smokeenc)
Audio : 2 channels at 44100 Hz (16 bits) (vorbisenc)
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Figure 8.112: Project Rendering Progress Indicator

11. The newly edited video clip is now saved at the specified location.

" Videos = Hle B
File Edit View Go Bookmarks Help

. . #® . -

Bacl Forward Up Stop reload
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— FACTORY_IMAGE
& Network Servers

@ Trash

£ Documents
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|=71 Dirtuirac Bt

"baseball" selected (73.6 KB)

Figure 8.113: The Edited Video Clip

8.11 Lesson Summary

In this lesson, you learned that:

» Software usage and distribution is controlled by laws and legislations unique to each country.
* When using or redistributing proprietary media formats, you should be aware of the associated patent or copyright laws.
* You can use Rhythmbox to play and organise music, listen to Internet radio and import music from CDs.

* Using Sound Juicer, you can play audio tracks direct from the CD, extract audio tracks and convert them into audio files in
various file formats. In addition, the default audio CD/DVD burner for Ubuntu, Brasero, can be used to create audio and data
CD/DVDs.
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 Playback of proprietary multimedia formats can be enabled in Ubuntu by installing additional multimedia codecs from the
repositories.

* Ubuntu offers you tools to play music from your iPod through gtkpod.

* Sound Recorder can be used to create audio files in various formats.

* Audacity enables you to record and edit audio files.

* DVD playback in Totem Movie Player can be enabled by installing the required software packages.
* Thoggen is a DVD backup utility for Linux that can be used in Ubuntu to copy DVDs.

* Ubuntu provides you with tools to listen and watch online videos and audios directly from within your browser or in a medi-
aplayer such as RealPlayer.

« Pitivi video Editor can be used to play and edit videos.

8.12 Review Exercise

Question: List the main features of a free software license.
Answer:

Question: Which is the default music player in Ubuntu?

e Totem

* Rhythmbox
¢ Audacity

* gtkpod

Answer:
Question: What are podcasts?
Answer:

Question: Which application is available in Ubuntu by default to play and extract audio compact discs?

e Xine
* RealPlayer
¢ Brasero

¢ Sound Juicer

Answer:

Question: In which formats does Sound Juicer enable you to extract audio files onto your computer?
Answer:

Question: From where does Sound Juicer retrieves retrieve the CD artist, title, and track data?
Answer:

Question: Name the default CD audio recording application available in Ubuntu?

Answer:

Question: Why do you need to install additional multimedia codecs in Ubuntu?

Answer:

Question: You can download and install multimedia codecs using the

Answer:
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8.13 Lab Exercise

Exercise 1: Playing Music Using Rhythmbox You have recently installed Ubuntu and want to play and organise your music
files, listen to music podcasts and Internet radio. List the steps that you would take.

10.
11.

12.
13.

. On the Application menu, point to Sound & Video and then click Rhythmbox Music Player.

To start importing individual music files into Rhythmbox, right-click Library and click Import File.

. In the Import File into Library dialogue box, navigate to the folder from which you want to import the files.

Select the files that you want to import and click Open.
Select the music tracks that you want to play and the Play button to start playing the selected track.

To play music from a podcast of your choice, right-click the Podcast option in the Source list and select New Podcast
Feed.

Enter the podcast feed URL in the New Podcast Feed text box and click Add.

To play a podcast episode, select the episode that you want to play and click the Play button.
To listen to Internet radio, click the Radio source in the Source pane.

Double-click on the radio station of your choice to listen to the streaming media.

To add a new radio station to the existing list of stations, click New Internet Radio Station and paste the URL of the new
radio station in the URL of Internet radio station text box.

Click Add to add the radio station in the existing list.

You can add many more Internet radio stations in the same way and listen to your favourite radio stations with just a click
of your mouse.

Exercise 2: Playing and Extracting Audio CDs You have built up an impressive CD collection over the years and you would
like to play these on your Ubuntu desktop, retrieve details about the music tracks and extract your favourite music tracks onto
your computer in a compatible format to be able to play them later. List the steps that you would need to perform to do all that
you want.

A

. Insert an audio CD in the CD drive of your computer. The Sound Juicer CD player and ripper is launched automatically.

Notice that Sound Juicer has fetched the tracks’ information from MusicBrainz.org.
To play the tracks of your choice, select the particular tracks by selecting the corresponding checkboxes.

Click the Play button to play the tracks.

. Insert the audio CD into your computer’s CD drive.

On the Edit menu, click Preferences.

In the Preferences dialogue box, click the Output Format drop-down list.

Select the format of your choice from the Output Format drop-down list.

Select the directory where you want to extract the files from the Music Folder drop-down list.

Click Close to exit the Preferences dialogue box.

In the Sound Juicer window, select the tracks that you want to extract by selecting the corresponding check boxes.

Click the Extract button to start extracting the files.
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9.

10.

Sound Juicer notifies you after the selected tracks are extracted successfully. Click Open to view the tracks copied on your
hard disk.

The CD audio tracks are now copied as audio files on your hard disk. You can listen to these tracks by simply double-
clicking them.

Exercise 3: Burning Audio CDs You have recently discovered a Web site from where you can freely download hundreds of
songs. You do not want these files to occupy the precious space on your computer’s hard drive. Therefore, you want to copy
these files on audio CDs, so that you can listen to them in future without taking up space on the hard drive.

. Insert a blank (recordable) CD in the CD drive of your computer.

Click the click the Make Audio CD button. This launches the Brasero Disc Burning application.
Click the New Audio Project button.
Navigate to the desired folder with the files you wish to add to display its contents.

Select the specific audio files that you want to be copied and click the Add button or simply drag each file name to the
Files area in the right side of the project window.

Once you are sure of the files to be copied to the disk, click the Burn button to start writing the audio files from your
computer to the CD.

The Disc Burning Setup dialogue box displays. Click Burn to continue.

Brasero now starts writing the music files to the media disc.

Exercise 4: Playing Proprietary Multimedia formats You have a huge collection of music in MP3 format stored on your
computer and want to play these music files on your Ubuntu desktop. List the steps that you will need to take to be able install
the required multimedia codecs.

© ® =N

10.
11.

12.
13.

. On the System menu, point to Administration and then click Synaptic Package Manager. The Synaptic Package

Manager window opens.

The Multiverse and Restricted repositories are not activated by default in Ubuntu. To activate these repositories, on the
Settings menu, click Repositories. The Software Sources dialogue box is displayed.

To enable the Multiverse and Restricted repositories, select the third and fourth check boxes available on the Ubuntu
Software tabbed page, and click Close to exit the dialogue box.

You may receive a notification that your repository information has changed. Click Close to exit this message.

Once you return to the Synaptic Package Manager window, you are required to click the Reload button to apply your
changes.

On clicking the Reload button, the system starts checking the repositories for new, removed or upgraded software packages.
To install a software package, you need to first locate the package in the Synaptic Package Manager window.

To initiate a search for a specific package, click Search.

In the Search field, enter the name of the software package that you are looking for. Click Search to begin the search.
Right-click the package to be installed and select Mark for Installation.

Once all the required packages are marked, click Apply to start downloading the packages. The Summary dialogue box
is displayed.

To go ahead with the marked installations, click Apply on the Summary dialogue box.

After all the mark software packages are downloaded and installed, the Changes Applied dialogue box is displayed. Click
Close to exit the Changes Applied dialogue box.
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14.

The check box corresponding to the recently installed software package has changed to green, indicating that the software
has been installed successfully.

Exercise 5: Playing DVDs One of your friends has recently given you a DVD gift box set of your favourite movies of all times.
Now, you want to play this DVD in your Ubuntu desktop and enjoy your favourite movies.

A S )

10.

. Install the following software packages from the Universe and Multiverse repositories using the Synaptic Package Manager.

* gxine

* libdvdcss2

* libdvdnav4
¢ libdvdplayO
* libdvdvread3

Install the Ubuntu Restricted Extras software package from the Ubuntu repository.

Insert the DVD into the DVD drive of your computer. This will automatically launch the Totem and the DVD will start
playing.

To view the DVD in full screen mode, on the View menu, click Fullscreen. Alternatively, you can simply press F on your
keyboard.

You can enjoy the DVD in full screen mode. At any point of time, while watching the DVD in fullscreen mode, you can
press ESC and return to the Totem window.

To configure the preferences settings, on the Edit menu, click Preferences.

After specifying your preferences, click Close to exit the dialogue box.

To skip to the next frame, on the Go menu, click Skip Forwards.

You do not want to view the side bar when playing the DVD, click the Sidebar button.

This hides the side bar and now you can view the DVD on a bigger space and simultaneously, have all the playback controls
right in front of you.
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Chapter 9

Ubuntu Help and Support

OBIJECTIVES

* How to seek help for Ubuntu from various sources such as system documentation, online documentation, commercial support,
community support, Launchpad and The Fridge.

9.1 Introduction

Help and support for Ubuntu is readily available through a number of sources so you need not panic if you run into a problem.
Essentially there are two channels for accessing support:

* The first level is: Free, community based and involves system and online documentation, mailing lists, forums, IRC channels
and Launchpad.

* The second level is: Paid for, commercial services through Canonical itself and / or various partners.

-@j Applications Places

5@

g Preferences r

System ¢

Lol Administration v
b o

o Help and Suppert
€ About GNOME

Get help with Ubuntu

-I:} About Ubuntu

(8] auit..

Figure 9.1: Accessing System Documentation
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9.2 System Documentation

The first resource that you should explore is the offline system documentation. The Ubuntu Documentation Team maintains and
updates the documentation for each release. This documentation is very reliable and available in different languages.

Ubuntu System documentation is organised into topic based help, including answers to common questions. It is accessed by
clicking the Help and Support button located under the System Menu. The following screenshot shows the home page of the
Help and Support offline system documentation.

File Edit Go Bookmarks Help

P
@]

Search: | |

Help Topics
Ubuntu Help Center

Topics
P Welcome to the Ubuntu Help Center

?
New to Ubuntu? To find help, insert a keyword in the search bar

Adding and Removing

Common Questions
Software Q

E * Connecting to the internet
Files, Folders and ® Enabling desktop effects
Documents s Playing music
* Importing photos
Customising Y our s Keeping your computer updated
Desktop il
Can't find the answer?
Internet
The Ubuntu community provides extensive free
Music, Videos and support
Photos

Canonical, its partners and approved companies
provide comrmercial technical support

[4]

Aesimtinrs Toamle

Figure 9.2: System Documentation

New to Ubuntu? This section introduces you to the wonderful world of Ubuntu including an easy to use guide if you are migrating
from Microsoft Windows to Ubuntu. Also in this section, the help guide will explain how to use your desktop, the role of the
administrator and basic computer skills. A great resource for any newcomers and a top-up to this desktop course.

Some applications do also offer access to the help system through the Help menu or keyboard shortcut F1.

One of the great features of the system documentation is the ability to search the documentation to help solve the problem
you have. Simply type in the term you are looking for and the system will search all the documents and guides with related
information.

9.3 Online Documentation

Note:

The online Ubuntu documentation is available at https://help.ubuntu.com. There are two different types of documentation avail-
able on this site, official and community.

The official documentation is the documentation that is included with your Ubuntu installation by default and is locally accessible
from your Ubuntu desktop. You can also access this documentation on the Internet at the Web site mentioned above.

The following screenshot shows the home page of the Ubuntu documentation site:
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Fle Edit View History Bookmarks Tools Help
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[EIMost Visited = @ Getting Started [)]Latest Headlines =

| search

documentation Official Documentation

‘.‘
< ubuntu

Official Ubuntu Documentation

This site is where you can find the official documentation developed and maintained by the Ubuntu Documentation Project.

Choose your version of Ubuntu below to access the documentation for that version. If you don't find what you are looking for,
visit the community contributed documentation for even more material!

= Ubuntu 8.10 - the current stable version, released in October 2008, codenamed inirepid ibex.
* Ubuniu 8.04 LTS - the current long term support version, released in April 2008, codenamed Hardy Heron.
= Ubuntu 7.10 - previous stable version. released in October 2007, codenamed Gutsy Gibbon.

» Ubuntu 6.06 LTS - previous long term support version, released in June 2006, codenamed Dapper Drake.

The material in this document is available under a free license, see Legal for details
For informaticn on contributing or to report a problem, visit the Ubuntu Documentation Project

Dane

[«

Figure 9.3: Online Documentation

The documentation is classified according to the various Ubuntu releases, such as Ubuntu 8.04 LTS, 7.10 and 6.06 LTS.

To access the official documentation locally from your Ubuntu desktop, without connecting to the Internet, on the System menu,
click Help and Support. You can also use the Help icon on the top panel of the desktop.

The information available in the official documentation will be enough to guide you through most topics and problems. However,
if you are unable to find an answer to your queries here, you can look for answers in the second type of documentation available on
this site. This is documentation created by the community, without following the stringent quality control process of the Ubuntu
Documentation Team. Access this documentation via the tab labelled Community Docs. The community documentation is
stored on a Wiki, which allows the documentation to be changed quickly. While the community documentation covers more
topics and some subjects in greater depth than the official documentation, the lack of quality assurance control and especially

maintenance makes it a slightly less reliably alternative.

The community documentation is a large collection of community-contributed documents, primarily covering the following

topics:

* Migrating from other operating systems, such as Microsoft Windows and Red Hat

* Post-installation configuration for a variety of tasks such as

— Maintaining your computer

— Connecting and configuring hardware

The following screenshot displays the information available in the community documentation:
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Figure 9.4: Community Documentation

The community documentation is also classified under various categories. You can select the desired category from the page
index at the right of the page. You can also use the Search field in the top-right corner of the page to look for specific information
within the community documentation. Be aware that Titles will restrict the search of your term to the pages titles only. If a
search via titles does not produce any results, a full Text search may find the right page.

You can also find relevant information on the CommonQuestions page. Access the CommonQuestions page by clicking the

Common Questions link on the community documentation page.

The following screenshot displays the CommonQuestions page on the Ubuntu Web site:

Fle Edit View History Bookmarks Tools Help
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Community Documentation
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< ubuntu

documentation

Login to Edit

CommonQuestions

Below is a selection of common questions with answers that may help you if you are new to Ubuntu. Choose a topic
from the table of contents or search this page by pressing Ctrl+F in your browser and entering a search term.

| Contents

1. About Ubuntu
1. Relsases and Version Numbers
2, Related Projects: Kubuntu, Edubuntu and
Xubuntu
3. Ubuntu and Debian?
2. Installing Ubuntu
1. CDs and DVDs
2. Network and Other Installation Methods
3. Using Ubuntu
. Installing software
. Repositories and sources.list
Upgrading
. Administration: Root vs Sudo
. MP3/Divx/DVDs/Quicklime/Realmedia
[Flach/ lava _ k]
Dane help.ubuntu.com &

o os oW

Figure 9.5: The CommonQuestions Page

Additional help is available to you in the form of Ubuntu screencasts. You can click the Ubuntu Screencasts link on the
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Community Documentation page to access a number of videos on using and installing Ubuntu. Each video is created with the
aim of educating new users of Ubuntu. Each video is available in three sizes, large, medium and small, and two formats, OGG
and Flash.

The following is an example of a screenshot from a video on installing applications:

I installing tapplications theora H00kvoThis /b BxA3 2,000 (application) 0agiob]
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| Transferring data from static.screencasts.ubuntu.com... |

Figure 9.6: The Screencasts Page

These screen casts are licensed under the Creative Commons Attributions-Share Alike 3.0 License. You are free to modify, share,
sell or distribute these screencasts as long as the attribution to Ubuntu is intact.

9.4 Community Support

The vast and ever growing Ubuntu community also offers a range of free support options for your Ubuntu desktop. Apart from
the community documentation, the Ubuntu community provides support through:

* Mailing lists
* Web Forums
* IRC Channels
* LoCo Teams

¢ The Ubuntu Team Wiki

9.4.1 Mailing Lists
To get help on a specific problem, all you need to do is to send your query through e-mail to the relevant mailing list and you will
get a quick response from the team.

You will need to subscribe to the mailing list first by visiting the Ubuntu Mailing Lists Web site at https://lists.ubuntu.com/. The
Mailing Lists page displays all the public mailing lists to which you can subscribe and their topic.

The following screenshot displays the Mailing Lists page:



https://lists.ubuntu.com/
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Mailing Lists

Below is a listing of all the public mailing lists on lists.ubuntu.com. Click on a list name to get more information
about the list, or to subscribe, unsubscribe, and change the preferences on your subscription.

List administrators, you can visit the list admin overview pade to find the management interface for your list

If you need help with your Ubuntu system, please try one of the Community Support Lists below, If you are
having trouble using the lists themselves, please contact mailman@lists.ubuntu.com.

Categories

. Ubuntu Announcements

. Community Support

. Announcemert Lists

Development Lists

Quality Assurance and Related Lists

Bug Lists

. Package Upload and Automatic Notlfication Lists
. Ubuntu Worldwide LoCo Teams

. Localization Lists

. Other Ubuntu Projects and Groups
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=

Done

lists.ubuntu.com [

Figure 9.7: The Mailing Lists Page

To get help for your Ubuntu desktop, you should go to the Community Support and select the ubuntu-users mailing list. This
will take you to a page like the following:
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ubuntu-users -- Ubuntu user technical support, not for general discussions

About ubuntu-users English (USA)

To see the collection of prior postings to the list, visit the ubuntu-users Archives,
Using ubuntu-users

To post a message to all the list members, send email to ubuntu-users@lists. ubuntu.com

You can subscribe to the list, or change your existing subscription, in the sections below.
Subscribing to ubuntu-users
Subscribe to ubuntu-users by filling out the following form.

You will be sent email requesting confirmation, to prevent others from gratuitously subscribing you.
This is a hidden list, which means that the list of members is available only to the list administrator.

Your email address: [ ]

Your name (optional): | ]

You may enter & privacy password below. This provides only mild security, but should
prevent cthers from messing with your subscription. Do not use a valuable password as
it will occasionally be emailed back to you in cleartext.

If you choose not to enter a password, cne will be automatically generated for you, and it =

Done

lists,ubuntu.com &5

Figure 9.8: Subscribing to Ubuntu-users Mailing List

You need to provide your e-mail address, your name and a password in the appropriate boxes and then click the Subscribe button.

When you subscribe to a mailing list, a confirmation mail is sent to your provided e-mail to verify that it is your address. To
activate this mailing list, you need to first open your e-mail account and then click the link provided in the confirmation e-mail.
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Figure 9.9: Confirmation Mail

Clicking this link takes you to the Confirm subscription request page, where you can verify the details of your subscription
request and subscribe to the selected mailing list by clicking the Subscribe to list ubuntu-users button.
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Confirm subscription request
Your confirmation is required in order to complete the subscription request to the mailing
list ubuntu-users. Your subscription settings are shown below; make any necessary
changes and hit Subscribe to complete the confirmation process. Once you've confirmed
your subscription request, you will be shown your account options page which you can
use to further customize your membership options.

Note: your password will be emailed to you once your subscription is confirmed. You can
change it by visiting your personal options page.

Or hit Cancel my subscription requestif you no longer want to subscribe to this list.

Your email address: wwindsorll@gmail.com
Your real name:| Wwindsor

Receive digests? ¢ No ¢ Yes

Preferred language: | English (USA) ~|

ZLi 1 N 1
Done i lists.ubuntu com &

Figure 9.10: Confirm Subscription Request Page

Finally, you will receive a confirmation message saying that your subscription request to the selected mailing list has been
confirmed.
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Subscription request confirmed

You have successfully confirmed your subscription request for
"wwindsorl l@gmail.com” to the ubuntu-users mailing list. A separate confirmation

message will be sent to your email address, along with your password, and other useful
information and links.

You can now proceed to your membership login page.

ubuntu-users list run by mako at ubuntu.com, brian.murray at ubuntu.com
ubuntu-users administrative interface (requires authorization)
Overview of all lists.ybuntu.com mailing lists

Delivered by Mailman Python Powered Gnu's Not Unix
version 2.1.8

Done

| lists.ubuntu com &

Figure 9.11: Confirmation of Subscription Request Page

Soon after, you will receive a welcome mail containing the mailing address of your selected mailing list and you will then be
able to send e-mail messages to this list. Before sending your first query, it is good practice to read a bit of the archive, as the

topic may have already been covered. The archive will also give you an idea of how much volume to expect from a list and get a
"feel" of others who are active on the list.

It is possible that you will be flooded with many responses to your posting. The level of emails received can be controlled
by adjusting your preferences on the UserCP (User Control Panel). You can use this panel to customize your profile and

preferences too.

The mailing lists archive is an excellent resource of information, as quite a few questions have been discussed on the lists already.
The archive can be seen as a memory for the mailing lists expertise.

9.4.2 Web Forums

Note:

Web forums are often an easier and more immediate alternative to mailing lists as you can receive help on various issues without

subscribing to a high-traffic mailing list. They are easier to use, available in a Web browser and are an ideal way for you to meet
other Ubuntu users and developers.

The following screenshot displays the home page of the Ubuntu forums Web site:
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Welcome to the Ubuntu Forums, we encourage you to REGISTER on our forums and participate in the community. Ubuntu is a
complete Linux-based operating system, fresly available with hoth community and professional support. By JOINING US today you
can participate in our active and growing community. Registering on our forum gets you access to post new messages, get support,
use private messages, download images from our gallery and much much moret
¥ =2
The Ubuntu Forum Community
Absolute Beginner Talk =
( 45.981 Threads ) ( 321,249 Feples )
The perfect starting place to find out more about computers, Linux and Ubuntu.
dualbooting XP/ubuntu on 2...- by amheuwr 1 Minute Ago
Main Support Categories =
(148,717 Threads ) ( 706,395 Replis )
Choose the most appropriate category for your regarding ANY Ubuntu/Kubuntu/ release.
| @) image my hard drive toa...- by Echbule 1 Miiite A6 =
Done

Figure 9.12: Web Forums

To access the Ubuntu forums, go to: http://ubuntuforums.org/ or http://www.ubuntu.com/community/forums.

The Ubuntu forums are entirely maintained and moderated by volunteers and are available in many languages such as Chinese,
Dutch, German, Finnish and French.

The following screenshot displays a view of the Ubuntu French forum:
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commencez par lire |es régles du forum ainsi que l'aide relative & Pratique pour le mois de Mars :
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Forums spécialisés | Wubi

Done
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Figure 9.13: Ubuntu French Forum

You need to register on the forum to be able to post messages and get support. To do this, click the Register link displayed on
the home page which will lead to the following page:
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“_s ubuntu

Search

Ubuntu Forums Rules

1~ Forum Rul

In order to proceed, you must agree with the following rules:

Forum Rules

Registration to this forum is freel We do insist that you abide by the rules and policies detailed
below. 1f you agree to the terms, please check the ‘T agree' checkbox and press the Register’ button

below. 1f you would like to cancel the registration, click here to return to the forums index

Forum Rules

Registration to this forum is freel We do instst that you abide by the rules and policies detailed

below. If you agree to the terms, please check the I agree' checkbox and press the ‘Register' button [+,
[J1 have read, and agree to abide by the Ubuntu Forums rules.

Register

Done

Figure 9.14: Ubuntu Forum Rules Page

Follow all the instructions on this and the following pages to sign on to the Ubuntu forum. You will then receive a confirmation
that your registration is complete.

You can now sign in with your new user name and password and start using the Web forum for posting new messages and
searching the existing ones. The postings on the Web forum are segregated into several categories based on their subject. To get
an answer for a specific question, you may first look into the related category. Each category contains threads to all the postings
already made under that category.

An alternate method to search the desired information is by using the Search option on the right of the home page. You can type
your question in the Search Forums field and run a search. It is more than likely that you will find your desired information in
these postings.

However, if you do not find the required information in the questions that have already been asked, you can create a new posting
on the Web forum. You are likely to receive an answer very quickly, otherwise the Unanswered Posts Team will pick up your
post within 24 hours.

9.4.3 IRC Channels

Note:
The IRC channels are a form of real-time Internet chat that enable users to talk directly (and immediately) with one another.

IRC channels are available on the freenode network, irc.freenode.net. The best channel for you to interact with other Ubuntu
users is #ubuntu. Other specialised channels related to Ubuntu variants, such as #kubuntu, #edubuntu and #xubuntu are also
available. In addition, channels related to bugs, development, LoCo teams, accessibility and documentation are also available.

To see a list of IRC channels and clients, go to https://help.ubuntu.com/community/InternetRelayChat.

There are many ways to connect to an IRC channel and one of them is by using the Pidgin instant messenger. Connecting to
Pidgin was covered in Lesson 3.

1. Open the Buddies menu to view the available options, and click Add Chat. This displays the Add Chat dialogue box.
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Buddies Accounts Toeols Help
[ NewInstant Message... Ctrl+M
Join a Chat... ctrl+C
@ Get User Info... ctrl 11
View User Log ctri+L
Show 4
Sort Buddies L4
4 Add Buddy. ctrl+8
| & Add chat.. |
4F Add Group...
&1 Quit cirl+Q
@ Avalable -

Figure 9.15: Buddies Menu

2. To interact with ubuntu users, type #Ubuntu in the Screen name field. Then click Add. This adds the Ubuntu users’
account to your Buddies List.

. Please enter an alias, and the appropriate information about
) the chat you would like to add to your buddy list.

Account: l ¥ wwindsor@ire.ubuntu.com (wwindsor) (IRC) :

Password; |

channel; [| ]
|
|

Alias: |

Group: | Jﬁ]
ogance\ [ Xl

Figure 9.16: Add Chat Dialogue Box

3. Notice that #ubuntu is added as an IRC account to your Buddy List. Double-click the account name to enter the IRC
channel for Ubuntu users.

< Buddies

@ #ubuntu

@ Avallable o

Figure 9.17: Buddy List

4. You have now entered the IRC channel for Ubuntu users. You can use the box at the bottom of the window to type your
messages, and press Enter to send them.
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Figure 9.18: IRC Channel for Ubuntu Users

9.4.4 LoCo Teams

Note:

The Ubuntu LoCo (short for ’Local Community’) teams are a vital resource for providing localised support. With the in-
credible success of Ubuntu around the world, the Loco project helps groups of Ubuntu fans and enthusiasts work together in
their regional teams to help advocate, promote, translate, develop and otherwise improve Ubuntu.You can access them through:

http://www.ubuntu.com/support/community/locallanguage.

The following screenshot displays the list of languages in which you can receive help and support on Ubuntu:

= - e 3 [‘ﬂihttplthww‘ubuntu‘corﬁfsuppurttcummun\tyf\ocallanguage "] l'\ s00gle Q)

[E] Most Visited = @ Getting Started [5]|Latest Headlines ~

» Products  ® Support  * Community  » Partners  » News

Search
Server User?

Take the Ubuntu server
survey today »

» Web Forums
» Maifing Lists Face-to-Face Local Support

& St (R Qur worldwide network of Local Community ("LoCo”) teams is providing a strong backbone to our already vast
» Launchpad and extensive Ubuntu community. Many of these teams provide free, face to-face local support, such as
one-on-one troubleshooting, group sessions, and presentations about Ubuntu. Why not go and see the full list

+ Local Language Support
of teams|

» Wiki

» Documentation Contents

1. Neon-English Support

Gﬁ Get Ubuntu

Figure 9.19: The LoCo Teams Page

To receive help and support on Ubuntu in your local language, select the desired language from the Non-English Support list.
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Support channels on IRC and mailing lists exist for Ubuntu users whose first language is not English. You are
welcome to join one of these or start your own.

An important part of the Ubuntu manifesto is your ability to use your software in your local language. Part of
that is ensuring that Ubuntu includes the best translations available for the Ubuntu deskiop software (and you
can help to improve those translations).

Another part of that commitment is helping to create mailing lists and IRC channels for Ubuntu users in
different languages.

If you want to start a local team or to join an existing one, visit https:/fwiki ubuntu.com/LoCoT eams
Bengali (Bangladesh)

® Website: hitp://www. ubuntu-bd org/

» Forum: http://forum.ubuntu-bd.ora/

= IRC: #ubuntu-bd on irc.freenode. net

» Mailing list: hitps://lists. ubuntu.com/mailman/listinfo/ubuntu-bd

Brazilian
» Website! htip://www.ubuntubrasil.org
« Forums: httpr/forum ubuntubrasil.org
= Wiki documentation: hittp://wiki. ubuntubrasil.org

= IRC: #ubuntu-br on chat.freenode.net

= Mniline lints It flinte (ihiimtin s fmailmandlistings koo e
Done
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Figure 9.20: Non-English Support Page

If you want to start a LoCo team or join an existing one, go to: https://wiki.ubuntu.com/LoCoTeams. To view the list of LoCo
teams, visit https://wiki.ubuntu.com/LoCoTeamList.

9.4.5 The Ubuntu Team Wiki

Note:

The Ubuntu Team Wiki is a central Web site that provides access to useful information on Ubuntu and the supporting Ubuntu

project. The pages are continually updated by the Ubuntu community members. The Ubuntu Team Wiki can be accessed at
https://wiki.ubuntu.com/.

The following is a screenshot of the Ubuntu Team Wiki home page:
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“* % Ubuntu Hel * Communit ; * Weekly Newsletter
Ubuntu Help
* Teams * Release Schedule

Welcome to the Ubuntu Community Team Wiki!

This is THE definitive place for members of the Ubuntu community to discuss ideas and store team-related
information.

Released (Current + Stable)

Hardy Heron B8.04 LTS April 24, 2008 Supported until April 2013 (Server) or April 2011 (Desktop)

Done

wiki.ubuntu.com &

Figure 9.21: The Ubuntu Team Wiki
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As an Ubuntu user, you can also contribute to the wiki content and edit any of the pages on this site. However, you must observe
the Ubuntu code of conduct while editing any content.

Although the official Ubuntu wiki is available only in English, many wikis exist through the LoCo Web sites. For instance, the
French wiki URL is http://wiki.ubuntu-fr.org. You can find other LoCo teams in https://wiki.ubuntu.com/LoCoTeamList.

For more information on editing the Ubuntu wiki, visit https://wiki.ubuntu.com/HelpOnEditing.

9.5 Launchpad

Launchpad is a collaborative Web-based suite that helps people develop directly or contribute to the development of free and
open source software. It is a collaborative system developed by Canonical, with Ubuntu as the most popular project hosted on it.
You can use Shipit with your Launchpad ID and order Ubuntu CDs, report a bug, assist in translation of Ubuntu and more. This
course covers the Launchpad Technical Answers section, Launchpad Bug Tracking and Shipit (ordering Ubuntu CDs).

You can visit Launchpad at https://launchpad.net. The following screenshot displays the home page of the Launchpad site:
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Figure 9.22: The Launchpad Page

Information stored on Launchpad can be retrieved anonymously. To submit information on Launchpad, you need to first create
an account on Launchpad. You can create a Launchpad account by clicking the Register link at the top-right corner of the
home page and filling the required details under the Not registered yet? section. Click Register to complete the registration
process. You may also use an OpenlID login to access Launchpad. For more information on on OpenID see the project website
at: http://openid.net.
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[ Log In J [Forgotten your password?]
Not registered yet?

Creating your Launchpad account is easy. Here's what to do:

Password:

1. Enter your e-mail address.
2. Launchpad will e-mail you asking you to confirm your address.
3. Follow the confirmation URL in the e-mail and you're done!

E-mail address: | |
[ Register |

Note: We will never disclose, share or sell your personal information, nor send you e-mail not directly related to Launchpad.

What is Launchpad? | Get help with Launchpad © 2004-2008 Canonical Ltd. | Terms of use

[+

Done launchpad.net &

Figure 9.23: Registration Page

After you register, you can log on again and return to the home page to search the required information. You can do this by either
asking a fresh question or searching the relevant information within the existing answers on the Launchpad site.

9.5.1 Launchpad Technical Answers

To search for an answer in the existing questions, click the Answers icon on the right. This displays the Questions and answers
page. To obtain information about a specific project, such as Ubuntu, you can select the project name from the Most active
projects list. This displays the Question for Ubuntu page on Launchpad.

Nice to Know
Many applications on Ubuntu provide the Get Help Online menu entry in their Help menu. This can be used as a shortcut to
visit the Technical Answers section in Launchpad.
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Figure 9.24: Questions and Answers Page

On this page, all answers specific to the Ubuntu project are listed under various categories. You can type your question in the
Search field to search for an answer in the existing questions. Alternatively, you can click the Ask a question button to display
the Ask a question page.
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Figure 9.25: Questions for Ubuntu Page

You can ask a question by selecting your preferred language and then typing the summary of your question in the Summary
field. Clicking Continue displays a list of questions that may be similar to what you asked.
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Figure 9.26: Ask a Question Page

If you still do not find the required answer, go ahead and type the description of the problem in the Description field. You can
then click Add to add the question to the main Launchpad database.
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Figure 9.27: Question Page
When your question is answered, you will receive an e-mail notification, stating that your question has been replied to.

9.5.2 Launchpad Bug Tracker: Malone

Note:

Malone is a Web-based, collaborative, bug-tracking tool available with Launchpad. It provides you with a location to report any
bugs that you find in Ubuntu and its various applications. It also enables you to track the bugs during their life, right until they
have been resolved.
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If you find any problems in Ubuntu and its related applications, you can report it on Launchpad by clicking the Bugs icon on
home page. This displays the Bug tracking page of the Launchpad Web site.

The Bug tracking page displays all the recently reported and recently fixed bugs. Before reporting a new bug on Launchpad,
you must run a search in the existing bug reports to ensure that this bug has not been reported already.
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Figure 9.28: The Bug Tracking Page

You can report a fresh bug on the Report a bug page, which can be displayed by clicking the Report a bug button on the Bug
tracking page.

Type a small description of the bug in the Summary field, and click Continue to report the bug.
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Figure 9.29: Report a Bug Page

When you click the Continue button, the bug tracker displays a list containing similar bugs reported earlier on Launchpad. If
you do not find your bug listed here, you can still report the bug as a fresh bug by clicking the No, I'd like to report a new bug
radio button at the bottom of this page. This displays a new section at the bottom of the page.
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Figure 9.30: Look for the Reported Bug

You are then required to provide further detailed information about the bug, such as the steps to reproduce the bug and version
information. After providing the required details, you can finally submit the bug report by clicking the Submit Bug Report

button.

Visit Malone at https://launchpad.net/malone.

9.5.3 Shipit

Note:

Shipit is an application you can use to request the delivery of Ubuntu CDs. Although Ubuntu can be freely downloaded from the
Internet, you can also request a free-of-charge mail delivery of the Ubuntu CD. This is especially useful if you have slow Internet
connection, as downloading the OS can take a while. Delivery may take up to 10 weeks.

The following screenshot displays the Shipit site:
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Figure 9.31: The Shipit Page

Visit Shipit at http://Shipit.ubuntu.com.
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9.6 The Fridge

Note:

The Fridge is an information hub for the Ubuntu community, bringing together news, grassroots marketing, advocacy, team
collaboration and great original content. Just like the family fridge at home, this is where the Ubuntu family can exhibit its best
work for everyone to see, along with the requisite jokes, reminders, invitations, news clippings and photos.

Visit The Fridge at http://fridge.ubuntu.com/.

The following is a screenshot of The Fridge home page:
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Figure 9.32: The Fridge

9.7 Paid For Commercial Services

Canonical provides professional support across the globe. You can purchase this support by contacting the Global Support
Services team on the Ubuntu Web site at http://www.ubuntu.com/support/paid. Professional support services can also be obtained
through the network of companies and partners listed in the Canonical Marketplace.

9.7.1 Professional Support Services from Canonical

Canonical Global Support Services are deployed to enable 24x7 assistance to customers. The Global Support Services team
utilises its vast experience and knowledge base to identify the challenges that customers may face when installing and maintaining
new platforms and applications. From optimising your small office set-up to providing guidance on very large deployments, the
Global Support Services team is always ready to help you get the most out of Ubuntu.

Support is provided for desktops, servers and thin client servers, and clusters. The following screenshot shows the various types
of support services offered:
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Figure 9.33: The Various Type of Support Page

To purchase commercial support, click the contact us link available at the bottom of the Canonical Global Support Services
page. This takes you to the About us page. You can fill the form provided on this page to request more information about
Canonical Global Support Services. Alternatively, you may click the Purchase Support button present in the left Navigation
pane. If you are a company employee, ask your 1.S. team for details of your support options as this will vary from company to
company.

File Edit View History Bookmarks Tools Help

& - ¢ o [( | http:fjwww.canonical.com/aboutus |'] ['| @

[ Most Visited ~ @ Getting Started [5]Latest Headlines~

@] Welcerne | canonical £ | € About us | Cancnical

£/ cANONICAL =

Projects Services Partners Support Login Store About Us otligh
Get Certified
Ubuntu Training

About Us S

v About Us Youare hers:  Home » Aboui us

» News

Founded in late 2004, Canonical Ltd is a company Latest News

» Maragement team headquartered in Europe with over 200 employses working 2

3 T GBS in 23 countries (and counting). Ganonical is the commercial xsnien s ot maditd. besed
sponsor of Ubuntu project. shqg.ubuntu.mm in time for

+ Employment holiday season

Our mission T Ao 208

Our mission is to realise the potential of free software in the ARM and Canonical to bring full

lives of individuals and organisations by: Ubuntu desktop experience to
low-power, ARM
= delivering the world's best free software platform technology-based computing
= ensuring its availability to everyone devices
= supporting it with high quality professional service 15th Nov, 2008
= nffarinne

Done

Figure 9.34: About Us Page

After you purchase the support, you will receive a confirmation e-mail message containing your support ID number. You will
also receive a phone call welcoming you to the service.
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9.7.2 The Canonical Marketplace

Note: Note:

The Canonical Marketplace lists a number of companies and partners located in various regions of the world which provide local
support for desktops and servers running Ubuntu.

The following screenshot displays the Marketplace page on the Ubuntu Web site:
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Figure 9.35: The Canonical Marketplace

To find support and solutions from local providers, visit http://www.ubuntu.com/support/commercial/marketplace.

Selecting your region from the list provided will lead you to a comprehensive list of all the Local Support Service providers in
that region. The following screenshot displays a list of all the Local Support Services providers existing in Africa:
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Figure 9.36: Local Support Services Page
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If your company is providing Ubuntu-related services then you too have the option of being listed in the Canonical Marketplace
as a Local Services Provider. To do this simply click the send us your information link at the bottom of the Marketplace page.

9.8 L

In this les

esson Summary

son, you learned:

The various sources where you can find both free and paid for support on Ubuntu - system and online documentation, com-
mercial support, community support, Launchpad and The Fridge.

System and Online documentation provide the primary source of help and contains both official and community documentation.

The Ubuntu community also provides vital support through mailing lists, Web forums, IRC channels, LoCo teams and the
Ubuntu Team Wiki.

You can use Launchpad to perform tasks such as searching Ubuntu related information, tracking bugs in Ubuntu and placing
orders for Ubuntu CDs.

The Fridge is an information hub for the Ubuntu community, bringing together news, grassroots marketing, advocacy, team
collaboration and great original content.

Canonical provides professional support across the globe, which you can purchase by contacting the Global Support Services

team.

* Professional support services can also be obtained through the companies and partners listed in the Canonical Marketplace.

9.9 Review Exercise

Question

Answer:

Question:

Answer:

Question:

Answer:

Question:

Answer:

Question:

Answer:

Question:

Answer:

Question:

Answer:

Question:

Answer:

: Name the major sources of help and support for Ubuntu.

What types of documentation is available on the documentation site of Ubuntu?

What are the options for obtaining commercial support for Ubuntu?

What are the different platforms through which the Ubuntu community extends its help and support?

What are IRC channels?

What help and support do the LoCo teams provide to Ubuntu users?

What is Launchpad?

What is the name of the bug-tracking tool available with Launchpad?
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Chapter 10

Partitioning and Booting

Note:

Partitioning and Booting is an additional section and not an integral part of the desktop course. Many users, especially corporate
desktop users who have system administrators to set up their computers for them will find this section irrelevant. Home users, or
advanced Ubuntu users may find this extremely useful.

OBIJECTIVES

* The benefits of partitioning
* How to create partitions

* How to configure start-up options

10.1 What is Partitioning

Note: Note:

Analogy Time Simply broken down, a new hard disk is similar to the foundations of a house - it needs some structure and walls
before you can start putting things (like furniture) into it. The partition is the first level of foundation on the disk. Once the disk
is logically carved up into partitions, it can be thought of as a house with rooms. Each partition (room) is of a specific size which
could potentially be resized again after you move it, but would cause some disruption as objects get moved to make room. Once
a partition (room) is created it can then be formatted using the filesystem of your choice. Once the filesystem has been laid down,
it’s possible to start populating the partition with data in the form of files and folders (furniture).

So, a partition is a logical chunk of space allocated out of the entire disk. Depending on how a system is configured at installation
time, there may be one or more partitions on a disk. In some instances, it is also possible to modify the layout, number and size
of partitions, but this is often considered an expert’s function.

Many Microsoft Windows users will have just one large partition - often known as "C: drive", however it is also common for
Microsoft Windows users to have multiple partitions which are labelled with successive alphabetic characters (D:, E: and so on).

Similarly, with Ubuntu it’s possible to install the system in exactly one partition on the disk, or spread data and applications over
multiple partitions.
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Disk

Two partitions

Figure 10.1: Partitioning

There are valid arguments for both scenarios. Having one single partition with all applications, libraries and data will result in
a simple to manage system. It also provides flexibility as installing applications or adding data will use space from a common
"pool".

If you accept all the defaults when installing Ubuntu, you will end up with a system separated into two partitions on the disk.
One contains all files, the other is known as "swap" which can be thought of as an extension to your computer’s internal memory.

Alternatively, it is possible to create multiple partitions of differing sizes into which different types of applications, libraries
and data can be placed. This is often used in a multi-user or server environment where user data is kept separate from system
programmes, log files and configuration files. A significant benefit to this can be seen when there is a problem on the system and
log files start to grow. The log files (in one partition) will not consume all available disk space in this scenario because they will
be confined to their own (small) partition of the physical disk.

Which ever partitioning scheme has been chosen, this is not set in stone. It is possible to use a partition editing utility to resize
partitions (subject to sufficient free space in each partition), however this is quite an advanced topic, and generally nto done while
the system is in use.

Whilst it is possible to change the disk partitioning layout after the system has been installed, it is important to make backups
before making any changes to the partitions.

About filesystems Partitioning a disk is only the beginning. Once the disk has been divided up, those partitions need to be
formatted so that the operating system can place files on the disk in a structured manner. There are many different filesystem
types, each with their own advantages. With Microsoft Windows the two main filesystems are FAT (File Allocation Table) and
NTFS (New Technology File System). With Ubuntu there are many options including ext2, ext3, reiserfs, xfs and many others.
The Ubuntu installer chooses ext3 by default, but of course it is possible to override this.

Nice to Know:
ext3 is a great general purpose journalling filesystem. It handles most tasks well however, xfs is sometimes chosen instead on
media-centre systems as it performs better when handling very large files - such as music and video files.

Mount points A mount point is a place in the directory hierarchy where a filesystem could be presented. There is no real
Microsoft Windows equivalent to this. With Microsoft Windows the partitions C:, D: and so on, are seen as entirely separate
entities so the operating system, applications and data is often referred to by a user as being "on the C: drive" or "in a folder on
the D: drive".

Nice to Know:

"Mount" is the term used when referring to a filesystem being made available for access. CD and DVDs are usually automatically
mounted when they are inserted. The same goes for USB connected devices such as memory sticks, hard disks and music
players.

On Ubuntu, files and folders reside within a partition as they do with Microsoft Windows. However the partition is not normally
referenced directly by the user. The user would typically say that files are "in my home directory" (when referring to /home/<
username>), or "in the root directory" (when referring to / ) without specifying which partition on the disk those directories reside
in.
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Under most standard installations of Ubuntu there will be only one partition where all files and folders reside. However if a
user plugs in an external USB-connected memory stick or USB hard disk, Ubuntu will mount the partition(s) on that device
under mount point(s) within the directory tree. For example a USB attached memory stick or hard disk will usually appear under
/media/disk (unless the device has partitions which are labelled, in which case they will appear under /media/<labelname> )

Further considerations As previously mentioned, resizing partitions is not a trivial task. Under most circumstances it requires
that all filesystems involved are unmounted, this means they must not be in use. Typically then to resize partitions the system
should be booted to an unused filesystem - such as a bootable Live CD. Considerable thought should therefor be given before
partitioning a disk with regards to the number and sizes of partitions to be created to prevent later unnecessary resizing.

Caution:

@ You may run out of hard drive space in your home partition due to the sub-division of the drive into fixed-size partitions.
This may occur even if the other partitions have plenty of usable space. Good and logical partitioning requires you to
predict how much space each partition needs.

For new users, home users and other single-user set-ups, a single root (/) partition with a swap partition would be the easiest and
the most convenient to create and use. However, for multi-user systems or computers with lots of disk space, it is best to have
the /home, /tmp, /usr and /var directories as individual partitions separate from the root (/) partition.

Before partitioning your hard drive, you should consider the following:

* root: Also called the slash directory, it is the highest directory of the directory tree. When creating the root partition, you need
to ensure that the root should contain the /etc, /bin, /sbin, /lib and /dev directories, otherwise you will not be able to boot-up
the system. You also need to ensure that the root partition is allocated at least 150-250 MB of disk space.

* /home: This directory contains all user-specific files and data. On a multi-user system, every user will store personal data in
a sub-directory of this directory. The size of this directory would depend on the number of users using the system and the
files they store in this directory. Ideally, you should plan the disk space for this partition based on your planned usage. In
general, about 100-MB disk space can be allocated for each user. However, you may need to reserve a lot more space if you
are planning to save a lot of multi-media files in your home directory.

Nice to Know:
It is good practice to have /home on a separate partition because it allows for a smoother transition from one distribution to
another.

* /var: This directory contains variable data, such as news chapters, e-mails, Web sites, databases and the packaging system
cache. The size of this directory also depends on system usage. Most probably, the size of this directory would be dictated by
your usage of the Ubuntu package management utilities. If you plan to install all the packages that Ubuntu offers, you need
to allocate 2 to 3 GB of space for the /var directory. However, if you want to save hard disk space and do not plan any major
software updates, you can get by with as little as 30- or 40-MB disk space for the /var directory.

 /tmp: This directory contains temporary data created by programmes. Some applications, including archive manipulators,
CD/DVD authoring tools and multi-media software also use this directory to temporarily store image files. You need to plan
space allocation for this directory based on your usage of these applications. for this directory.

e /usr: This directory contains all user programmes (binaries), their documentation and supporting libraries. This directory tends
to use the maximum space on the hard disk. Therefore, you should provide at least 500-MB disk space for this directory. But,
you need to increase this space depending on the number and types of software packages you plan to install. Based on your
planned usage and the available disk space, you may allocate 1.5 to 6 GB of disk space for this directory.

Nice to Know:
The /usr partition is sometimes referred to as User System Resources and not user as was originally intended.
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10.2 Creating a Partition

As mentioned earlier, multiple partitions are very useful especially in cases where a partition is corrupted, as it enables you to
boot into GNU/Linux to fix the system, without having to reinstall the system. To do this, a root partition is required. This
partition should contain the essential components of the system.

( : ) Caution:
The hard disk drive that you are formatting should not contain any data. If you have already formatted the drive and it
contains data, skip the partitioning step and move to the next step - mounting.

If the hard disk drive that you want to format is blank and unformatted, you can use either of the following tools to partition it:

* Partition Editor (GParted): GParted is useful for creating space for new operating systems, re-organising disk usage, copying
data residing on hard disks and mirroring one partition with another (disk imaging).

e Command Line: The command line is faster and more powerful than GParted. When navigating through the file system, you
can use the command line to jump from one directory to another in a split second. Use the command-line interface if you are
comfortable using the Terminal.

If you want to create a partition using GParted, you need to first install GParted by using Add/Remove Applications or Synaptic
Package Manager.

10.2.1 Installing GParted by Using Synaptic Package Manager

1. On the System menu, point to Administration and then click Synaptic Package Manager. The Synaptic Package
Manager window opens.
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Figure 10.2: Synaptic Package Manager Location

2. When the Synaptic Package Manager window opens for the first time, it displays a list of all the software packages
available in the Ubuntu software repositories. The left pane lists the various software categories. You can select a specific
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category to view the available software packages listed in that category. Alternatively, you can use the Search functionality
provided in the Synaptic Package Manager to locate specific software in the list.

Click the Search button to search the package you want to install. The Find dialogue box appears.

In the Search field of the Find dialogue box, type the name of the package, Partition Editor, and click the Search button.
The package, gparted, is now displayed in the right pane of the Synaptic Package Manager window.

Right-click the package name to select an action that you want to perform on it. Notice that various options are available to
perform a number of actions on the selected package. If the selected package is not installed currently, you can mark it for
installation. If the selected package is already marked for installation, you can unmark it to clear the selection. Similarly,
if the package is already installed, you may select Upgrade to upgrade the package and Mark for Removal or Mark for
Complete Removal to delete the package from your computer.

To install the package, select the Mark for Installation check box.

The gparted package is now selected for installation. To continue with the installation, click Apply. This displays the
Summary dialogue box.

The Summary dialogue box prompts you to perform a final check before implementing the marked changes. Click the
Apply button to apply the marked changes. The Downloading package files window opens.

Wait for all the required files to download. After all the required files in the package are downloaded, the Changes applied
dialogue box appears.

The Changes applied dialogue box notifies you that all the requested changes have been applied. Click Close to exit the
dialogue box.
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Figure 10.3: Synaptic Package Manager

3. In the Search field of the Find dialogue box, type the name of the package, Partition Editor, and click the Search button.
The package, gparted, is now displayed in the right pane of the Synaptic Package Manager window.
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Figure 10.4: Finding a Package in Synaptic

4. Right-click the package name to select an action that you want to perform on it. Notice that various options are available to
perform a number of actions on the selected package. If the selected package is not installed currently, you can mark it for
installation. If the selected package is already marked for installation, you can unmark it to clear the selection. Similarly,
if the package is already installed, you may select Upgrade to upgrade the package and Mark for Removal or Mark for
Complete Removal to delete the package from your computer.

To install the package, select the Mark for Installation check box.
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All
Partition Editor
gparted

&

Package Installed Version | Latest Version

Description |

K}

% gparted

| L& Properties

=23 2ubuntus

| Mark for Installation

GNOME partition

I Sections ‘

Status
Orign ‘
Custom Filters ‘
I Search Fesults

No

p is selecte ) .
Mark Suggested for Instzllation  »

Figure 10.5: Marking a Package for installation

5. The gparted package is now selected for installation. To continue with the installation, click Apply. This displays the

Summary dialogue box.
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Synaptic Package Manager R EEY

&

Fle Edit Packsge Settings Help

Reload  Mark All Upgr.

Al i ) -
| . Apply the following changes? el Deseophian
Partition Editor { . | tus GNOME partition
This is your last oppertunity to look through the list
gparted of marked changes before they are applied.
b To be installed
H =
= i 3]
I D= summary Show Details| ——

Sections 1 new package will be installed
1854 kB of extra space will be used
Status 0 B have to be downloaded

origin [ Download package files only

Custom Filters QCaneI PPl

Search Results

it

11 packages listed, 1110 installed, 0 broken. 1 to installjupgrade, 0 to remove; 1854 kB will be used

Figure 10.6: Summary Dialog Box

6. The Summary dialogue box prompts you to perform a final check before implementing the marked changes. Click the
Apply button to apply the marked changes. The Downloading package files window opens.

Applying Changes. =

"3
=

Installing software

The marked changes are now being applied. This can
take some time. Please wait.

Preparing packages...

@ Autorratically close after the changes have been successfully applied:

[> Details

Figure 10.7: Applying Changes Box

7. Wait for all the required files to download. After all the required files in the package are downloaded, the Changes applied
dialogue box appears.

Changes applied

successfully applied all
changes, You can close the
window now.

[ Autorratically close after the changes have been successfully applied

[ Details

Figure 10.8: Changes Applied Box

8. The Changes applied dialogue box notifies you that all the requested changes have been applied. Click Close to exit the
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dialogue box.

Eile Edit Package Settings Help

Reload  Mark all Upgrades ppl Search
|

All Package Installed \ersion Latest Version Size Desc
Partition Editor M 2 gparted 0.3.3-2ubuntué 0.3.3-2ubuntué 1954 kB GNOI
gparted

[T T e D]

= No p is selected.
I Sections
Search Results

|1 packages listed, 1111 installed, 0 broken, 0 to installjupgrade, 0 to remove

Figure 10.9: Synaptic Package Manager after Installation

9. The partition editor is installed on your computer. You can now partition the hard disk drive.

G Applications

Places
g Preferences

n;é} Administration

e Help and Support
‘& About GNOME
q About Ubuntu

Quit...

een @O

il Fri Dec 19, 9

v
» %J"‘" Authorizations
ﬁ Hardware Drivers
- j Hardware Testing
m Language Support
[E1 Login Window
% Metwork
MNetwork Tools

% partition Editor

H Printing

= Services

Manage your partitions

@ Software Sources

Synaptic Package Manager
@ System Log

System Monitor

@ Time and Date

@ Update Manager
B users and Groups

,@ Windows Wireless Drivers

Figure 10.10: Opening Partition Editor
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10.2.2 Partitioning Using Gparted

1. On the System menu, point to Administration and then click Partition Editor. The GParted window opens.

Nice to Know:
GParted is also available from the Live CD.

S fdevisdas
GParted Edit Yiew Device Partition Help

= e

[ /devssda (74,50 GiBl *

Jdevfsdal ‘unallocated
34.46 GIB 35,39 GIB
Partition Flesystem Mountpoint Size Used Unused Flags
Jdevjsdal D W ext3 ! 34.46 GiB 2.86 GIB 31.60 GIiB boot
Jdevjsdaz D W linux-swap 4.656 GIB

35.39 GiB

0 operations pending

Figure 10.11: GParted Window

2. In the top-right corner of the GParted window is the drive drop-down box. You can use this box to select the hard drive

that you need to partition by specifying the logical name you noted earlier. The Gparted window refreshes and shows you
a representation of the selected drive.

If the existing partitions on the drive have not yet been used, a white bar would run across the window. However, if the
existing partitions contain some data, the data will be represented by a pale yellow area.

You can either resize an existing partition or create a new partition in the unallocated space of the hard drive. Before
resizing an existing partition, you must make sure that you unmount it by right-clicking the partition and then selecting
Unmount. Remember that you cannot resize a partition to be smaller than the yellow area, which represents the data on
the partition.

To create a new partition in the unallocated drive space, right-click the area and select New on the short-cut menu. The
Create new Partition dialogue box appears.

The Create new Partition dialogue box enables you to select specifications for the new partition. Apart from defining
the size of the new partition, you can also select the partition type, whether primary or logical, for the new partition. In
addition, you can even define the file system to be used on the new partition. By default, Ubuntu uses the ext3 partitions.
However, if you want the new drive to be readable by both Microsoft Windows and Ubuntu without installing anything
extra, you can format it as Fat 32.
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GParted Edit View Dewvice Partition Help

& [\/devisda (7450 GB) +
New t =

Jdevjsdal unallocated
34.46 GiB : i
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Partition Filesystem Mountpoint Size Flags
Jdevisdal Q W ext3 / 34.46 GiB boot
Jdevssdaz D W linux-swap 4.66 GiB
unallocated unallocated 35,39 GiB

« Information

0 operations pending

Figure 10.12: Creating a New Partition

3. You can either resize an existing partition or create a new partition in the unallocated space of the hard drive. Before

resizing an existing partition, you must make sure that you unmount it by right-clicking the partition and then selecting
Unmount. Remember that you cannot resize a partition to be smaller than the yellow area, which represents the data on
the partition.

To create a new partition in the unallocated drive space, right-click the area and select New on the short-cut menu. The
Create new Partition dialogue box appears.

Minimum Size: 8 MiB Maximum Size: 36233 MIB

g s
Frée Spade el (R J Create as: Logical Partition 5
New Size (MiB): [38233];] ———

Free Space Following (MiB): |0 -‘l Fl=systat:

[ Round to cylinders

ext2 :

‘ ogamcel ‘ | =k Add |

Figure 10.13: Create New Partition Box

4. The Create new Partition dialogue box allows you to select specifications for the new partition. Apart from defining

the size of the new partition, you can also select the partition type, whether primary or logical, for the new partition. In
addition, you can even define the file system to be used on the new partition. By default, Ubuntu uses the ext3 partitions.
However, if you want the new drive to be readable by both Microsoft Windows and Ubuntu without installing anything
extra, you can format it as Fat 32. NOTE:

If you are creating a partition on a new hard drive, select Primary Partition. An SCSI or S-ATA hard disk can have a
maximum of 4 primary partitions and 11 logical partitions while an integrated development environment (IDE) hard drive
can have up to 63 partitions overall. The primary partition used to house the logical partitions is called an extended
partition. Unlike primary partitions, logical partitions must be contiguous: the blocks in the partition are following each
other without any gap.
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= Jdev/sda - GParted |Z||EE|1

GParted Edit View Device Partition Help

e
e I I, [)/devisda (7450 GiB) 4
Undo | Apply
Jdevjsdal
34.46 GiB
Partition Filesyst {15 Unused Flags
faergsdat ET W =2 /. Are you sure you want to ERbEREE e
{devjsdaz 15 M linux &I \, apply the pending operations?
New Partition #1 ext2

It is recommended to backup
valuable data before proceeding.

% Create Primary Partition #1 (ext2, 7.84 MiB) on /dev/sda

1 eperation pending

Figure 10.14: Confirmation Box
5. In the New Size (MiB) field, specify the size of the partition by using the up or down arrow key. You can also define the
size by dragging the black bold arrows on the top white bar.
Select Primary, Logical or Extended partition from the Create as drop-down list.
Next, specify the file system by selecting from the Filesystem drop-down list.

. Click the Add button to complete the partition. The white bar updates to show a new partition on the disk.

© o N o

. You can create multiple partitions at this stage by following the above-mentioned procedure and then clicking Apply to
add them to the hard drive. The Apply operations to hard disk dialogue box appears.

Applying pending operations
Applying all listed operations.

Depending on the amount and type of operations this might take a long time.

Completed Operations:

L

b ‘Details!

Save Details

Q Close

Figure 10.15: Applying Pending Operations Box

10. The Apply operations to hard disk dialogue box recommends that you back up data before performing the changes and

seeks your final confirmation before applying the changes to the hard disk. Click the Apply button to partition and format
the hard disk according to your specifications.
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GParted Edit View Dewvice Partition Help
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1 operation pending

Figure 10.16: GParted with New Partition

11. The system starts applying the changes to the hard disk. The duration of the operation will depend on the size of the new
partition. You can click the Details button to view more information about where and how changes are being made, whilst
the operation is running.

GParted Edit View Dewice Partition Help

i =] By [ Videvssda (7450 GiB) *
Delete Resize/Move Copy Paste Linda  Appl

:
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Jed
Ly e Chrlnd
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/devisdal W ext3 / 34.4¢ 7 31.59 GiB boot
@] 5 = Resize/Move
[dev/sdaz [E] B linux-swap 4,66
Jdev/sda3  ext2 101,98 (71 Copy Ctri+C 57,22 MiB
unallocated [l unallocated 3524 |- Easts et
3 Format to 3

W[yl

Manage Flags
Check

w Infermation

0 operatiens pending

Figure 10.17: Deleting a Partition

12. Once you receive a message that all the specified operations have been successfully completed, you can safely close the
window by clicking the Close button. However, if something goes wrong and the process does not complete successfully,
you can save the process output for future reference by clicking the Save Details button.

13. The newly created partition is now visible in the GParted window. You will also notice that your system automounts the
newly created partition.

Mounting refers to the process of attaching the newly created partition or drive to an existing directory to make it accessible.
The directory where the new partition is attached is called the mount point. After the partition is mounted, you can access
the files on that partition by accessing the mount point for the new partition. Early Linux distributions did not allow the
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auto-mounting of new partitions or drives. However, from Ubuntu 8.04 LTS, you can easily access the new partitions by
auto-mounting the partitions. When you create a new partition, the new partition opens as a separate window and the
partition appears as a disk icon on the desktop.
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& About GNOME O

@ Bluetooth

423 About Ubuntu _
) Default Printer

E Quit. ..

. Encryption and Keyrings

== Keyboard

B2 Keyboard shortcuts

A main Menu

.:, Mouse
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E PalmOs Devices

E‘m‘_‘-ﬂ Power Management

‘_‘y Preferred Applications
Remote Desktop

@ Removable Drives and Media >
@ Screen Resolution
E Screensaver

@# Search and Indexing

Sessions

G Sound

7= Windows

Figure 10.18: Removable Drives and Media Preferences Dialogue Box

14. When you no longer want to access the new partitions, you can unmount them by right-clicking the disk icon on the
desktop and selecting the Unmount Volume option from the short-cut menu.

! Multimedia ‘Cameras } PDAs |Printers & Scanners | Input Devices

Removable Storage
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] Auto-open files on new drives and media

Blank CD and DVD Discs
[ Burn a €D or DVD when a blank disc is inserted

&

Command for Audio CDs: [serpentme | - ] Iﬁrowse.‘.l

Command for Data CDs: |naut\|us —-no-desktop bL| - ‘ lﬁruwse.‘.|

‘ a Close

Figure 10.19: RC.Local File

10.3 Boot-up Options

Booting up is a process through which the operating system is loaded into the computer’s main memory or random access
memory (RAM). The boot-up process starts when you turn on your computer. During this process, the BIOS takes control
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of your computer and decides where to look for software on the computer and in which order.Your computer’s BIOS settings
determine whether your computer will first check the hard disk or a floppy disc, CD, DVD or flash memory to start the booting-up
process. If you have multiple operating systems installed on your computer, the BIOS configuration determines which operating
system will be loaded first at boot-up.

Only after all system files have been loaded into the main memory, is the operating system given control of the computer. The
operating system performs the requested initial commands and then waits for the first interactive user input.

However, as a superuser or user with administrative privileges, it is possible for you to change the boot-up configuration to define
the computer’s boot order, change the default operating system to boot-up or make a system command run automatically at
boot-up.

One way to change or check your BIOS setting is to restart your computer, and press a key to enter the setup function before it
starts to load any operating system. Generally, you can do this by pressing F1, F2, ESC or DELETE. Once you are inside the
BIOS setup, you can make the desired changes by following the instructions for using the setup. However, you need to be very
cautious when making any changes in the BIOS settings because a wrong setting can prevent your computer from booting-up

properly.

You can also perform these configuration changes by using a command line on your computer’s terminal.

10.3.1 Running a System Command Automatically at Start-Up

At times, you may wish to add a custom command for the start-up process so that your computer executes this command every
time it boots up.

1. On the Terminal, type the following command to open the rc.local file:

$ sudo nano
/etc/rc.local

(= W

bt
File Edit View Termin;

al Tebs Help
williamwindsor@ubuntuB@4desktop:~$ cat newbackup D

Figure 10.20: Terminal Window

The rc.local file contains a script that is executed after all the other initial scripts. You can insert your own initialisation
scripts in this file if you want some services to be executed automatically during the start-up process.

2. The rc.local file opens in the Terminal window. Type the command that you want to run at system start-up before the line,
exit 0.

$ date >
/home/oem/newbackup
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File Edit

Modified |
#!/bin/sh -e
#
# rc.local
#
# This script is executed at the end of each multiuser runlevel.
# Make sure that the script will "exit @" on success or any other
# value on error.
#
# In order to enable or disable this script just change the execution
# bits,
#
# By default this script does nothing.

date > /home/oem/newbackuﬁ]
exit @

Get Help HE Writeout @& Read File Prev Page @d Cut Text Cur Pos
Exit g Justify @i Where Is Mext Page gl UnCut Textgg] To Spell

Figure 10.21: Making Settings for rc.local File

3. After you enter the command you want executed at system start-up, press CTRL+X to save and exit the edited file.
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Figure 10.22: Services Window

4. When you reboot the system, the rc.local file executes. If you want to display the output of the above command, type the
following command in the Terminal:

$ cat newbackup

The following image shows the output of the above command:
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10.3.2 Changing the Default Operating System at Boot

When multiple operating systems are installed on a computer, this is referred to as a multi-boot configuration. Typically, the
operating system that is listed on top in the configuration file is loaded on the computer. To choose the operating system that
starts when you turn on your computer, edit the grub configuration file.

1. Back up the configuration file, and open it in a text editor, as follows:

$ sudo cp
/boot/grub/menu.lst /boot/grub/menu.lst_backup $ sudo
gedit /boot/grub/menu.lst

2. Find the line written below to change the default sequence:

. default 0

Replace this line with the following line:
default X
Replace X with a number based on the order in which your operating systems appear in the configuration file. You should

start counting from 0. For example, if you wish the default operating system to be the first in the list, replace X with 0; and
if you wish the default operating system to be the second in the list, replace X with 1.

3. Point to saved and save default to reboot the last OS chosen.

10.3.3 Configuring Start-Up Services

When Ubuntu starts up, many services are started for your convenience. Some services are mandatory for Ubuntu to work
properly on your computer. Others are services that you’ll probably never need, either because you just do not want them (for
example, ntpdate, which sets your system time from a time server) or you simply don’t have the device (for example, the HP
printing and scanning system, which is of no use if you don’t own an HP device).

Although these services are harmless, they increase your computer’s start-up time. By de-activating some of these services, you
should get a slightly faster start-up time.

( ) Caution:
Read the service information before you disable any service because disabling some services may stop your system
from booting-up or running properly.

To configure the start-up services, you need to have administrative privileges. Then, perform the following steps:

1. On the System menu, point to Administration and then click Services.
2. Type your administrative password. The Services settings window opens.

3. Select the services you want running by selecting or clearing the respective check boxes and click OK.
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Figure 10.23: Services Settings Window

10.4 Lesson Summary

In this lesson, you learned that:

* Partitioning your hard disk is similar to splitting rooms with walls in a house.
* You can run Ubuntu on a single or multiple partitions or drives.

* Before partitioning the hard drive, you should make sure that there is no data on the hard drive. If the hard drive on which you
are creating a partition contains data and you wish to preserve it, it will be safer to back up the data before proceeding.

* You can create a partition by using both the partition editor and the command-line interface.

* It is possible for you to change the boot-up configuration to define the computer’s boot order, change the default operating
system to boot or make a system command run automatically at boot-up.

* To run a set of commands each time the system boots up, you need to include the commands in the /etc/rc.local file so that the
computer executes them automatically at every boot-up.

* You can change the default operating system at boot by making changes in the configuration file.

* You must read the service information before disabling any service because disabling some services may stop your system
from booting-up or running properly.

10.5 Review Exercise

Question: What are the advantages of partitioning?
Answer:

Question: Why do you need to use the sudo command?
Answer:

Question: Which of these file systems does Ubuntu use by default?
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e Fat 32
e NTFS
e Ext3

Answer:

Question: If you want to run a system command automatically at start-up, where should you add the command?
Answer:

Question: Is it possible to disable all the start-up services? Why?

Answer:

10.6 Lab Exercise

Exercise 1 As a previous Microsoft Windows user, you want to have a dual-boot configuration on your computer and create a
separate partition to run Microsoft Windows on it. To perform this task, you need to create a 5-GB primary partition and format
it with a Microsoft Windows-compatible file system.

1. On the System menu, point to Administration and then click Partition Editor.

2. In the drive drop-down box, select the hard drive you need to partition by specifying its logical name. The window refreshes
and shows you a representation of the drive.

3. Right-click the white bar and click New to create a new partition. The Create new Partition dialogue box appears, in
which you choose the specifications of the new partition.

In the New Size dialogue box, select the size of the new partition.
In the Create as box, select Primary Partition.
Next, specify the file system. Select ntfs.

Click Add to compute the partition. The graphical display updates to show a new partition on the disk.

® N ok

If you are sure about the specification of the new partition, click Apply. The disk will be partitioned and formatted.
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